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Copyright and Licensing Information 

Impact/SQL Version 10.5.0  

Copyright © 1992-2016 by USA Digital Solutions, Inc., Phoenix, Arizona. 

No part of this publication may be reproduced in any form without prior written permission of USA Digital 

Solutions, Inc.  For additional information, contact USA Digital Solutions, Inc., 10835 N. 25
th
 Ave., 

Phoenix, AZ 85029, or call 602-866-8199 x 2. 

Microsoft, Windows, Office, Word, Excel, and MS-DOS are registered trademarks of Microsoft 

Corporation in the United States and/or other countries.  Crystal Reports is a registered trademark of SAP 

AG.  RealEC Technologies, Inc. is a division of Black Knight Financial Services.  All other brand and 

product names are trademarks or registered trademarks of their respective companies. 

IMPORTANT NOTICE – READ CAREFULLY 

Use of this software and related materials is provided under the terms of the Impact/SQL License and 

Support Agreement.  By accepting the License, you acknowledge that the materials and programs 

furnished are the exclusive property of USA Digital Solutions, Inc.  You do not become the owner of the 

program, but have the right to use it only as outlined in the Impact/SQL License and Support Agreement. 

All USA Digital Solutions, Inc. products are designed to ASSIST in maintaining data and/or producing 

documents and reports based upon information provided by the user and logic, rules, and principles that 

are incorporated within the program(s).  Accordingly, the documents and/or reports produced may or may 

not be valid, adequate, or sufficient under various circumstances at the time of production.  UNDER NO 

CIRCUMSTANCES SHOULD ANY DOCUMENTS AND/OR REPORTS PRODUCED BE USED FOR 

ANY PURPOSE UNTIL THEY HAVE BEEN REVIEWED FOR VALIDITY, ADEQUACY AND 

SUFFICIENCY, AND REVISED WHERE APPROPRIATE, BY A COMPETENT PROFESSIONAL. 
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Introduction to Impact/SQL Title 

This manual explains the functionality contained within the Impact Title module (Title), and discusses how 

each tool might be used.  As each company functions in its own unique way, there are some functions 

that may not be utilized, but users are encouraged to examine and consider all of them, to ensure they 

are getting the most out of Impact. 

The Title module is utilized by the Title Department to prepare preliminary title reports, or commitments to 

issue title, and for the issuance of title policies.  Data entered by Escrow is utilized by the Title module, so 

there is no redundant data entry.  This module makes heavy use of Microsoft Word ®, and the user is 

provided with many utilities that speed the preparation of these documents.  Submission reporting of 

policies to the underwriters can be handled either with paper reports or with electronic exports. 

This manual progresses through the functions in Title in the order that they appear on the menus within 

the module.  This will not be how users will work with the product, as that will depend on their 

responsibilities and the structure of each individual business, as well as the configuration of Impact at 

each business. 

There are a number of configuration options that can affect the functionality of the system.  These 

variations are discussed in this manual, to the extent that the discussion does not detract from the 

explanation of the functions of the complete package. 

Note: several functions discussed herein require the Impact Windows Service, introduced with version 8.0 

and documented separately, to be installed and running. 
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General Information and Helpful Hints 

This manual progresses through the functions in Impact Title in the order that they appear on the menus 

within the module.  This is not how users will work with the product, as that will depend on their 

responsibilities and the structure of each individual business, as well as the configuration of Impact at 

each business.  Before discussing the system functionality in detail, there are some general features that 

you should be aware of.  These are discussed below. 

When you need to press the Enter key, you will see ENTER in this manual. 

When you see text displayed on a menu or window such as the words “Edit” or “Cancel”, you will see Edit 

or Cancel in this manual. 

File > Select File means that you select File from the main menu and then select Select File from the 

sub menu. 

Recent File List 

There is a user option, set via Options > Show Recent File List, that will provide a listing of the last ten 

(10) files accessed, at the bottom of the File menu.  This is the Recent File List.  You can simply click on 

a file number, on the list, to open it up.  To access the list you can use ALT+F to display the File menu.   

Impact Payee Shortcuts – Residential Files (non-CDF) 

The following payee shortcuts can be used to ease data entry and ensure data commonality. 

:L1  Lender 1 

:L2  Lender 2 

:L3  Lender 3 or Mortgage Broker 

:L# John Doe John Doe on HUD as payee 

Allows the fee to be WTH (withheld) on non-GFE files 

:T  Your Company Name 

:T Maricopa County  Your Company Name with amount applied to income, but a different payee 

on  Settlement   Statement 

:TC  Title company shown in Initial Questions (for outside title) 

:E  Your Company Name (if option to use :E is enabled) 

:SA  All Seller names (used in Create & Print Checks only) 

:S1 – 8  Selected Seller name (used in Create & Print Checks only) 

:BA  All Buyer names (used in Create & Print Checks only) 

:B1 – 8  Selected Buyer name (used in Create & Print Checks only) 
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File Search 

The File Search function, seen in many places in Impact, when a file number is being requested, permits 

you to search the entire database, for files that meet search criteria, with differing filters to limit the 

search.  When first opened, the screen presented is set with broad filter of All but file numbers against 

which the Search For: field content will be applied, as shown below. 

The File Search screen gives you the ability to search the database broadly or in a more targeted 

manner.  By entering the beginning of a last name in the Search For: field, for example, and then clicking 

on the Search button without changing the search default of All but file numbers, you will get a listing 

returned of all files that have names of either the Buyer or the Seller which begin as you requested.  The 

more sure you are of the item being requested, enter a more complete description.  However, if at first 

you do not find what you believe you should have, limit the information you enter in the Search For: field.  

You may also use the percent sign (%) as a wildcard in your searches.  It can be placed at the beginning, 

middle or end of your entry to tell the system to find anything that ends with what you entered, contains 

anything between your entry items, or begins with what you entered, respectively.  The more targeted 

search options are listed below and can be selected from the Filter: dropdown.  The default is All but file 

numbers. 

 Sellers and Buyers 

 Buyers 

 Sellers 

 Property Address 

 Tax Parcel Number 

 Subdivision (Name) 

 Reference Number 

 Base File Number 

 Loan Number (Lender’s) 

 File Number 

 Title File Number 

Once you click on the Search button, a listing of candidate items will present.  The records will indicate 

which search criteria they matched up on.  Up to the first 1,000 records that meet the criteria will be 

presented – you will be prompted to narrow your search if over 1,000 hits are made.    
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The quickest path to the Search functionality is via the  Search icon on the Impact toolbar. 

The user should proceed as far as they can before invoking a search, to minimize the effort.  For 

example, if the plan is to open a file from the search results, use the  Open Existing File toolbar icon 

and then click on the  Search icon and conduct the search.  Double-clicking on a search result, will 

then open that file. 

In the sample below, “smith” was the search criteria, with the All but file numbers filter.  The Found By 

column indicates how the search criterion relates to the search result.  The File Number column contains 

that information.  The Initials column presents the Escrow Officer’s initials, and the Branch of the file is 

presented; along with the Title File Number.  There is a  View File Status icon next to each record 

returned; click on the icon to get more information on the file that the record relates to. 

The Show Detail checkbox, in the top right of the screen, will open a section at the bottom of the screen 

presenting some additional information on the highlighted file.  This helps the user determine if the 

selection is the file they are really looking for. 

The search results can be re-ordered by clicking on a column header. 

The user can re-size the screen by clicking and dragging on the lower right corner of the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

If the File Search screen was called up from a screen requesting a file number, double-clicking on a 

record in the results screen will select that file number for use. 
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Name and Address File (NAF) 

The Name and Address File (NAF) or customer list is a very important tool in Impact.  It is used to aid in 

consistently filling name and address information into the appropriate fields in Impact.  Consistency in 

data entry helps ensure that documents properly present information.  Management reporting is also 

aided by consistent data entry.   The Name and Address File (NAF) is displayed in a tiered manner: 

Company – Branch – Individual (Top – Middle – Bottom).  This provides a good way to show the 

relationship between an individual and where he/she works, within the larger organization.  The NAF can 

be centralized or branch-specific, depending on system configuration.  The NAF menu entry, on the main 

Title desktop, is discussed more fully later in this manual, but the following comments relate to its routine 

use. 

The NAF is called up, from any Name field that can be filled from the NAF, by clicking on the  NAF  

icon. 

Search criteria are entered at the top of the screen.  The first is the Option field.  The nine options 

presented are the eight categories which can be used to categorize entries by type of firm, as they are 

entered/edited, and the All option is used to assist in searching the entire database, regardless of 

categorization of the entries. 

In addition to the  Option field, there are five other fields that are used to refine the Search to include 

either Name, ID, City, State and/or County.  When more than one character is entered into any of these 

fields (three in Name), the Search button will be activated, and the user should click it when all desired 

criteria have been entered.  You may use the percent sign (%) as a wildcard character. Those records 

that have a specific match, and their related records, are displayed in the tree on the lower left of the 

screen.  In the search results display, the company entries are bolded, branch entries are not bolded and 

individuals’ entries are italicized for enhanced readability.  Details of the highlighted entry will appear on 

the right side of the screen, if the Show Details checkbox is checked (at the bottom of the screen). 

Double-click on an entry to Use it, if you are in a field where a NAF entry could be used, when the NAF 

was invoked.  Alternatively, highlight the entry and then click on the  Use icon at the top of the screen, 

or right-click on an entry and pick Use from the menu presented. 

When a NAF entry is pulled into the file under Parties, Contacts, Source of Business, Bill To Customer, 

Title Information, Documents or Payoffs, if the NAF entry is a branch or individual, and the address 

information is empty, the parent’s address information is used.  The same is true if the Work Number, 

Work Extension and Fax Number are blank; the parent’s values will be used. 
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Helpful Hints for Entering Information 

Dates 

When entering a date for the current year, enter dates as two-digit month, two-digit day, for example, 

“0115” for January 15, 2015 (assuming 2015 is the current year) and TAB out of the date field. Do not 

enter hyphens or slashes when entering dates into Impact. If not within the current year but the current 

century enter the date as two-digit month, two-digit day and two digit year, for example: “062514” for June 

25, 2014.  If entering a different century other than the current century, you must enter a four-digit year.   

You can also click the  Calendar icon, just to the right of the date entry area, or press the CTRL+D 

Quick Key to display the Calendar tool.  Select the desired date from the calendar presented by clicking 

on the date. 

 

 

  

 

 

 

 

 

 

 

 

Dollars 

Do not put commas or dollar signs in the dollar amounts.  Decimals before pennies are required. 

TAB 

Use TAB to move forward from one entry field to the next entry field. 

Use SHIFT+TAB to move backward from one entry field to the previous entry field. 

  

For the Calendar tool, click on this 

icon or use the CTRL+D Quick Key to 

display the Calendar tool. 
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Execute 

When you see a button that has a dark border it has the “focus” and you can press ENTER to execute 

that command, rather than clicking on it with the mouse.  Press TAB to move the focus to the other 

button(s). 

 

 

 

F4 

You may use the function key F4 to access a drop down list box, or you may click with the mouse on the 

down arrow. 

 

Quick Keys 

Quick Keys can quickly accomplish tasks by using keyboard entries instead of using the mouse to click 

on selections.  Quick Keys are one or more keys you press on the keyboard to complete a task.  Most 

menu items contain an underlined letter that represents the Quick Key for that menu item. 

For example, press and hold the Alt key and also the F key.  This ALT+F key combination opens the File 

menu, just as clicking on the File menu at the top left of the Impact Title screen opens the File menu. 

Anytime you see a menu selection item on the screen that has a letter in the word underlined, you can 

use the Quick Keys alternative to using the mouse, for example, use the ALT+D Quick Keys to drop down 

the Documents menu because the “D” in Documents is underlined. If no underlining is presenting, hit 

the ALT key, and it will present. 

 

 

 

 

Info Icons 

The  Info icons are found in various screens throughout the Title module. When you click an Info 

icon next to a field, a non-editable pop-up box is displayed, providing additional information about the 

field.  

Closing Impact/SQL Title 

As with most Windows applications, you can close Impact/SQL modules by clicking  in the upper-

right hand corner of the Title desktop.  Alternatively, File > Exit can be used.  

Press ENTER to execute “OK” 

ALT+D opens the Documents menu 
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Logon 

Access to the Impact Title module (as to all Impact modules), is controlled by a user-rights table, 

administered by a limited set of user ID’s that have sufficient authority granted to them.  This is a very 

important control, and should be carefully managed.  Depending on the nature of the rights assigned to a 

user, they will have access to various pieces of the overall Impact suite, but generally not complete 

access.  This functionality helps reinforce audit controls, and needs to be considered in conjunction with 

the network security plan. 

The system can be configured to require a logon routine, each time the user opens an Impact module, or 

it can be configured to provide for an automatic logon utilizing the NT user name.  By providing for an 

automatic logon utilizing the NT user name, control over the access to the application is very flexible: both 

the system administrator and the rights table within Impact can control access.  The system administrator 

can control access by disabling the user’s NT user name, a likely event in the case of an employee’s 

departure. In addition, the user name can be disabled within Impact Utilities – which will only affect the 

user’s ability to access Impact modules.  This would be done if the user is still using the rest of the 

network, but should no longer be accessing Impact. 

There is not an automatic expiration of passwords setting within Impact, so to ensure strong controls the 

administrator would have to routinely change all users’ Impact passwords, and inform the users of them, if 

the automatic logon based on NT user names is disabled.  For this reason, the use of an automatic logon 

based on NT user names can be a more effective control – assuming automatic expiration of passwords 

is implemented through the NT operating system.  This matter is more fully explained in the Impact 

Utilities manual. 

If the system is configured for NT Authentication, and more than one database is available, a screen like 

that shown below will be presented, after the user double-clicks on the Impact Title  icon on their 

desktop.  The appropriate database should be selected and OK clicked on.  If only one database is 

available, the user, if they have permission, will be taken directly into the module. 

 

 

 

 

 

 

 

 

  
Drop down list arrow 
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When configured to require a logon step, the user will be identified within the Impact system by their 

initials (3 maximum), and will be given a password.  A login screen will be presented asking for the user’s 

initials and password. 

Enter the user initials in the first field, and then TAB to the Password field. Enter the password and, if the 

correct database is identified in the Log on to: field, click OK. If the database is not correct, then TAB to 

the Log on to: field and select the correct database by clicking on the drop down list arrow and 

highlighting a database name; then click OK. Most users will only have one database available. 

Alternatively, if the user does not want to use the mouse to click OK, they can hit the TAB key until OK is 

highlighted, and hit ENTER. 

 

NOTE: When they enter their password, it will not display on the screen, but will be represented 

by a series of asterisks “****”. 

 

If the user does not want to continue, they should click on Cancel instead. This will cause the Log On to 

Impact/SQL Title dialogue box to close and the Impact Title module will not be opened. 

KEEP PASSWORDS PRIVATE. Users should not share their passwords or log on to the system and 

then let someone else operate under their session. The initials of the user logged on to the system will 

attach to transactions entered, and users will only want to be responsible for their own activity. 

If users forget their password, the administrator of the Impact application must assign a new one. 
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The Impact/SQL Title Desktop 

Impact Title Desktop 

Impact will display a desktop as shown below when the user signs into the Title module. 

The screen, as it initially opens, presents the user with a menu of options across the top of the screen.  

Each option has a dropdown menu below it, which will be displayed when the user clicks on the option 

name.  Once the user has clicked on one option name, and the menu list below it is presented, they can 

slide their cursor down the list, with the mouse, to get to the function they wish to use.  If they are not sure 

under which option heading the desired function is housed, they can click on any option heading and, 

once the menu list is presented, slide their mouse to the left or right, to other option headings, and the 

menu lists will present without the user having to click again, and they can then browse all of the menu 

choices available to them.  

 

The current date should be displayed in the lower right corner of the Impact desktop. If the current date is 

not displayed, or is incorrect, the user should notify the system administrator and NOT continue to enter 

activity to the system – having the correct dates on activity is very important. The current date is used for 

the print date on documents and on invoices, for example. 

The file number and seller and buyer names will appear when a file is opened by the user.  When shown, 

the file is “locked” by that user and can only be opened in “read only” mode by others, until closed by the 

user.  

Current date Logged in user’s name 

and access level 

The Impact Title desktop may 

show your company logo 
Tool bar icons 

File Number 

when open 

 

Seller & Buyer Names 

when file open 

 



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 12 of 181 

Title Toolbar 

If the user has set the option to present the tool bar (Options > Show Toolbar), which displays under the 

menu at the top of the Title desktop, they will see a row of icons that can be used to initiate actions 

without using the menus.  Holding the cursor over the icons will present tooltips identifying each icon’s 

purpose. 

 

 

The table below details the tools and their Quick Key alternatives, if the user does not want to use the 

mouse. 

Button Tool Name Quick Keys 

 
New File (Direct Order)  ALT+F then N (if option for DO’s enabled) 

 
Save File  ALT+F then A 

 
Open Existing File  ALT+F then S 

 
Copy Base & Subdivision Files  ALT+B then C 

   
Edit Legal  ALT+E then L 

  
Edit Prelim/Commitment  ALT+D then P 

  
Edit Policy  ALT+D then O 

 
Select & Edit Documents  ALT+D then S 

  
Endorsements  ALT+S 

 
Create and Edit Invoices  ALT+M then I 

 
Tracking  ALT+F then T 

 
File Status  ALT+F then P 

 
Search For File  ALT+F then S then ALT+S 

 
Rate Calculator  ALT+M then T 

 
Name and address file (NAF)  ALT+A then A 

 
Conversation Log  ALT+F then L 

   
File Notes  ALT F then E 

 
View File History  ALT+F then V 



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 13 of 181 

Switching Profiles 

There are some Impact users that have multiple sets of Impact Initials (“profiles”) so that they might 

perform a variety of typically unrelated tasks in one module – or to work in different branches (but not all 

with a single set of initials).  Historically, these users had to log out of Impact and log back in to be able to 

select a different “profile” (set of Impact Initials).  There is a function in Impact that permits those with 

multiple profiles to switch between those that they have which are applicable to the module they are in, 

while staying in the module.  If a user has multiple profiles for the particular module they are in, with 

different permissions or branch assignments, they will see their Name, Branch Assignment and Access 

Level, from the profile they are currently logged into Impact with, in the middle of the bottom of the Impact 

desktop, in the form of a link (blue-colored text).  Clicking on the link will bring up a screen of the other 

profiles that they have available to them related to the module they are in.  The user should highlight the 

desired profile and click on OK and the user’s access level and/or branch will be altered accordingly.  

Should there be a file open on the desktop when this action is triggered, the user will be warned about 

that and will be asked if the file should be closed and the switch made or not. 

 

 

 

 

 

 

 

 

 

Exit 

Users should exit out of Impact when they leave their desks for an extended period, or are going home for 

the day. They should use the boxed X  icon, in the upper right corner of the Impact desktop window, 

to exit.  Users should always exit out of Impact at the end of each day, before logging off of their 

computers. If users leave their Impact Title session logged on, others will have access to their “rights”, 

and this could raise security concerns.  Remember that work done under a user’s initials will bear that 

user’s name.  The menu path to exiting is File > Exit in the Title module. 
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Impact Widget Dashboard 

Impact Widgets were introduced in Impact/SQL version 8.0.  They are comprised of, in this version of the 

Title module, up to four (4) “floating windows”, each presenting different functional areas, which can be 

opened (or not) and positioned as the user wishes on his/her desktop.  The functions addressed by each 

will be discussed elsewhere in this manual, but the widgets are: Pending Prelims as Title Officer, 

Pending Prelims as Typist, Report Schedules and User Attachments. 

 

 

 

 

 

 

 

 

 

 

 

At the bottom of the Impact Title desktop window there is a dark band, labeled as the Impact Widget 

Dashboard.  At the right side are two icons: 

       This icon is used to order the widget windows which are on the desktop by name, in alpha 

ascending or descending order, and will tile the windows from the upper left corner of the 

Impact desktop. Widgets can be sized and positioned by the user, in typical Windows fashion. 

          This icon is used to open the widget selection window, as shown above.  Highlighting a 

widget name and clicking on it will either open or close the widget, depending on its 

current status. 

The three icons at the top right of each widget window are used to   Refresh the window content, 

Collapse or  Expand the window and    Close the window. 
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Report Scheduling 

The ability to schedule reports is introduced with Impact/SQL version 8.0.  Scheduled reports will print in 

the background, freeing up the user to go on and perform other Impact functions.  Reports can be 

scheduled on a one-time basis or to print on a recurring basis.  The Impact Windows Service must be 

installed and functioning for report scheduling to function.  Scheduled reports can be tracked on the 

Report Schedules Widget (discussed above).  If a report can be scheduled, the user will see a 

Schedule button on the report’s 

option selection screen, like that 

shown here. 

If the Schedule button is present and the user wishes to schedule a report to run in the background, 

either once or on a recurring basis, the user should first set the report options (unique by report type and 

discussed elsewhere in this manual) and then click on the Schedule button.  A screen like the ones 

shown here will be presented, on which the user will manage scheduling options.  Two versions are 

shown below, one indicating the report is to run one time, and the other is preparing to schedule the 

report to run on a recurring basis.   

NOTE: only printers available to the Impact Windows Service will be available for scheduled reports. 

This Impact Report Scheduler screen                                    This Impact Report Scheduler screen  

reflects a One Time Schedule Type.                                       reflects a Recurring Schedule Type. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The system name of the report is reflected at the top of the screen (*.rpt), next to the Report File label.  

The name for the report, to appear on the Report Schedules Widget screen, is in the Schedule Name 

field, and the default value can be edited.  A Brief Description field is also available for an additional 

user comment. 
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The Schedule Type field is next, and can be set to One Time or Recurring.   

If Recurring is selected, the Interval Type can be set to Daily, Weekly or Monthly.   

If Daily is selected, the Days of Week entries, in the Timer Information section, are all checked and 

cannot be changed…the report will run seven days a week, at the time the user sets in the Timer Time 

field.   

Alternatively, select Weekly and check those days the report should run (one or more) each week, and 

set the time.  Check all weekdays for Monday-Friday, for example.   

If the user checks Monthly, the Days of Week section of the 

screen will be replaced with one like that shown to the right 

that only asks what time of the day to run the report.  The 

Report Date Range section, below, is used to detail the 

data range to present. 

 

 

 

The Report Date Range section of the screen is used to select the date range of data to be included on 

the report, whether it is being run once or on a scheduled basis.  The options available are shown in this 

screen shot.  Most are self-explanatory; the Custom Range option allows for running the report forward 

or back “x” number of days from the current date.  So, if the user wanted the report to present the last 7 

days of activity, each time it is run, he/she could do that, as shown below (right). 

 

 

 

 

 

 

 

Once a report is scheduled, it will appear on the 

Report Schedules widget screen. The Report 

Schedules widget screen shown to the left 

reflects a Log Book report having been 

scheduled.  The report’s schedule can be 

modified, or deleted from this screen. 
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User Attachments 

The User Attachments widget provides for a TEMPORARY file storage area, by file, from which users 

can email, print or publish (if so configured) multiple documents at one time – again, by file.  This provides 

for the ability to print, email or publish a group of dissimilar documents at one time (such as a HUD along 

with other Word-based documents).  When users are generating a prelim, policy or other document they 

will see an “Attachment” option on the print dialog box, which will generate a copy of the item and put it 

in the User Attachments area, organized by file number.  Documents from outside of Impact can also be 

added to the User Attachments area, with the  “Add Documents” icon.   

When the  “Add Documents” icon is clicked upon the user will be presented with a variable menu, 

depending on whether there are already documents attached for one or more files and whether the 

system is configured for a document management system.  The user can attach a file (PDF, Word, Excel, 

JPG, GIF or TIF) that is on an accessible drive, using the Add Documents > Select File path.  The Add 

Documents > Outside System path will let the user attach documents from their document management 

system (only smartVIEW at this writing – January, 2015). 

Setup Options are available to force deletion of items from the User Attachments area after “X” number 

of days.  Users will be prompted, if the options are set, upon leaving a module, if they have attachment 

files older than the threshold, as to whether they wish the documents to be deleted.  They will also be 

prompted as to whether the items should be deleted after they print, email or publish them.  They can 

also  Preview a PDF version of the item,  Rename it or  Remove it, with the icons provided on 

each. 
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File Menu 

The File Menu’s content can vary depending on system configuration.  The full listing of possible entries 

is presented below, and all will be explained in this section of the Title manual.  The order of the menu 

entries is not indicative of workflow.  These items will be explained in menu order. 

 New File (optional) 

 Select File 

 File Progress Report 

 Tracking (optional) 

 Modify Direct Order Status (optional) 

 Conversation Log 

 File Notes 

 Impact Online Documents (optional) 

 View File History (optional) 

 Outside Services (optional) 

 Save File 

 Exit 

The Recent File List, if turned on to be presented (Options > Show Recent File List), will display below 

the File Menu.  The last 10 opened files will be listed and the user can open a file from that list by clicking 

on it. 
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New File (Direct Order) (optional) 

The ability to create Direct Orders in Impact/SQL is optional.  This discussion assumes the option is 

enabled. 

The New File menu entry, or the  New File icon, will trigger the opening of the New Direct File screen 

shown here.  A Direct Order (file created through Title) cannot have any Trust Accounting done in it, just 

invoicing.  They are true “title only” files.  Most sites use a “Title Only” Escrow branch for title only work, 

rather than using Direct Orders in a Title branch, as they wish to do escrow trust accounting in those files 

(for payoffs or to collect fees through the file). 

 

 

 

 

 

 

At the top of the screen, the Title Branch for the new file is identified.  Depending on the user’s Access 

Level, branch assignment, and system configuration, there may only be one branch available (it will be 

shown but grayed out and cannot be changed) or all title branches will be available, and the user will 

select the correct branch for the new direct order file via the dropdown arrow to the right of the Title 

Branch field. 

The File Number Options section, on the New Direct File screen, is used to determine how the file 

number will be assigned to the new direct order file.  The options are to take an Automatic number or 

enter a Manual number.  Depending on your company’s configuration, Automatic or Manual numbers 

may be deactivated (dimmed out). 

Automatic numbers are numbers assigned by a predetermined setup with numbering by branch or by 

database.  Automatic numbers may be numeric or a combination of alphabetic and numeric of up to 

eight (8) characters.  When using Automatic numbers, Impact will assign the current date as the open 

date. 

Manual numbers can be all numeric, all alphabetic, or a combination of alphabetic and numeric of up to 

eight (8) characters.  Manual numbers will require the user to supply an Original Setup Date for the file.  

Enter the 2 digit month, 2 digit day, and 2 digit year, for example, “013114” for January 31, 2014.  The 

year’s digits need not be entered if the current year is desired.  The user can also click on the  

Calendar tool just to the right of the date entry area to select the date, or use the CTRL+D Quick Keys, to 

pull up the calendar tool. 

Note: Do not enter hyphens or slashes when entering dates into Impact. 

Once OK is clicked on, the user will be taken to the Opening Information screens. 
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Select File 

The Select File option, on the File menu, will present a screen for the user to enter an existing file 

number into, in order to open the file for data entry work.  The  Open Existing File icon, on the toolbar, 

can be used to get to the same screen, as can the ALT-F then S Quick Key shortcut. 

 

 

 

 

 

 

The File Number Entry screen (shown above) has the user identify the type of file they are entering a 

number for (existing files) or lets the user create a new Direct Order or use the Search function to find an 

existing file. 

The  New File icon, at the top of the screen, will take the user to the New Direct File screen discussed 

earlier in this manual.  The option will only be enabled when the user clicks on the Direct radio button. 

The  Search icon, at the top of the screen, will take the user to the File Search screen discussed 

earlier in this manual. 

If the user knows the escrow file number, of an existing order that they wish to work on, they would click 

on the Escrow radio button and enter the number, then click on OK to continue. 

If the user knows that they are asking for an existing Direct Order file to work on, they would click on the 

Direct radio button and enter the number, then click on OK to continue. 

If the user knows the title file number of an existing escrow file that they wish to work on, they would leave 

the default selection of the Title radio button and would enter the title file number, then click on OK to 

continue.  NOTE: a title file number is a separate number for an escrow file – it does not designate a third 

file type.  It is possible, with a system configuration setting, to have different title file numbers from the 

escrow file number, but in most cases the unique title file numbers are not used.  Title file numbering is 

simply another way to label the same escrow file.  Title file numbers, if used, are numeric only. 

Selecting the file category, entering the file number in the field provided and clicking on OK will open the 

file for data entry.  If another user has the file open (and thus has a “lock” on the file) a message will be 

presented explaining that and ask if the file should be opened in “read-only” mode.  In “read-only” mode, 

the user will be able to look at the data in the file but not change any of it.  A sample of that message is 

shown here. 
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File Progress Report 

The File Progress Report menu option, on the File menu, opens the File Number Entry dialogue box 

shown on the previous page.  If there is already a file open on the desktop the appropriate File Type 

radio button will be selected and the file number entry field will be pre-filled with the current open file 

number.  The  Search icon can be used to search for a file number.  Once a file type and file number 

are provided, and the OK button is clicked, the system will present the Escrow Status Information 

screen (if an escrow or title file number had been provided), or the Direct Order Status Information 

screen, on which information on the full life cycle of the file will be presented, as shown below (Escrow 

sample shown below; the Direct Order Status screen is similar).   

 

 

 

 

 

 

 

 

 

 

 

 

 

At the top of the screen are two icons.  The  Change File icon is used to select another file for viewing.  

The  Print icon is used to generate a printed report of the file information. 

General information about the file is presented at the top of the screen, under the aforementioned icons.  

There are four (5) tabs of information below the general file information:  Info, Tracking, 

Prelims/Commitments, Policies and External Systems.  If there is content on those tabs, there will be 

a  red diamond in front of the tab name.  Some general comments on some of the data presented 

follows. 

The Branch Number, Type of File and Manual Date are determined when a new escrow file is 

established. 

The Escrow Officer, Project Name, Date Opened, Opened By, Est. Close Date, Funding Date and 

Date Entered are pulled from Initial Questions > Dates/Transaction Info.  

If the database is configured to automatically close the file when the revenue check is cut, then the Date 

Closed and Date Recorded will be the date the revenue check was cut.  Otherwise, depending on the 

database configuration, Escrow may enter the Date Closed and Date Recorded from the Disburse > 

Close File menu path. 
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The Last Changed date and time is updated when a user signs into the escrow file.  If the database 

configuration is set to Enable File History Log, the user will be able to produce a listing of who accessed 

the file and when from File > View Escrow History. 

The Date Ordered and Ordered By is updated when the current user signed into the file sends the file to 

Title via Edit > Order Title Search or Edit > Initial Questions > Title Search.  

If the database configuration is to Auto Print Title Instructions in the Title Department, then the Date 

Accepted is updated when the title instructions print.  If the Title Department is manually printing the title 

instructions one by one the Date Accepted will be blank. 

The Search Date, Search Inits, Exam Inits, Exam Date, and Into Typing Date, on the Info tab, are 

updated when Title inputs the information within the Title module under Edit > Update Search & Exam 

Info. 

The Typist Inits, Examiner Inits, Type Date, and Released Date are automatically updated when the 

Prelim/Commitment is created.  This information is on the Prelims/Commitments tab.  This information 

is on a separate tab to accommodate Commercial files, which can have a prelim/commitment for each 

property.  The properties on the Prelims/Commitments tab are listed in the same order as they are 

presented on the Property Information screen. 

As an additional aid in the communication flow between Title and Escrow, when an amended 

Prelim/Commitment is generated, the escrow officer will automatically be notified via e-mail. 

Information on the policy(ies) is displayed on the Policies tab. The Policy tab’s data is automatically 

updated when the Title Department creates the policies.  The Policy Date reflects the date the policy(ies) 

was created, not the ”as of” date of the policy.   

The IRS Reporting field is updated with “Completed”, if a physical 1099-S was created under Disburse > 

1099S.  If the file is flagged as Non-Reportable, that information will present. 

The Buyer #1, Seller #1, Realtor (who is the Listing/Seller Broker), Property Address,  Type of 

Transaction, Lender #1 Name, Sales Price, Loan Amount, Marketing Rep, Escrow Co/Other, Title 

Officer (the name from Initial Questions > Title Information > Title Officer), Parcel Number, and 

Processor are updated when the Escrow user updates the escrow file in Edit > Initial Questions. 

The Title Department is updated when Escrow sends a file to Title via Edit > Order Title Search or Edit 

> Initial Questions > Title Search. 

The date fields, for files created on or after a site went to version 8.1 of Impact/SQL, will reflect the time 

as well as the date. 

Information on the Tracking tab is explained in the Tracking section of this manual (next). 
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Tracking 

The Tracking function, under the File menu, is a customized tool to track items that are not specifically 

detailed on Initial Questions or on HUD lines. Tracking may be used to keep track of some items 

required by the escrow instructions, for example.  Depending on system configuration, Title users may be 

able to see the Tracking detail on Escrow files, or they may be limited to only working with Tracking on 

Direct Orders.    Default Tracking templates can be set up for each transaction type, or for all files, by the 

System Administrator, through the Utilities module.  It is possible (starting with version 8.5 (046)) to set 

individual tracking items as “Tasks”, which cannot be deleted by the user on individual files. The 

Tracking Entry screen allows an unlimited number of separate items to be maintained.  Fields within 

Initial Questions or HUD/Settlement Statement entry screens will not update Tracking, nor will Tracking 

update the HUD/Settlement Statement.  Tracking is a useful tool to inform others in the office of the status 

of items ordered and completed.  The following discussion will assume that the Title user has access to 

Tracking detail on Escrow files. 

After selecting Tracking from the File menu, if the user has a file (escrow or direct order) open on the 

desktop the File Type will be pre-selected on the File Number Entry screen, and the file number field will 

be pre-filled with the file number.  If no file is open on the desktop, the File Number Entry screen will 

open and the user should select the File Type and enter the file number.  Click on OK to continue or click 

on Cancel to exit. 

If the user has selected a Direct Order and there are not yet Tracking items set up for the file, the 

default set of Direct Order Tracking entries, if any exist, will be loaded and presented to the user. 

If the user has selected an Escrow file and there are not yet Tracking items set up for the file, a 

Tracking Template dialogue box will pop up with a prompt asking if the user would like to use the default 

tracking template?  The user would click on Yes to bring in the default set of Escrow Tracking entries, or 

click on No if only manual entries are desired. 

 

 

 

 

The Tracking Entry screen (shown on the next page) presents the Description of the items to be 

tracked, the Date Ordered, Date Received, and a column for Comments.  “Task” items are shaded 

gray, and cannot be deleted. 
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The checkboxes, in the Date fields, are used to quickly enter the current date and time.  They are the only 

way to enter dates on “Task” entries.  To use the Calendar tool in any of non-Task item Date fields, click 

on the field to highlight it, then click again or hit the ENTER key to enable editing of the date fields. 

Click on the last column and enter text to include Comments. 

To the right of each non-Task entry, the  Delete icon can be used to remove the entry. 

There are icons at the top of the screen to  Change File, add a  New Entry and to  Print the 

listing of events for the file.  

Tracking may be customized per file.  Depending on system configuration, the Title Department may 

have the ability to add or modify the Escrow Tracking data.  Each entry field has 50 character positions 

available for comments.  The user can add items to be tracked, if the default set does not include a 

needed item.  Adding a new tracking item will add it to the bottom of the list. 

The Cancel button will close the window and abandon any changes, without a warning. 

The OK button save changes and close the Tracking Entry window. 

 

  

To Add a new entry, click here Type in comments here 

For the Calendar tool, click on 
field, then click again or hit 
ENTER – on non-Task items 

Date last changed 
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Modify Direct Order Status (optional) 

If the system is configured for Direct Orders, the Modify Direct Order 

Status option, on the File menu, opens the Order Number Entry 

dialogue box.  If there is already a direct order file open on the desktop the 

Enter the Order Number entry field will be pre-filled with the current open 

direct order number.  The  Search icon can be used to search for a file 

number. 

The Modify Direct File Status screen has four (4) choices 

in the Status area, Active (Open), Cancel, Set For 

Deletion, and Hold.  None of the options will prohibit the 

user from modifying the file or creating documents.  The 

options are status flags only.  Any status flag may be 

reversed.  The direct order status can be utilized in 

reporting. 

The Active (Open) status reflects an order that has not been 

flagged with Cancel, Set For Deletion, or Hold.  Closed files 

will reflect Open on the Current Status area of the screen, 

plus the screen will reflect when the file was closed with a 

message:  “Closed on mm/dd/yyyy”. 

The Cancel status is used on an order that was cancelled per the parties involved or a file was opened in 

error.  The number of cancelled orders will appear on management reports.  After Cancel is selected the 

Reason field will be enabled to allow for the entry of a reason for the order’s cancellation.  An automatic 

Title Order Sheet with “Cancelled” imprinted on it will be sent to the Title Department, when an order is 

cancelled. 

The Set For Deletion status is reserved for future use with archiving, but currently there is not an 

archiving function in Impact/SQL. 

The Hold status is used to identify orders that should not be archived (for example, master condos or 

projects).  An order flagged as on Hold will not be archived, when that functionality is added to 

Impact/SQL.  Again, there is no archiving function at this time. 

The Hold status, when turned on will exclude that order’s documents from being deleted by the Batch 

Processor/Impact Windows Service document deletion routine. 

Click on OK to accept the choice, or on Cancel to quit without saving. 
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Conversation Log 

The Conversation Log is a utility through which notes of conversations partaken in during an escrow’s or 

direct order’s life can be stored.  The Conversation Log is used to keep a chronological order of 

conversations entered by date, time and user.  It can also be used when someone other than the escrow 

or title officer takes a call concerning the file.  The conversation logs from Escrow can be shared, by 

system setting, with Title and vice-versa. 

Entries to the Conversation Log cannot be modified after entry and can therefore be used as evidence 

in a dispute.  The Log does not spell check typing. 

There are three icons at the top of the screen 

that are used to  Change File, add a  New 

Entry and to  Print the Conversation Log 

entries. 

There is an  Info icon to the right of each 

entry that will open up a window showing the full 

text of the entry.  Again, entries cannot be 

edited nor deleted. 

The entries are sorted, by default, in 

descending time order, with the most current on 

the top of the list.  Clicking on any column 

header will alter the sort to be by the column 

clicked.  Re-clicking on the column header will 

invert the sort (ascending vs. descending).  A custom sort can be done with the  Sort icon in the upper 

right corner of the screen. 
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File Notes 

The File Notes function allows the user to enter notes that are not specific to a party or property on a file, 

but are, rather, file specific.  It also provides a storage facility for recording data from SoftPro 360 widget 

integrations which are not fed to specific fields within Impact/SQL. The File Notes are accessed via the 

File menu in both the Escrow and Title modules.  They can also be accessed via the  File Notes icon, 

on the desktop toolbar, or via the same icon on the data entry wizard toolbar.   

When requested, and a file number has been 

provided, the File Notes screen will be 

presented.  The sample to the right has had 

some entries recorded by the SoftPro 360 

widget’s RealEC integration and one entered 

manually.  

The  Change File icon, at the top of the 

screen, is used to switch files for entering File 

Notes.   

 

 

The  New Entry icon, also at the top of the screen, will 

bring up a blank File Note Entry screen, where a manual file 

note can be entered by the user.  

 

 

 

 

The   Print icon will prepare a report of all of the 

File Notes for the selected file. A sample is shown to 

the left. 

 

 

 

The  Modify icon, to the right of each entry on the File Notes screen, will bring up the File Note Entry 

screen, where the user may view previously entered information (entered either by an integration or 

manually) and add to it or edit it, as need be. 

The Internal use only checkbox is used to flag an entry for exclusion from custom reporting that might be 

developed, if so desired. 

The  Delete icon, to the right of each entry on the File Notes screen, will remove a File Note.  
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Impact Online Documents (Impact Online sites only) 

The Impact Online Documents option, on the File menu, will only appear on sites utilizing Impact 

Online.  Impact Online is used to allow customers to open escrow files via the Internet and to let 

customers view documents published from Impact to Impact Online.   

The option, in Title, is used to do two specific functions: Delete documents that have been published to a 

file in Impact Online and to alter viewing permissions to parties to the file on published documents. 

 

 

 

 

 

 

 

 

 

 

The screen above will present after the user identifies the escrow file for which Impact Online-published 

documents should be managed.   

The  Change File icon, at the top of the screen, is used to switch to a different file’s published 

document list. 

The  Delete Selected icon, at the top of the screen, will be enabled once one or more documents have 

been selected by entering a checkbox in front of the document Description.  This action will delete the 

document(s) selected from Impact Online, not from the Document List for the file in Impact. 

The checkboxes under the party type headings (Buyer, Seller, Lender, Listing, Selling and Other) 

indicate whether those party types have permission to view the specific published documents.  These are 

set when a document is published, but can be altered from this screen. 

Click on OK to save changes and return to the Title desktop. 
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View File History (optional) 

There are events that occur within Impact/SQL that are tracked and written to a history log file.  If the 

option is turned on, in Utilities, to allow users to view the history data, users will see the View File History 

option on the File menu.  The user will be prompted to enter the Escrow, Direct Order or Title file number. 

The events that are tracked include: 

File Initial Opening;  

Change of File Status;  

Title Instructions Printed;  

HUD or HUD1A Printed;  

User Opening of the File (on desktop);  

Copy Base action is taken;  

NextAce data is imported into 

Commitment or Policy;  

Commitment/Prelim is Typed;  

Commitment/Prelim is Released;  

Policy Typed;  

Change of Branch of File;  

Change of Data Entry Type;  

File Copy;  

Fees Imported;  

Vesting Data Imported;  

Messaging activity (such as File Publishing to smartVIEW);  

Commitment/Prelim Deleted;  

Sale Price Changed;  

Messaging Item;  

Loan Amount Changed;  

Buyer Name Changed;  

Seller Name Changed;  

Marketing Rep Changed;  

Marketing Rep Percentage Changed;  

Title Charges Status Changed;  

Ordering of Title Search; and  

Legal Updated. 

Some of the items tracked will reflect the Previous Value and New Value on the View File History 

screen. 
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The  Change File icon, at the top of the screen can be used to pull up the history for another file. 

The  Print icon can be used to generate a printed report of the file’s history. 

 

Outside Services (optional) 

Should the environment be configured with one or more integrations with outside services, such as with 

RealEC, the Outside Services menu option will appear on the File menu.  This option is used to gain 

access to the interfaces of those service providers.  Separate documentation on those integrations should 

be consulted for further information on functionality. 
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Save File 

When a file is opened on the user’s desktop (indicated by the file number being presented in the lower left 

corner of the desktop screen), the Save File option will be enabled on the File menu.  This option is used 

to save any data changes not already saved and will unlock the file and remove it from the desktop – 

freeing it up for others to work with.  It is highly recommended that any file be saved out of as soon as it is 

not being worked on, to make it available for other users who may need to access it. 

The  Save File icon, on the tool bar, performs the same function. 

Choosing the Select File or New File options will automatically execute the Save File function if there is 

a file already open on the desktop. 

 

Exit 

The last entry on the File menu is Exit.  This function is the same as clicking on the  Close icon in 

the upper right corner of the Impact/SQL Title desktop.  This will shut down the Title module.  Should 

there be a file open on the desktop, it will be saved before the module is closed.  It is highly 

recommended that the user exit the application when they leave their desk or go home for the day so that 

they do not leave the system accessible under their login – giving others the opportunity to work in the 

system as though they were the user. 

 

 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 32 of 181 

Edit Menu 

The Edit menu, in the Title module, contains functions for data entry, for editing the legal description, for 

logging title’s efforts on files, for working up and releasing the preliminary report/commitment documents, 

for preparing policies, to copy base file information, and to enter recording information.  The Edit menu is 

only activated when there is a file open on the user’s desktop.  This means the file is locked to other 

users, so that there is not a conflict over data being entered and saved on the file by more than one 

person. 

There are up to eight (8) entries found on the Edit menu; the first, Opening Info, may or may not appear 

depending on system configuration and whether the user is working on an Escrow file or a Direct Order.  

The menu will reflect the following items, each of which will be described in the following pages: 

 Opening Information (optional) 

 Legal Description 

 Update Search & Exam Info 

 Create Prelim/Commitment 

 Release Prelim/Commitment to Escrow 

 Create Policy 

 Copy Base Files & Subdivisions 

 Recording Information 
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Opening Information (optional) 

The Opening Information entry, on the Edit menu in Title, varies in its sub-menu presentation based on 

system configuration and the type of file the user has opened on the desktop.  If an Escrow file is on the 

desktop (opened via entry of an Escrow or Title file number), and the system is configured to not allow 

Title to edit any opening information, the menu entry will not appear at all.  Alternatively, the system can 

be configured to allow All or Partial editing, by Title, of opening information on Escrow files – as will be 

discussed below.  There are also variations on the data entry screens if an Escrow file is a Residential 

file or a Commercial file.  If a Direct Order is opened on the desktop, the sub-menu of data entry 

screens will be different from those for Escrow files.  The following discussion will present the screens of 

data on Escrow files first and will then present those for Direct Orders. 

If the system is configured to allow Title to edit All Opening Information on Escrow files, the following list 

of screens is presented on the Opening Information sub-menu: 

 Dates/Transaction Information 

 Properties 

 Parties 

 Source of Business/Bill To 

 Title Information 

 Prelim Distribution List 

 Miscellaneous Date Entry (if utilized) 

If the system is configured to allow Title to edit Partial Opening Information on Escrow files, the following 

list of screens is presented on the Opening Information sub-menu: 

 Properties 

 Parties 

 Prelim Distribution List 

The following list of screens is presented on the Opening Information sub-menu when a Direct Order is 

opened on the desktop: 

 Dates/Transaction Info 

 Property Information 

 Seller Information 

 Buyer Information 

 Lender Information 

 Title Information 

 Source of Business 

 Billing Information 

 Prelim Distribution 

 Miscellaneous Date Entry (if utilized) 
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Opening Information – Residential Escrow File 

The Opening Info entry screen listing, under the Edit menu, will present, for Residential Escrow files, 

between six and eight (6 & 8) items, depending on system configuration (listed below).  These screens 

are used, primarily by Escrow, to enter the data required before submitting an order to Title.  Since not all 

fields pertain to every escrow, the user must determine which data to enter.  Some fields in Opening 

Information can be set to require an entry – they can be made mandatory.  Mandatory fields will have a 

green background on the data entry screens.  Generally, Escrow will have entered all required 

information on a file, but Title may need to make edits to some of the information, and can be granted 

access to do so.  Title users should notify Escrow if they change data in a file. 

 Dates/Transaction Information 

 Properties 

 Parties 

 Source of Business/Bill To 

 Title Information 

 Title Charges (optional) 

 Prelim Distribution List 

 Miscellaneous Data Entry (optional) 

Functional and Navigational Icons on the Opening Information 

Screens 

At the top of the Opening Information screens, there are a set of icons used to perform functional and 

navigational tasks. 

The  Save & Exit icon is used to get out of the Opening Information screens.  Any data changes that 

have been made are saved to the database through use of this icon.  There is not a way to exit without 

saving changes that have been made to the screens. 

The  Print icon has one option under it:  Title Instructions.  The user can print the Title Instructions, 

for the file on the screen, with this option by clicking on the dropdown arrow and selecting Title 

Instructions. 

The  Legal icon is used to take the user to the Edit Legal screen, where the full legal description(s) 

can be edited. 

The  Pre/Com icon is used to take the user to the Prelim/Commitment screen, where the 

prelim(s)/commitment(s) can be edited. 

The  Policy icon is used to take the user to the Create Policy screen. 

The  Docs icon is used to take the user to the Title Documents Menu. 

The  File Notes icon is used to take the user to the File Notes screen. 
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The  Previous icon will be grayed out if the user is on the first screen of Opening Information.  If not 

on the first screen, the icon can be used to move back through screens as they are being worked up. 

When the  Jump icon is clicked on, a listing of all of the Opening Information screens is presented so 

the user can “jump” to a screen out of order.  In addition, there may be an entry on the screen listing to 

jump to the HUD 1100 (Title Charges) entry screen, without having to save and exit. 

The  Next icon will take the user to the next screen of Opening Information, unless the user is on the 

last screen, and then the icon will be grayed out. 

The  Calendar tool presents next to date fields and can be used to select a date.  Alternatively, the 

user can simply type in the date in MMDD form (if current year) or MMDDYY if not the current year. 

The F4 function key can be used to open dropdown menus for the fields with them. 

The TAB key can be used to move from field to field.  
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Dates/Transaction Information Screen (Residential) 

The first screen of Initial Questions is the Dates/Transaction Information screen, shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

Order Type is the first field at the top of the screen, if the system is configured to present it.  A default 

can also be set for the database.  The options are Escrow & Title, Title Only and Escrow Only.  The 

dropdown list is presented by clicking on the arrow to the right of the field, or clicking on the F4 function 

key.  The user can also hit the “E” or “T” keys to move through the options (“E” for the two entries starting 

with “E”, “T” for Title Only).  The primary use of this field is for categorization of transactions for 

management reporting.  However, the Escrow Only selection will eliminate the prompts about submitting 

the order to Title; the user can still submit manually – but should not need to.  The Title Only selection 

will cause the file to be marked “Non-Reportable” (with regard to 1099-S issuance). 

Type of Closing is the next field and it is important to understand the options available.  The Type of 

Closing assigned to a file can be changed, but there will very likely be data lost (if any has been entered) 

if the type is changed after initial file opening.  A message as to the data that will be lost will be provided 

to the user. 

 HUD – used for files that are not confirmed to need to consider the 2010 RESPA or 2015 CDF  

requirements and with which the user wishes to use data entry forms that resemble the HUD 

sections, with HUD numbering.   

 Worksheet – used for files that are not confirmed to need to consider the 2010 RESPA or 2015 

CDF requirements, and with which the user wishes to use data entry forms that do not have HUD 

numbering and which include extra proration and rent schedule fields.   

 HUD with GFE – used for files that must comply with the 2010 RESPA regulations that require a 

GFE Comparison and Loan Terms schedule, among other things, and with which the user wishes 

to use data entry forms that resemble the HUD sections, with HUD numbering and GFE data 

entry fields.  A HUD-1A cannot be generated with a file of this selection. 
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 Worksheet with GFE – used for files that must comply with the 2010 RESPA regulations and 

with which the user wishes to use data entry forms that do not include HUD line numbering.  This 

selection is very infrequently used, as the RESPA regulations direct items to specific line 

numbers and not having them available for reference makes data entry difficult. A HUD-1A 

cannot be generated with a file of this selection. 

 Commercial – this type of closing will set the file as a Commercial file (details on the differences 

of Commercial files will follow the discussion of Residential files). 

 CDF (Closing Disclosure Form) – this Residential file type will be the most commonly used type 

after October 3, 2015. The Closing Disclosure Form data entry wizard, in the Escrow module, is 

utilized to enter information beyond Initial Questions on this file type. 

 

The default Type of Closing can be set for the database, but the user can always select the other 

options (unless the database is set to allow Worksheet styles only – which is very rare due to the 2010 

RESPA and CDF 2015 requirements).  The user will be prompted to confirm the change upon tabbing out 

of the filed or clicking on Save & Exit.  Should the file have additional deposits, the user will receive a 

warning that deposit entries will be deleted when the change is made. 

As indicated previously, a Type of Closing can be changed at a later time to another type.  The user will 

be prompted, when the user tabs out of the field, or clicks on Save & Exit to end data entry, that there will 

possibly be data lost and to confirm the switch is desired.   

Escrow Officer – all files must have an escrow officer assigned to them, even Title Only files.  The user 

should select an escrow officer from the dropdown list.  Only EO’s assigned to the branch of the file will 

be presented.  The flagging of a user as an Escrow Officer is done through the Users function, in the 

Utilities module, by a System Admin.   A Secondary Escrow Officer field may present if the option to 

add a second is enabled. 

Title Officer – the dropdown list presented is of internal title officers assigned to title plants available to 

the branch of the file.  If a TO is selected, the title branch of the TO will be the title branch the file is 

submitted to, when submitted to Title.  If no TO is selected, and the branch of the file has multiple title 

branches available to it, when the user submits the file to Title, they will be prompted to select a title 

branch for the submission.  The flagging of a user as a Title Officer is done through the Users function, in 

the Utilities module, by a System Admin. 

Processor (1 or 1-3) – this field is used to identify an escrow secretary or escrow assistant that will be the 

primary support person for the file.  All users assigned the Processor flag will appear in the dropdown.  

The email notification on the release of the prelim/commitment, if so configured, will go to both the 

Processor and the Escrow Officer assigned to the file.  The flagging of a user as a Processor is done 

through the Users function, in the Utilities module, by a System Admin.  There is a system option that 

can be enabled that will allow up to three processors to be assigned to every file. 

Marketing Rep (1-2, or 1-4) – depending on system configuration, two or four marketing rep fields will be 

presented to the user.  The appropriate rep(s) should be selected by the user, and if more than one rep is 

selected, each (other than the first) should be assigned their “ownership interest” percentage.  The 

undefined balance will be considered the first rep’s interest.  The percentages can be used in 

management reporting.  The dropdown list of marketing reps is maintained in the Utilities module, by a 

System Admin, in the Marketing Reps User Table. 

Date Opened – this field is pre-filled with the date the file was created but can be changed by the user 

manually or with the  Calendar tool.  There is another system-managed date field, that the user cannot 
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change, that maintains the actual date the file was created – which tends to be the field used in 

management reporting. 

Contract Date – this field is used to enter the date of the purchase contract, if there is one.  This field is 

available to be pulled into escrow documents. 

Close of Escrow Date – this field is used for the anticipated closing date.  It prints as the Settlement 

Date on the HUD and Settlement Statement.  If this 

date field is changed, after being initially set, a pop-

up window will remind the user to check on the 

Proration Date.   

This date is also used as the basis for closing projects.  A separate Close Date field is maintained by the 

system, normally the date that the Fee Check/Fee Slip was generated, which is most often used for 

management reporting. 

Contract Number – this field is used in conjunction with the Contract Date, as needed. 

Proration Date – this field is used to set the beginning or 

ending date on certain prorations.  If the proration date field 

is changed, the user will receive a prompt asking which 

prorations should be altered by the system – giving the user 

control over whether existing calculations should be 

changed.  If some data has not been entered, not all of the 

prompt’s options will be enabled.  The user may check any 

and all enabled options – with the Taxes, Assessments and 

Miscellaneous prorations option being pre-checked.  If that 

option is not desired, the user must uncheck it. 

Funding Date – this field is used to identify the funding date and will appear on the HUD. 

Disburse Date – this field is used to identify the disbursement date of the file and will appear on the 

HUD.  There is a Setup Option that can be set that will set the Disburse Date to the date of the fee 

slip/fee check, when the item is issued. 

Signing Date – this field is used to identify the signing date for the transaction and will appear on the 

HUD in box “I”. 

Type of Transaction – the transaction type is selected from the dropdown list.  This field is used to 

categorize files for management reporting.  This field is often mandatory.  The transaction type lookup 

table is maintained, through the Utilities module, by a System Admin.  Transaction types can be flagged 

to enable 1099-S reportability or to prevent it. 

IRS Reportable – this checkbox is used to indicate whether the specific file will have 1099-S reporting 

done out of it.  If the transaction type previously selected is flagged to indicate files of that type are not 

subject to 1099-S reporting, this option will be grayed out. 

Exchange – this checkbox is used to indicate the transaction is involved in a 1031 Exchange – so that 

the corresponding checkbox on any 1099-S produced will be checked.  If the transaction type previously 

selected is flagged to indicate files of that type are not subject to 1099-S reporting, this option will be 

grayed out. 
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Cash Sale – this checkbox is used to indicate if the transaction is a “cash” transaction.  The flag will be 

available to Crystal Reports to be used in Custom MIS.  Transaction Types flagged as “Refinance” (via 

the Utilities configuration of Transaction Types) will clear and disable the Cash Sale field.  The Cash Sale 

flag, when set, will make unavailable, on the Lender(s) screen(s), the Type of Financing types of “New” 

and “Refinance”.  Should one of those two Types of Financing already be selected, the Cash Sale flag will 

not be available, until the Type of Financing is changed.   

Underwriter – this field is filled via the dropdown listing of available underwriters.  If only one is available, 

it will default.  Once the file has been submitted to Title, the underwriter selection cannot be changed 

through the Escrow module – only through Title.  Underwriters can be set as inactive, so, should that 

happen, an underwriter could disappear from the listing the users are used to. 

Premium Rate – the dropdown for this field presents the product sets that have been defined by the 

business as those available to their customers.  The listing will present the various combinations of 

owner’s and lender’s policies and the user should select the description that best fits the transaction.  The 

listings may differ by underwriter.  Should additional information need to be provided to Title, it can be 

added in the Comments field on the Title Information screen.   

Sales Price – the purchase price of the property is entered in this field, if a purchase transaction.  The 

field can be left blank if a refinance transaction.  The loan amount, on a refinance transaction, is not 

entered here, but on the Lender screen. 

Initial Deposit – this field is used to record the earnest money on a purchase transaction.  The first time 

an amount is entered in this field, an Initial Deposit (receipt entry) screen will present, letting the user 

create the earnest money receipt at that time.  The Earnest Money receipt type will default.  The user 

should enter the Payor Name and confirm the other 

information on the screen is correct.  If the user is in fact not 

in receipt of the funds, and does not wish for a receipt to be 

created, then the Cancel button should be clicked.  The user 

should only click OK, and continue with the receipt creation, if 

the funds are in hand. 

If the Initial Deposit receipt is completed as discussed above, 

the (…) ellipse icon next to the Initial Deposit Amount field 

is used to add additional deposits and provides for the 

creation of additional receipts.  This is described in more 

detail in the HUD 200 screen section later in this manual. 

In the Worksheet style of data entry, additional deposits will 

prompt the user to create receipts, if the system is so configured. 

Funds Held by Broker – this field is used to identify the amount, if any, of Buyer funds being held by one 

of the agents (Listing, Selling or Other), that will not be placed into escrow and will be deducted from their 

earned commission. 

Funds Held By – the dropdown list will let the user select which agent (Listing, Selling or Other) is 

holding the funds identified in the field above.  The system will utilize this information to manage the funds 

being disbursed to the appropriate party. 
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Estimated Fee Information – Title and Escrow – these fields are purely informational and are used to 

record anticipated fees on the transaction.  Managerial reports can present this information.  These fields 

are not used on the HUD or Settlement Statement. 

Project Name – this field is used to link escrow files to a project or condo master file.  The field is used to 

group files with a project for reporting purposes, enabling reporting on an entire project for a developer.  

The project name can be up to six (6) characters.  When the project name is entered, the system will 

check to see if there has been a project identified by that 

name previously established in the database.  If not, a 

screen will be presented, like that shown here, on which the 

user should identify the full Project Title, the number of the 

Master Escrow (must be a pre-existing file, in the user’s 

branch; can be the active file) and the Bank involved (will 

default to the bank of the Master Escrow).  

 

That completes the description of the Dates/Transaction Information screen of Initial Questions. 
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Properties Screen (Residential) 

The Properties screen is used to enter information on the property involved with the transaction.  Most of 

the fields on this screen are available for use in documents and in reports. 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are three or four tabs on the Properties screen, depending on Residential file type:  Property, 

Mobile Homes, Personal Property and Notes.  Should there be data on the respective tabs, there will 

be a  red diamond icon next to the tab name.  The Notes tab presents a memo field into which 

comments may be entered by the user for future reference. 

Property Tab 

The Property tab is used to detail all the pertinent information about the property, starting with the 

address information.  There are two lines for the street or box address information (Address #1 & 

Address #2) and then City, State and Zip Code fields.  The City field has a dropdown list that can be 

populated by the business with those cities that they routinely do business with; selections from that list 

may populate the County and State fields at the same time.  The user may also enter the city manually.  

The State field dropdown has all of the states abbreviations listed.   

If the Foreign Address check box is checked, the City, State and Zip Code fields are replaced with a 

single Location field that can be used to identify the city, country and postal code (if any) for the foreign 

address.  This routine is recommended for military addresses as well. 

There will be a Search button to the right of the Address #1 line if the system is configured for an 

integration with an external property search function, such as that from CoreLogic.  This type of search 

function is used to qualify the address information and let the user select search results to populate much 

of the property information screens.  This is not the same as the search function utilized within Impact to 

locate files. 

The County field can be populated manually or via the business-maintained dropdown listing of counties. 

The Property Type field is populated via the business-maintained dropdown listing of property types (i.e. 

1-4 Family Residence).  The property types are used to categorize the transactions for management 

reporting, but have no other functionality in the system. 
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The Municipality Type and Municipality Name fields are provided, but are not used in most states. 

The Subdivision Name field can be filled from stored subdivision information via the use of the button 

with the ellipse (…) on it, next to the field.  The stored subdivision information can fill the Tract, Book and 

Page fields as well.  If the user does not find the subdivision name they need in the listing available, they 

can enter the name manually.  The stored subdivision listing is maintained by the business via the 

Utilities module.  

The T/S Weeks field is used to store the number of weeks of a timeshare unit, should the transaction 

involve a timeshare transfer. 

The Appraisal Type, Appraised Value and Appraisal Description fields are used to enter information 

on an appraisal.  If the Appraisal Type of “Other” is selected from the dropdown of types, the Appraisal 

Description field will open for data entry (otherwise it is not accessible). 

The Unit, Low Lot, High Lot, Block and Q1Q2Q3Q4 sections of the screen are used to detail 

information related to the plat map of the property.  The user would only use the Unit or the Q1Q2Q3Q4 

sections, not both, depending on how the property is described in the land records. 

The Brief Legal field will auto-populate from data entered in the Subdivision Name, Tract, Map Book 

and Map Page or Section, Township and Range fields (whichever set are used), the first time the brief 

legal field is tabbed or clicked into.  The user can modify the brief legal that is presented.  The brief legal 

field is limited to 250 characters.  Note: if changes are made to the individual component fields, the brief 

legal will not be automatically reconstituted unless it is deleted and the field is tabbed into again when 

empty. 

Clicking on the  Full Legal icon will launch MS Word® and let the user enter the full legal description.  

The full legal is stored as an MS Word® document by Impact/SQL and, as such, it can be incorporated 

into other documents prepared within Impact/SQL.  Often, Escrow does not enter the full legal, but leaves 

that task to Title.  Once an order has been submitted to Title, the full legal cannot be edited by Escrow 

unless an override setup option is enabled. 

The Tax Parcel ID Numbers / Tax Map Key fields (four) are available for that data and are available to 

the Search function in Impact.  Hyphens must be included when entering the tax parcel numbers, as 

there is not a standard convention. 

The HPR Numbers (horizontal property regime) fields are used with property descriptions of timeshare or 

condominium units.  If needed, these fields could also be used for additional tax parcel ID numbers or tax 

map keys.  Depending on the system configuration, these fields may be labeled Property Levy Codes. 
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Mobile Homes tab 

The Mobile Homes tab, on the Properties screen, is used to detail any number of mobile homes that 

may be involved with the transaction.  The data entered on this tab is available for use in escrow 

documents.  When first presented, the screen looks like the sample below. 

Clicking on the  New Mobile Home icon will create 

an entry, in the column on the left side, of “Mobile 

Home 1” and will open up the data fields for entry of 

information.  The NAF will be enabled for the HCD 

Address information. 

Once one or more mobile homes’ information has 

been entered, if the user determines one should be 

deleted, it should be highlighted in the column on the 

left and the  Delete Selected icon should be clicked 

on.  The user will be prompted to confirm the intent to 

delete the item selected. 

 

Personal Property 

The Personal Property tab will appear on “with GFE” and CDF Residential file types.  The data entered 

on this tab can be presented on the Closing Disclosure Form, and on the “with GFE” HUD . 

There are three fields on the screen: 

Amount – enter the value of any personal 

property being transferred in the 

transaction. 

Show on Statements – this checkbox will 

allow the data entered to appear on the 

CDF or with GFE HUD. 

Description – enter the description of any 

personal property being transferred in the 

transaction. 
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Parties (Residential) 

Residential files can have an unlimited number of Buyers, Sellers, Attorneys, Accommodators and Other 

Parties.  They can have three (3) Lenders and three (3) Real Estate Agents (Listing, Selling and Other – 

one each).  The Lender and Agent restrictions do not apply to CDF files.  Entry and editing of parties is 

done via the Parties menu item on the Initial Questions sub-menu.  If the user is on the Property 

Information screen, clicking on the  Next icon, at the top of the screen, will take the user to the Parties 

screen.  When first opened, prior to any parties being entered, the screen is as shown here. 

The Buyer tree-view is opened, and the Buyer category header is highlighted in the lower left corner.  

The category headers have counts after each to indicate the number of parties of each type that are 

already in the file.  Clicking on the category you wish to add a party to will bring that category’s tree-view 

up on the top left of the window. 

The only active icon at this point is the  

Add Party icon at the top of the screen.  

Clicking on it will open a New Buyer (or 

Seller or other category heading) screen, 

like the New Buyer screen shown below.  

 

 

 

 

 

The Entity Type field has the focus when 

the screen is first loaded.  However, if the 

user sees that the wrong Party Type has 

been selected for the new entry, it can be 

changed at the top of the screen.  Once a 

party has been created, its party type 

cannot be changed.  However, a party 

entered with the wrong type can be copied 

to a new party, with the correct type, with 

the Copy From function (at the bottom of 

the screen).  Then, the original, erroneous, 

entry can be deleted.  

The Cancel and OK buttons apply to all of 

the tabs of data together, not just the tab 

being viewed. 

Information on the various parties’ screens 

follows. 
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Buyers and Sellers 

The Buyer and Seller party types have identical screens.  The other party types have unique screens, as 

will be detailed later in this document. 

NOTE:  Buyer and Seller names can be 8,000 characters long, while other parties can have names of up 

to 250 characters. 

The New Buyer screen, shown on the previous page, is quite full.  There are five tabs across the top 

(Information, Vesting, Signature, Contacts and Notes) and three tabs across the middle of the 

Information tab (Current Information, Forwarding Information and Distribution).   

The fields on each screen are generally self-explanatory, but some warrant special mention. 

Information Tab 

The Entity Type field, at the top of the Information tab, has two selections: Individual and Company.   

If Individual is selected, the Prefix, and First, Middle and Last Name and Suffix fields are presented.  

The name will be properly managed for presentation on documents and on the 1099’s. 

If Company is selected as the Entity Type, the Prefix, and First, Middle and Last Name and Suffix fields 

are replaced with a Full Name field.  In addition, an Attention To field will be added so the primary 

contact at the company can be identified. 

The Tax ID Type field has three options:  TIN, EIN and SSN.  Select the appropriate type and enter the 9 

digit value in the Tax ID field – without hyphens – and the value will be presented with the appropriate 

hyphenation. 

The Reference Number field can be used to enter any party-provided value. 

The user should check the Source of Business and/or the Bill To Customer check boxes if the party is 

either of those.  Only one party can be the Source of Business and only one can be the Bill To Customer.  

If the user tries to assign each of those roles to more than one party, they will be warned about that fact. 

The Ownership Percent field, seen on Commercial Buyers and Sellers is not seen on Residential files. 

Current Information and Forwarding Information Tabs 

The Current Information and Forwarding Information tabs, at the bottom half of the Information tab, 

are for addresses and contact numbers.  The Link To field, on the Current Information tab, has a 

dropdown selection of either None (the user will enter the address) or one of the properties that has been 

entered can be selected to be used as the current address.  Addresses of the other buyers (if entering a 

buyer) or sellers (if entering a seller) can be linked to as well.  The same field, on the Forwarding 

Information tab, will offer the same choices and the address entered on the Current Info tab. 

The Primary Notification dropdown choices are: Work Number, Home Number, Cell Number, Email, Fax 

Number, Mail or None. 

Distribution Tab 

The Distribution tab is used to identify the number of copies of the Prelim, CC&R’s and Document Sets 

should be provided to this party, and the method of delivery.  Depending on system settings, there can be 

references to the Legal, Vesting and Plotted Easements as well. 
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Vesting Tab 

The Vesting tab is used to detail how this party will hold title, and will only appear for Party Types of 

Buyer and Seller. 

 

 

 

 

 

 

 

 

The Hold Title Code dropdown list, at the top of the Vesting screen, presents the database defaults for 

vesting.  One of those can be selected as the entry, and when that is done, it will appear in the body of 

the screen.  If the user wishes to simply type in the vesting information, in the body of the screen, they 

may do so if no selection is made in the Hold Title Code field.  If a Hold Title Code entry is desired as the 

starting point for a manually edited entry, select the appropriate code, by clicking on it, then reselect the 

blank entry at the top of the list…this will result in the initially selected entry being put in the body, but 

then let it be edited.  This field can contain 8,000 characters. 

Signature Tab 

The Signature tab is used to create “custom signatures”.  Custom signatures allow the user the flexibility 

to handle information above and below the signature line in documents.  This signature function is useful 

when dealing with corporations, attorneys and trusts, which might require an explanation of the status of 

the signer.  The text boxes can contain 8,000 characters. 

The  Insert Name icon, in each section, is used 

to insert the party’s name at the cursor’s location in 

the box. 

The  Clear icon, in each section will remove the 

entire contents of the box, without a confirmation 

prompt. 
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Contacts Tab 

The Contacts tab is used to enter name and contact information for people that are contacts for the party 

being edited.  For example, a buyer may want his/her secretary to be their primary contact on matters 

relating to the transaction.  This screen is used to load one or more contacts for the party being entered.  

When first presented for a party with no contacts loaded, the screen will reflect “No records found.” in the 

body of the screen.  If contacts have been entered, they will be listed on the screen.   

There will be  Modify and  Delete icons next to each record. 

The   New Contact icon, in the upper left corner of the first screen presented will bring up the screen 

below. 

The Roles available for assignment to Contacts are Assistant, Loan Officer, Loan Processor and 

Secretary.  This list can be expanded, from the Utilities module, by a System Administrator. 

The NAF is available when the cursor is in the Name field. 

An Attention to: field is provided so that an assistant to the contact, for example, can be identified. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Add Another button, at the bottom of the screen, is used to do just that: add another contact. 

The Cancel button is used to exit the New Contact screen without saving changes.  

The OK button is used to save data that has been entered and to then exit the New Contact screen, 

returning the user to the listing of contacts screen. 

Notes Tab 

The Notes tab, on the New/Edit Party screen is available to add any comments on the party that the 

user wishes.  Notes associated with Parties are available for inclusion on the Title Instructions, under 

the Prelim Distribution section.  The Crystal Reports involved will require editing to include the Notes. 
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Notary Block Icon – Buyers and Sellers Only 

At the top of the Parties screen, when either the Buyer or Seller category is 

selected (by clicking on it), there is a  Notary Block icon that will present 

that is used to edit the Notary Block for either Buyers or Sellers (one is 

permitted for each category, not for each party in the category).  

When the  Notary Block icon is clicked on, a blank screen will be 

presented, like that shown below.  The user may enter whatever text they 

wish to appear in the buyer or seller signature area detailing the notary 

verbiage. 

 

 

 

 

 

Copy Party Icon – Any Party 

Next to the  Notary Block icon, and active whenever a specific party is highlighted, is the Copy 

Party icon.  Clicking on the icon will open a new party screen, filled with the highlighted party’s 

information, with the Party Type field available for edit at the top of the New Party screen.  So, for 

example, a Buyer can be selected and be copied using the  Copy Party icon and the copied party 

could then be made a Seller party, by changing the Party Type field to Seller. 

An alternative approach is to right-click on a party and select Copy from the menu presented. 

Reposition Party 

The  Reposition Party icon, above the tree-view when there is 

more than one party entered in the category, will present a window 

in which the user can reorder the parties – this will impact the 

number of the party, which can impact documents that have already 

been prepared based on the previous ordering.  The  Move Up 

and   Move Down icons are used to push the selected party in the 

desired direction. 
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Lenders – (Residential) 

The Lender party type has a different set of data entry/edit screens.  The content of the Information tab 

is different from that of the Buyer & Seller party type screens, and will be explained below.  Two of the 

other top-of-the-screen tabs – Contacts and Notes – as well as the Distribution sub-tab on the 

Information screen - are common in layout and content as those on the Buyer & Seller screens, so will 

not be discussed again here.  There are Loan Terms and Tolerance Adjustment tabs, which do not 

exist on the Commercial files’ Lenders screens.  Note: the Loan Terms and Tolerance Adjustment tabs 

will appear on “with GFE” files.  A modified 

Loan Terms screen will appear on CDF files. 

There are placeholders for each of the three 

(3) permitted lenders in non-CDF 

Residential files already established on the 

Parties screen.  Traditionally, Lender #3 is 

used for the Mortgage Broker.  After 

highlighting the Lenders category, the user 

should use the  Modify icon, on the right 

side of the lender placeholder they wish to 

add data to, to bring up the Edit Lender 

screen below. They may pick the lender to 

add by selecting it from the Party Type 

listing.  CDF files have no lender 

placeholders nor is there a limit to the number of lenders for a file. 

Information Tab - Lender 

The Information tab, on the New/Edit Lender screen, is presented here (the “with GFE” version).   

 

 

 

 

 

 

 

 

 

 

 

 

 

The Copy From button, at the bottom of the screen, can be used to copy lender information from one 

lender to another.  When clicked, a screen of all existing lenders will be presented, and the user can 

select the lender to copy.  
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The Full Name field can contain 250 characters, and the NAF can be used to load that data, along with 

the related Contact Information fields on the Contact sub-tab. 

The name of the primary lender contact is entered in the Attention To field. 

The Lender’s Reference Number field is the third field on the screen.  There is a Loan Number field 

below, so this field would likely be used for some other lender-provided value. 

If the Lender entry is the Source of Business, that box should be checked. 

If the Lender entry is the Bill To Customer, that box should be checked. 

On the Lender #3 screen ONLY (for non-CDF files), there is a Mortgage Broker checkbox.  If the party 

being entered on the Lender #3 screens is representing a lender but not making a loan, then the 

Mortgage Broker box should be checked and no loan information would be entered.  If this box is 

checked, the Loan Amount and Type of Financing fields will be disabled. 

NOTE: for CDF files, a Mortgage Broker checkbox will appear on each lender data entry screen until one 

lender is selected as a Mortgage Broker. 

The Loan Number and Loan Amount fields are next, followed by a field for the Mortgage Insurance 

Number.   

Once the file has been worked up, depending on the charges that have 

been entered, and if they are set to have been calculated by the system 

based off of the Loan Amount, if the Loan Amount is changed, a screen 

like the one shown here will pop up, after the Lender screen is asked to 

be saved and closed, that will identify areas that would be affected by the 

change made and ask if the user wishes to have the figures recalculated.  

The items that might appear are Loan Origination Fee, Loan Discount 

Fee, City/County & State Tax Stamps, City/County & State Transfer 

Tax and Escrow/Title Fees. 

The Type of Financing field has ten (10) options available on its dropdown list, and these dictate the 

loan type text on the settlement statement, and manage whether interest prorations can be detailed from 

this screen. 

New Loan – used for most transactions; no interest proration from this screen.  The loan will be applied to 

the buyer/borrower with prepaid interest calculated in the new loan section. Unavailable if Cash Sale flag 

is checked. 

Assumption – if a loan is being assumed, interest proration can be done here; will offset the buyer and 

seller with interest prorations. 

Note & DT – interest proration can be done here; will offset the buyer and seller with interest prorations. 

Seller Carryback – Lender Full Name field will populate with “:S1” payee shortcut (Seller One); interest 

proration can be done here; will offset the buyer and seller with interest prorations. 

Realty Mortgage – interest proration can be done here; will offset the buyer and seller with interest 

prorations. 

Purchase Money – interest proration can be done here; will offset the buyer and seller with interest 

prorations. 

Refinance – no interest proration from this screen. Unavailable if Cash Sale flag is checked. 

Second Mortgage – interest proration can be done here; will offset the buyer and seller with interest 

prorations. 
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Agreement for Sale – interest proration can be done here; will offset the buyer and seller with interest 

prorations. 

Reverse Mortgage – treatment of the loan follows specific RESPA rules (“with GFE” only). 

The Type of Loan field has five (5) options, which mark the appropriate HUD box for loan type:  FHA, 

RHS, Conv. Unins., VA and Conv. Ins. 

Lender Interest Proration 

The Interest Prorate function will be enabled if available for the Type of Financing selected.  The user 

should click on the checkbox in front of the Prorate label, in the Interest box on the right side of the Edit 

Lender screen, to open the Lender Proration screen, 

shown here. 

The Proration Types available are Interest and Per Diem. 

The user should select the appropriate base for the proration 

(360 or 365 days), if the default is incorrect. 

The Interest Rate should be entered, along with the 

Starting Date and Ending Date (this is a “to” date, not a 

“through” date). 

The appropriate Give Credit to party should be selected. 

The Calculate button can then be clicked on to compute the Prorated Amount. 

Should there be an existing proration that should be removed, the user should click on the Remove 

button. 
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Yield Spread Premium (non-GFE) 

The Yield Spread Premium check box will be enabled on non-GFE and non-CDF files.  The Yield 

Spread Premium (YSP) is reflected as a notation under the loan section of the HUD or Settlement 

Statement, again, on non-GFE and non-CDF files.  When the checkbox in front of the Yes label is 

checked, in the Yield Spread Premium box, on the 

Edit Lender screen, the Yield Spread Premium 

Broker Information screen shown here is 

presented to the user. 

The Lender Payee shortcut (:L3) can be used for 

the Broker Name, if the broker information has 

been entered for Lender #3. 

The Description can be selected from the drop 

down list, or the user can type in their own 

description.  Yield Spread Premium and Broker 

Compensation are the available choices in the dropdown listing. 

There are three options for the Code field: 

 The WTH option will subtract the Amount entered from the Due From Lender funding amount 

that appears on the Lender Summary screen. 

 Over Funded (Issue Check) - If the lender funds the YSP then a check will be issued payable to 

the Broker Name, and will appear as a negative amount on the Lender Summary screen. 

 Not Over Funded - this option should be selected if the lender does not include the YSP in the 

funding check, and the amount will not appear on the Lender Summary screen.. 

 

Contact Information Sub Tab - Lender 

The Contact Information sub tab, at the bottom of the Information tab on the Lender party screen, is 

used to store information on the primary contact at the lender.   

The Primary Notification field dropdown lets the user identify how the contact prefers to be 

communicated with.  Options are:  Work Number, Home Number, Cell Number, Email, Fax Number, Mail 

and None. 

 

License Information  Sub Tab – Lender – CDF Files 
The License Information sub tab, at the bottom of the Information tab on the Lender party screen, is 

used to store information on the Company’s licensing and Attention To’s licensing. 
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Loan Terms - GFE  

The Loan Terms screen, on “with GFE” files, is presented 

here.  The information for this screen should come from a 

combination of the lender’s GFE and Lender’s Instructions to 

Escrow.  The screen starts out looking like the sample to the 

right, with many items “grayed out”.  If the response(s) to the 

questions, on the left side of the screen, are “Yes”, the Yes 

box is to be checked and the grayed out fields will open up, 

indicating data can be entered.  In the sample below, all of 

the responses are Yes, and you can read the screen’s field 

names more easily.  The user should not check the Yes box 

unless the category is applicable. 

 

 

 

 

 

 

 

Note: the Balloon 

Payment Due in ___ 

Years field can accept 

up to 12 decimal 

places. 

 

 

 

 

Loan Terms - CDF  

The Loan Terms screen, for “CDF” files, is shown 

here.  The term value and period type should be 

entered in the Loan Term fields.  The starting 

Interest Rate should be entered in the field of that 

name (as ##.###%).  The Purpose of the loan is 

selected from the dropdown box, as it the Product (if 

Other is selected – the description field will open for 

data entry.  The initial Principal & Interest payment is 

entered in the P&I Amount field.  If the optional CDF 

for transactions not involving a seller is to be used, the checkbox at the bottom of the form is checked.  
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Reverse Mortgage - GFE 

Special functionality has been added to Impact/SQL for Reverse Mortgages to accommodate HUD and 

Loan Terms reporting requirements for with GFE files.  To trigger the functionality, the Type of 

Financing selected, via the dropdown box, must be Reverse Mortgage. 

With Reverse Mortgage selected as the Type of Financing, on the 

Loan Terms tab and the entry of any Initial Draw, in the 200 

section of the HUD, the appropriate presentation of the loan 

amount, in the description area of line 202 (rather than in the 

column), is made, along with the proper presentation of Loan 

Terms on that page. 

The Loan Terms tab, in a reverse mortgage situation, needs specific treatment, on specific lines, as 

indicated below, in addition to the entry of the initial draw amount, if any, on the 200 section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Loan Term: check the Text box, and enter lender-provided text (ex: N/A” or “Unknown” or “Not 

Applicable”) in the field labeled Years. 

Monthly amount owed…: check the Text box, and enter lender-provided text, as above. 

Can loan balance rise?: check the Yes box, and check the Text box, and enter lender-provided text. 

Total monthly amount…: check the Includes escrow payment of box, and check the Paid by or through 

draws from Principal limit box. 

Enter the description “Initial Draw” and the amount on line 204 or 205 of the HUD, if there is one. 
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Tolerance Adjustments - GFE 

The categorization of charges is very important in the 2010 RESPA process.  Certain charges technically 

should not deviate from the GFE figures (Category 1), others can deviate by no more than 10% (Category 

2) and others can deviate (Category 3).  The third tab on the Lender/Loan Information screen is 

Tolerance Adjustments.   On this tab (displayed below) the user would enter values, authorized by the 

lender, that acknowledge that there were deviations from the tolerance limits for Category 1 (zero 

tolerance) and Category 2 (10% tolerance limit) charges.   

Quoting from the Federal Register’s Instructions on page 2 of the Good Faith Estimate (HUD-GFE), the 

charge categories are (Categories 1, 2 & 3, from left to right): 

These charges  

cannot increase  

at settlement: 

The total of these charges  

can increase by up to 10% 

at settlement: 

These charges 

can change 

at settlement: 

Our origination charge 

 

Your credit or charge (points) for 
the specific interest rate chosen 
(after you lock in your interest 
rate) 

 

Your adjusted origination 
charges (after you lock in your 
interest rate) 

 

Transfer taxes 

Required services that we select 

 

Title services and lender’s title 
insurance (if we select them or 
you use companies we identify) 

 

Owner’s title insurance (if you 
use companies we identify) 

 

Required services that you can 
shop for (if you use companies 
we identify) 

 

Government recording charges 

Required services that you can 
shop for (if you do not use 
companies we identify) 

 

Title services and lender’s title 
insurance (if you do not use 
companies we identify) 

 

Owner’s title insurance (if you do 
not use companies we identify) 

 

Initial deposit for your escrow 
account 

 

Daily interest charges 

 

Homeowner’s insurance 

So, should there be charges that violate the tolerance limits, the lender and escrow officer must work 

together to have those charges authorized, and the net overage would be detailed on this tab, as a 

negative number.  In the sample shown below, there was an overage of $100 in Category 1 charges and 

an overage of $200 in category 2 charges.  These adjustments will display in the Comparison of Good 

Faith Estimate (GFEC) and HUD-1 Charges section of the HUD (top of page 3). 

In addition, there is a Show Credit(s) to Buyer 

on HUD in Section 200 checkbox, and two 

Description and Amount fields (which are 

enabled if the checkbox is checked), that can be 

used to detail lender credits on the first page of 

the HUD. 
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Proposed Insured 

The Proposed Insured tab is used to store the verbiage a lender wants to be used to identify them as 

the proposed insured.  There is a Proposed Insured Clause field in the NAF, for Lender Entity Type 

entries, that is to be used to store this information by lender.  When the lender is pulled from the NAF for 

a particular file, the Proposed Insured Clause on the NAF entry will populate this field.  The contents of 

this field are available as a DDE field for escrow documents. 
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Accommodators 

The Accommodator party type’s data screens are similar in some respects to the Buyer/Seller screens – 

in that there are Information, Signature, Contacts and Notes tabs – yet the bottom of the Information 

screen is patterned after the Lender party type screen, with the Contact Information and Distribution 

tabs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Only the top half of the Information tab is truly different from either the Buyer/Seller or the Lender 

Information screens.   

There is still a Reference Number, which can be used to store whatever the party provides as their “id” 

for the transaction. 

There is a Full Name field, likely to be used for a company name.  The NAF will be activated if the cursor 

is in the Full Name field. 

The Attention To field would be used to identify the primary contact’s name at the company. 

The Representing field will present, in the dropdown, all existing Buyers and Sellers (only), and the user 

should pick the party that the Accommodator being entered represents. 

If the Accommodator being entered is the Source of Business or a Bill To Customer, the respective 

check boxes should be checked. 

The balance of the Accommodator party screens are common to those discussed previously. 
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Attorneys 

The Attorney party screens are identical to the Accommodator screens except there is not a Signature 

tab for an attorney entry. 

Agents - Residential 

The Agent party type screen is really made up of three sub-party types:  Listing (Sellers) Agents, 

Selling (Buyers) Agents and Other Agents.  Residential files (except for CDF files) are limited to one 

agent of each type, and there are placeholders for each created when the file is established. 

The Agents party screens are identical to the Attorneys screens except there is not a Representing field 

for the agents. 

Other Parties 

The Other party type screens are identical to the Attorney screens. 

There is a Party Type of Escrow Company, to be used to designate outside escrow companies as 

parties to the file, distinct from the generic Other Party designation.  DDE fields and SmartTags are 

available for use in document templates for the Escrow Company party type. 

It is possible to add additional Party Types (such as HOA, Pest Inspection, etc.) to the system.  The 

added Party Types will aggregate in the Other Party section of the Parties listings.  A System 

Administrator can add Party Types via the Utilities Module.  SmartTags can be used to access the 

additional party data in documents. 
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Source of Business/Bill To 

The Source of Business/Bill To screen, for both Residential and Commercial files, is a combined screen 

(shown below), assuming the Bill To Customer functionality is configured for in the database, that 

reflects the parties assigned to those roles.  Typically, the assignation of the roles is done as the parties 

are entered via the New/Edit Party screen.  NOTE: if either of the types is set to be mandatory, the user 

will not be able to leave this screen until there is a party assigned. 

Only one party can be the Source of Business and only one can be the Bill To Customer – but they 

need not be the same for both.  If the user tries to assign either of the roles to more than one party, they 

will be warned about that fact, with a message like that shown below.   

 

 

 

If the user gets the warning that another party already has the role being requested (by checking the 

Source of Business or Bill To Customer checkboxes on the New/Edit Party screen for a particular 

party) and they indicate “Yes” to continue, the current party will be given the role and the previously 

flagged party will have that flag removed from their record. 

The Source of Business/Bill To screen presents the parties selected for the roles, if any, as shown 

here. 

 

 

 

 

 

 

The user can use the icons, at the right of each heading, to create a  New Party (and give that new 

party the role desired), to  Modify the party selected (from a list of existing Parties) or  Remove the 

designation from the Party (does not remove the Party). 

If the  Modify icon is clicked, the Party Selection screen 

shown here is presented.  The Filter field, at the top of the 

screen, can be used to search for parties by entering a part 

of their name or a party type – should the party listing be 

very long and not all are visible at one time.   
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Title Information 

The Title Information screen is used for entering any and all additional information that may be needed 

to facilitate the title search.  It is also used to identify an Outside Title Company for Escrow Only orders. 

 

 

 

 

 

 

 

 

 

 

 

The top portion of the screen is used to provide information to the Title Department.  This information will 

be presented on the Title Instructions (Title Order) form. 

The Status field is used to indicate the status of the structure, or if one exists, on the property.  The 

choices are:  Exists, Proposed (vacant land), or Under Construction.  If Proposed is selected, this 

should alert the Title Department that an ALTA inspection is needed. 

The Base Order No field is used to identify if there is a starter file that should be used on the transaction.  

The number of the starter file should be entered in this field.  The Base Order No field is available to be 

used in the Search function. 

The Subject To field is used to enter “Schedule B” items, if Escrow knows of some that should be noted. 

If the file is for an “escrow only” transaction, the Reference Numbers 1 & 2 fields can be used for the 

outside title company’s title file number and any other numbering that needs to be referenced.  If the 

transaction is being worked by the internal Title Department these fields can be used for other reference 

numbers, such as a builder or developer number.  The Reference Number 1 and Reference Number 2 

fields are also used in the Search function. 

The Need By Date field should be used to enter the date that the Prelim/Commitment is needed.  Click 

on the  Calendar tool icon, just to the right of the date entry area, or use the CTRL+D Quick Keys to 

pull up the Calendar tool, or enter the date manually in mmddyy form (no slashes). 

The Requirements fields are used to note any requirements that are needed, such as Releases, or 

Deeds of Trust. 

The Comments to Title field is used to add anything that was unclear in any of the previous fields or 

screens.  If the user is sending an amended title order, enter “Amended” and notes about what was 

added, deleted, or changed.  When a second title order is sent to the Title Department, it will print 

“Amended” across the top of the form. 

The bottom portion of the screen, labeled Title Company Information, is used to detail information on 

the Outside Title Company if the file is an Escrow Only transaction.  The user should enter the 

information for the outside title company that is doing the title search.  The Title Company Information 
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may be filled out manually, or if the outside title company is in the NAF then use the  NAF icon, in the 

upper left corner of the screen, to speed-fill this information.  The data that is entered into the Title 

Company Information fields can be made available in other areas within Impact.  For example, the 

information that is entered here is utilized every time that the :TC Payee Shortcut is used.  See the 

Impact Payee Shortcuts section for more details about this and other shortcuts. 

The Title Officer field’s dropdown list presents External Title Officer names that have been entered in the 

Utilities module>User Tables>External Title Officers.  The user may select a name from the dropdown 

list or may enter a name manually. 
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Title Charges (1100) – Non-GFE/non-CDF Residential 

(conditional) 

Please note that the Rate Calculator in Impact/SQL does not currently handle some common pricing 

practices and is under review for revision (as of January 2015).  Therefore, a full description of the Rate 

Calculator will not be included in this section of the Title manual. 

The Title Charges screen can be made available to Title users, if the Enhanced Sub Escrow functionality 

is not turned on.  If enabled, the Title Charges menu entry, on the Opening Information menu, will 

appear. The screens will vary for non-GFE Residential files, GFE Residential files, CDF Residential 

files, and Commercial files – each are discussed below.   

On the Title Charges screen, depending on system configuration, you will either see the Title Charges 

Detail check box, to the left of the Computer to Calculate Fees? option box – or you will only see the 

Computer to Calculate Fees? option box, at the top of the screen, under the Title Charges (1) tab 

heading.  It is very rare that the Title Charges Detail option is enabled on a system (it was a client-specific 

request), so the absence of the option should be expected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the rare instance that the option exists, clicking on the 

Title Charges Detail check box will open the 

Title/Escrow Fee Breakdown screen shown here.  

Click on the Detail button, on the Title Charges screen 

to re-enter a previously worked up Title Charge Detail 

screen.  As this screen is rarely presented, it will not be 

discussed further. 

The Computer to Calculate Fees? option, on both of 

these screens will also not be discussed further due to 

the current state of the Rate Calculator in Impact (see 

notice at the top of this page).  The Computer to 

Calculate Fees? option should always have “No” 

selected, and the user will enter charges manually.  If 

Computer to Calculate Fees? is chosen, the fields will not accept manual entries.  The radio button will 

need to be reset to “No” to open the fields for editing.  
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To make changes to the Paid From Borrowers Funds at Settlement field and/or the Paid From Sellers 

Funds at Settlement field, or to modify any pre-filled payee data on a line, place the cursor in the field to 

make the necessary changes. 

In the payee field, a Payee Shortcut may be currently displayed, or can be entered, for example, use :T to 

have the Title Company Name as the payee.  :T, as payee, denotes a revenue check which may, 

depending on system configuration, require income codes on each detail line, which are entered on the 

Disbursements screen on non-GFE files. 

Depending on your company’s system configuration, a :E may be entered as a payee with the amount 

being applied as revenue.  The use of :E vs. :T is to distinguish between charges entered by Escrow 

versus Title users, in a traditional sub-escrow environment.  The :E and :T will display subtotals at the 

bottom of the Title Charges screen if enabled.  Both represent fees to the Company.  The newer sub-

escrow functionality, in Impact version 7.7 and later (see Appendix B), does not need such a device as 

Title/Sub-Escrow users do not enter charges directly into the HUD if the newer functionality is enabled. 

Users have the ability to use :T (space) [name].  This will permit a payee name on the HUD other than 

the Company name, but still be included as a revenue check item – only on non-GFE files. 

A “:TC” may be entered as a payee.  :TC is the payee shortcut for the Outside Title Company, on an 

Escrow Only file.  The :TC payee shortcut will pull the name from Opening Information > Title 

Information > Title Company Information.  The :TC-coded items will not be counted as revenue to your 

company. 

The  Address icon can be used to enter the name and address of the payee, for those lines that have 

the icon.  Alternatively, the to payee field can be filled in manually, or with the  NAF tool, which will be 

activated when the cursor is placed in a payee field. 

As needed, select one of the check boxes: 

WTH – Withheld from the Lenders funding check.  The payee must be :L1, :L2, or :L3. 

 POC – Paid Outside of Closing by the buyer and/or seller 

 POCL – Paid Outside of Closing by the lender 

 POCB – Paid Outside of Closing by the mortgage broker 

The Lenders coverage field may be pre-filled with the Loan Amount from data entered on the Edit 

Lender screen of Party entry in Initial Questions. 

The Owners coverage field may be pre-filled with the Sales Price from data entered on the first screen 

of Initial Questions. 

NOTE: HUD lines 1109 and 1110 will print the payee name from HUD line 1108. 

 

Access to lines 1114 through 1130, for additional charge entry, is available on the Title Charges (2) tab. 

 

For Washington state requirements see Appendix A - Washington State.  
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Title Charges (1100) – GFE – Residential (conditional) 

The Title Charges form has three Lender icons  with three tabs of Title Charges screens for each (A, 

B & L).  The Title Charges (A) screen is shown below, and will be described here.  The (B) & (L) screens 

are discussed following the explanation of the (A) screen. 

Should there be more than one lender care must be taken to properly record title charges on the 

appropriate lenders’ screens so that the GFE Comparisons generated are accurate. 

The  NAF icon is highlighted when the cursor is in a payee field, as indicated by the highlighted :T on 

line 1102 below.  The  Payee Name and Address icon is also used here to facilitate entry of payee 

data.  The  Modify icon  is used to open data entry/edit screens on lines 1102, 1103 and 1104 for 

Settlement fees and Owner’s and Lender’s title insurance – which will be described below.  The payee 

field should reflect “:T” if the Company is collecting the fees or the appropriate vendor’s name if the fees 

are being paid to a third party. 

The amount field on line 1101, Title Services and lender’s title insurance, under the Paid From 

Borrower’s Funds at Settlement heading, reflects the sum of the items detailed on lines 1102, 1104 and 

all of the items on the Title Charges (B) and Title Charges (L) screens that are tagged with #4 (HUD 

1101) in the From GFE field (explained below).  The GFE Amount field, on line 1101, is used to enter the 

amount from the Lender’s GFE, box #4. 

The amount field on line 1102, Settlement, Escrow or Closing Fees to, under the Paid From Sellers 

Funds at Settlement heading, reflects the amount of non-GFE settlement charges paid by the Seller, if 

any, included in the 1102 breakdown screen (discussed below).  It does not include settlement charges 

from the GFE attributable to the Buyer but paid by the Seller – those will be reflected in a Seller Credit on 

page 1 of the HUD.   The GFE Amount field, on 1102, is only used to segregate Escrow charges if they 

are to be in a separate category from Title Charges and Lenders Title Insurance. 

The amount field on line 1103, Owner’s title insurance to, under the Paid From Borrower’s Funds at 

Settlement heading, reflects the total Owner’s title insurance premiums and other itemized additional 

charges detailed in the breakdown screen (discussed below), and all of the items on the Title Charges 

(B) and Title Charges (L) screens that are tagged with #5 (HUD 1103) in the From GFE field (explained 

below).  The GFE Amount field, on line 1103, is used to enter the amount from the Lender’s GFE, box 

#5. 

The GFE Category fields should be checked to make sure the right categories are selected for each line. 
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The Lender’s title policy limit $ figure, on line 1105, will reflect the loan amount entered on the 

Lender’s Policy and Additional Charges data entry/edit screen, and will be blank until that edit screen 

is utilized.  This figure can be edited via the  Modify icon on line 1104. 

The Owner’s title policy limit $ figure, on line 1106, will reflect the sales amount entered on the 

Owner’s Policy and Additional Charges data entry/edit screen, and will be blank until that edit screen is 

utilized.  This figure can be edited via the  Modify icon on line 1103. 

The Agent’s and Underwriter’s portions of the total title insurance premium, shown on lines 1107 

and 1108, are computed based on the remittance percentage entered on the underwriter menu 

maintenance screen (entered by System Administrators), and cannot be directly edited, if the payee on 

1103 & 1104 is “:T”.   

For outside title transactions, once the payee name is anything other than blank or :T, the Agent’s portion 

of the total title insurance premium and Underwriter’s portion of the total title insurance premium fields 

become accessible to manually enter the values into them.  The outside title company must provide the 

values to be entered by Escrow into 1107 & 1108 in that instance. 

There is a summary of the seller paid loan charges presented at the bottom of the 1100 screens.  The 

figure will match the amount on line 208.  The box containing this summary figure also contains the 

amount of any seller paid owner’s policy premiums (which are a mandated buyer charge) which appears 

on line 207.  Having the figures on each of these screens eliminates the need to go to the 200 screen to 

see them. 

NOTE:  Designations can be placed on the income codes established in each system that will filter the 

codes available to the user depending on where they are entering the charge.  The categorization of 

income codes is done through the Utilities module.  The categories are: None (all Categories), Title Fees 

Premium, Title Fees Non-Premium, Escrow Fees, Recording Fees and Sub Escrow Fees.  Items entered 

in the 1102, 1103 and 1104 breakdowns can have income codes attached to them, and the listings on 

those screens can be filtered in this manner. 
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Line 1102 Settlement or Closing Fees 

The Settlement or Closing Fees data entry/edit screen, reached via the  Modify icon on line 1102, is 

shown below.   

This screen should be used to enter all “:T” (the Company’s) escrow fees.   

Escrow fees the Company is charging, that are not included in the GFE box #4, and which are paid by the 

seller, are entered in this breakout screen as well, with the amount of the charge entered in the Seller 

Amount field. 

Escrow fees to third parties, whether included in the GFE box #4 amount or not, should be entered on 

screens (B) and (L).   

The top portion of the screen presents fields into which information about the basic escrow fee is entered.  

A description of the fee is entered in the Escrow Fee: field (there is a system option that will let the 

business change the default description), and the amount of the total charge in the Escrow Fee Amount: 

field.  If the “:T” payee was identified in the payee field of line 1102, the Income Code dropdown will be 

enabled and the appropriate code should be selected.  The WTH and POC check boxes are provided, as 

are the Buyer Amount, Seller Credit to Buyer and Seller Amount fields.   

Items that are payable to the Company (:T payee) will have the total amount charged for the item entered 

into the Escrow Fee Amount field, and the buyer’s charge (from the GFE) would be entered into the 

Buyer Amount column while any seller paid, non-GFE amount, would be entered into the Seller Amount 

column.  If the seller is paying for some or all of 

the Buyer Amount, the amount the seller is 

paying is to be entered into the Seller Credit to 

Buyer column.  This credit will be accumulated 

with any others into one figure on page 1 of the 

HUD. 

The Escrow Fee Amount must total the sum of 

the Buyer Amount and Seller Amount fields for 

the primary entry (the one on the top half of the 

screen). 

Click on the  New Item icon, in the top left corner of the Additional Charges section of the screen, to 

add additional charge records.  The following screen will be superimposed over the Settlement or 

Closing Fees screen. 

 

 

 

 

Enter the detail for the additional charge and then either click on the Add Another button, lower left, to 

save the information on the added charge, and refresh with a blank screen to add another charge, or click 

on OK to return to the initial screen.  All entered charges will be summed in the boxed fields for Buyer 

Amount and Paid From Sellers Funds at Settlement on line 1102. The Buyer Amounts (only) will roll 

up into the Paid From Borrower Funds at Settlement field on line 1101.   

Non-GFE, paid by Seller, charges will not roll up into 1101.  

The total amount of any entries in the Seller Credit to Buyer fields will not be presented on the 1100 

screen.
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Line 1103 Owner’s Title Insurance 

The Owner’s Policy and Additional Charges data entry/edit screen, reached via the  Modify icon on 

line 1103, is shown below.  It is similar to the Settlement or Closing Fees screen, but there are some 

fundamental differences. 

 

 

 

 

 

 

 

 

 

 

 

The Owner’s Policy Description should be entered into the field of that name, at the top of the form.  If 

the Title Rate Description table is properly configured, the policy description should default from the 

selected Premium Rate entered on the first screen of Initial Questions.  The Owner’s Policy Liability 

should be defaulted, from the Sales Price.  The premium should be entered in the Owner’s Policy 

Premium field.  The appropriate income code should be entered; the dropdown can be used to assist 

with that.  The WTH and POC check boxes are provided.  Also provided are the Buyer Amount field and 

a field labeled Seller Credit to Buyer.  You should enter the full premium in the Buyer Amount 

column and the amount being paid by the seller (if any) in the Seller Credit to Buyer field.  The Lnk 

checkbox links the Seller Credit to Buyer field with the Buyer Amount, so they stay the same and only 

the Buyer Amount need be entered.  If the seller is not paying for the policy, the Lnk checkbox should be 

unchecked.  If the seller is paying all, or part of, the owner’s policy premium, it is not shown as a seller 

charge on page 2 of the HUD, but is shown on page 1 as a debit to the seller and a credit to the buyer – 

on lines 207 and 507.   

The  New Item icon on this screen is used to add information on endorsements or other policy related 

charges.  The Charge Type (Endorsement or Other) should be selected, then the Description of the 

item, Income Code and Amounts are entered.  Like the other screens like this, the Add Another button 

will let you add more items, as needed.  Only Endorsement entry amounts will be included, along with 

the premiums, for the line 1107 & 1108 calculations.  

The Lnk checkbox links the Seller Credit to Buyer field with the Buyer Amount, so they stay the same.  

If the seller is not paying for the additional charge, the Lnk checkbox should be unchecked.  This linking 

function can be disabled in Setup Options. 
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Line 1104 Lender’s Title Insurance 

The Lender’s Policy and Additional Charges data entry/edit screen, reached via the  Modify icon on 

line 1104, is shown below, and is identical in format and function as the Owner’s Policy and Additional 

Charges data entry/edit screen (without the Lnk field), so will not be further explained.  See the 

discussion above regarding line 1103. 

 

 

 

 

 

 

 

 

 

 

 

The GFE figure related to this line is included in the GFE Amount entered on line 1101, which typically 

includes the GFE amount relating to line 1102 as well. 

The charges entered on the 1102, 1103 & 1104 breakdown screens can be printed out via the Fee Check 

Invoice report (Disburse > Fee Check Invoice). 

 

Computer to calculate fees 

Please note that the Rate Calculator in Impact/SQL does not currently handle some common 

pricing practices and is under review for revision (as of January 2015).  Therefore, a full 

description of the Rate Calculator will not be included in this section of the Escrow manual. 

 

NOTE:  If the rate calculator is used, the primary Escrow Fee Amount, Owner’s Policy Premium, and 

Lender’s Policy Premium fields, on the 1102, 1103 and 1104 date entry/edit screens will not be able to 

be edited.  A message to that effect will present on those screens.  Also, the payee fields, on those lines, 

will be defaulted to “:T” and disabled.  Additional charges (endorsements and other) will be able to be 

added on those screens. 
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Form 1100 - Title Charges (B) and (L) 

Additional title charges, to be paid to outside parties, should be detailed on the Title Charges (B) and 

Title Charges (L) screens.  Charges entered on these lines will appear on the HUD (as opposed to the 

summary figures presented for charges entered in the breakdown screens on lines 1102, 1103 and 

1104).  These charges may or may not have been identified on the lender’s GFE, and the From GFE field 

is used to identify whether each charge was on the GFE and, if it were, in which box (#4 or #5) was it 

included.  The From GFE options are None, #4 (HUD 1101) and #5 (HUD 1103). 

The values entered in the Paid From Borrowers Funds at Settlement field, on lines in which the From 

GFE entry is other than None, will total into the boxed figures, under the Paid From Borrower’s Funds 

at Settlement on lines 1101 and 1103, as appropriate, on the Title Charges (A) screen.   

Fees with From GFE entries of #4 (HUD 1101) or #5 (HUD 1103) should have the full amount of the 

charge entered in the Paid From Borrowers Funds at Settlement column and any seller paid portion of the 

charge should be entered in the Paid From Sellers Funds at Settlement column.  Any values entered in 

the Paid From Sellers Funds at Settlement field, on lines in which the From GFE entry is #4 (HUD 1101) 

or #5 (HUD 1103) (rolling into 1101 or 1103), will be accumulated with the other Seller Credit to Buyer 

figures and will not be treated as Seller Paid items (the way the column header implies).   

Only entries with None in the From GFE field, with amounts in the Paid From Sellers Funds at 

Settlement, are treated as Seller Paid items. 

The charge Description is entered to the left-most field, and the payee in the “to” field.  The  Payee 

Name and Address icon will open the payee name and address detail screen which can be used to 

complete the “to” field; and the  NAF icon can facilitate that as well.  The From GFE option is selected 

via the dropdown provided; and, the WTH and POC checkboxes, and POC  Modify button are 

provided. 

 

 

 

 

 

 

 

 

 

 

 

The Title Charges (B) screen covers lines 1109 through 1120. 

The Title Charges (L) screen is identical to the Title Charges (B) screen, covering lines 1121 through 

1132. 
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Title Charges – Closing Disclosure Form (CDF) (conditional) 

The Closing Disclosure Form data entry screens, when made available to Title, are comprised of a loan 

overview screen, Title Insurance Premiums screen, and Title Charges screen – for each lender on the 

file.  The screens are reached through the Title Charges entry on the Opening Information menu.  The 

screens are accessed via a tree-view presentation, as shown below.  The tree-view in Escrow has many 

more data entry screens but Title is restricted to these, if any.  Again, the availability of the title charges 

screens is controlled by a Setup Option to allow Title to have access to enter/edit title charges, which can 

only be enabled if the Sub Escrow functionality is not enabled.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note the addition of the  Up and  Down icons, in the Opening Information tool bar at the top of the 

screen.  These are used to move the user through the entries on the tree-view on the left side of the 

screen. 

When a lender’s name is highlighted, in the tree-view, the right side of the screen will present information 

about that lender’s loan, as shown above. 

The  Edit Lender icon, at the top right of the data window (next to the lender name) is used to take the 

user to the Edit Lender screen, where the currently selected lender and its loan information can be 

edited. 

If no lender has been added to a file, and the user goes to the Closing Disclosure Form entry screens, the 

screen will indicate that there are no lenders present on the file.  The user can click on the link in the 

middle of the screen or the   Add New Lender icon, above the tree-view area, to add a lender to the 

file.  From a practical standpoint, if Title finds there is no lender on the file, they would probably contact 

Escrow to have the proper lender added to the file.   
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Title Insurance Premiums 

The Title Insurance Premiums branch on the tree-view is where information on the Lender’s and 

Owner’s policies is entered.  The CFPB’s rule governing the presentation of title insurance premium 

pricing, in a simultaneous issuance (Lender’s and Owner’s) situation, is very precise and is not the 

historic presentation of most of the Western US marketplace.  Rather than presenting the simultaneous 

rate for the Lender’s Policy (generally a low additional charge), the rule mandates presenting the full 

Lender’s Policy price, as though it were not a simultaneous issue situation, and then the Owner’s Policy 

pricing is presented as the combined simultaneous cost of both policies, less the full Loan Policy price.  In 

a situation, typical in the Western US, where the seller is paying for the Owner’s Policy, and the borrower 

is paying just the incremental add for the Lender’s Policy, the rule’s mandated presentation of pricing 

results in an overstatement of what the buyer/borrower is responsible for and an understatement of what 

the seller is responsible for.  The Title Insurance Premiums screens take this matter into consideration 

and provide for a Seller Credit to address the discrepancy presented by the pricing presentation mandate, 

in simultaneous issue situations where the seller is paying for the Owner’s Policy and the buyer/borrower 

is paying for the Lender’s Policy. 

 

 

 

 

 

 

 

 

 

 

 

 

Prior to any policy pricing information being entered, the Title Insurance Premiums main screen looks 

like the sample shown above.  The  Add Policy icons are used to get to the Lender’s Policy 

Information and Owner’s Policy Information screens.  Only one policy of each type may be added. 

 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 72 of 181 

Lender’s Policy Information 

Clicking on the  Add Policy icon, for the Lender’s Policy Information, brings up the screen below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Policy to Issue field can be manually typed into, with the policy to be issued, or the  Search icon 

can be clicked on to pull up the policy menu for the underwriter on the file, from which the policy can be 

selected, as shown in the graphic above. 

If an Income Code is selected, the Payee Information will default to the Company, and the Liability field 

will fill with the value linked to the income code selected.  If the policy is not being issued by the Company 

(outside title situation), then no income code should be selected; the outside title company should be 

identified in the Payee Information section at the bottom of the screen. 

The Base Premium through Total Premium fields are for “rate schedule/manual” figures (historic pricing 

method).  The Surcharge amount will be added to the Base Premium.  The Discount amount will be 

subtracted from the Base Premium.  Both the Surcharge and Discount figures are entered as positive 

numbers.  The calculated result will be put in the Total Premium field. 
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The Lender’s Policy Information screen has a “Simultaneous” checkbox.  It is to be checked if the 

pricing of the Lender’s Policy is based on the simultaneous issue discount.  This will trigger the 

appropriate Credit to Borrower for Seller Pay, on the Owner’s policy screen – if the seller is paying for 

the Owner’s policy and the borrower is paying for the Lender’s policy.  In this situation, the user would 

enter the full Lender’s Policy Base Premium, in the field of that name, and enter the Discount that brings 

the Total Premium to the rate schedule/manual simultaneous rate for the Lender’s Policy.  Checking the 

checkbox will pull the Base Premium to the CDF Amount field.  

 

 

 

 

 

 

 

 

 

 

 

 

The Borrower Amount, Seller Amount and Paid by Others fields are used to identify which party(ies) 

are paying what portion of the Total Premium.   

When an amount is entered into the Paid by Others field, 

and the user then tabs out of the field, the system will 

bring up the Paid by Others (Payors) screen, on which 

details of which party(ies) to the file is(are) paying the 

charge, and whether it is POC’d. The full amount must be 

detailed before leaving the Paid by Others (Payors) 

screen.  The ellipse button after the Paid by Others field 

will bring up the Paid by Other (Payors) screen for 

subsequent editing after initial completion. 

The CDF Amount field is used to present the value that is to appear on the CDF for the Lender’s Policy.  

Again, as was discussed earlier, in a simultaneous issue situation, this will be a higher figure than the rate 

schedule pricing would indicate.  This amount will be calculated by the system. 

The Description field will default to the mandated format for the Lender’s Policy charge (with “Title –“ in 

front of the policy info) but the field will be editable. 
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The Send To field is used to identify which section of the CDF the policy premium information should be 

presented.  Sections B, C or H are the options.   

The Loan Estimate and Tolerance fields are used to enter the amount from the Loan Estimate and the 

tolerance category for the policy. 

The Credits/Funding section provides for the withholding of the amount paid by the lender (entered via 

the Paid by Others field) and for Seller credits to the Borrower for some or all of the premium. 

The POC section of the screen provides for identification of premium amounts Paid Outside of Closing by 

the Borrower or Seller.  The Description field is used to customize the POC item’s label, for use on the 

Settlement Statement only. 

 

Endorsements Tab 

The Endorsements tab is used to detail any endorsements, and premiums, that are being issued with 

the Lender’s Policy.  Click on the  New Endorsements button to bring up the screen on which that 

information is entered.  The behavior is similar to the Lender’s Policy screen’s top portion.  The Liability 

field will be grayed out if an income code is selected, as it will be linked to the policy the endorsement is 

assigned to. 
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Payee Tab 

The Payee tab will be pre-filled and locked if an income code was selected on the Lender’s Policy, or will 

be open for entry of the outside title company’s information. 

 

 

 

 

 

 

 

Once the data entry is completed, the user should click on OK to save the data.  The policy and 

endorsement information will be displayed on the main Title Insurance Premiums screen, with the policy 

being listed first. 
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Owner’s Policy Information 

Clicking on the  Add Policy icon, for the Owner’s Policy Information, brings up a screen identical to 

the Lender’s Policy Information screen with two exceptions: 

1) The Owner’s Policy Information screen does not have the “Simultaneous” checkbox. 

2) There are a pair of fields under the label Credit to Borrower for Seller pay: that are used to 

present the credit needed to correct the Borrower and Seller actual costs, in a simultaneous issue 

situation with a Seller-paid Owner’s policy and a Borrower-paid Lender’s policy, due to the 

regulation-mandated pricing presentation on the CDF (discussed further below). 

The CDF Amount field is used to present the value that is to appear on the CDF for the Owner’s Policy.  

Again, as was discussed earlier, in a simultaneous issue situation, this will be a lower figure than the rate 

schedule pricing would indicate.  This amount will be calculated by the system, in conjunction with 

information on the Lender’s Policy screen.  Both the Lender’s Policy and Owner’s Policy figures must be 

entered before the calculation will be completed.  Clicking on the  Info icon will present an explanation 

of the calculation. 

Under the Credit to Borrower for Seller pay: label, there is a Description field that will default, but will 

be editable, and an Amount field for the amount of the credit.  The credit amount would be the amount 

required to bring the cost to the borrower, for the simultaneous Lender’s Policy, down from the stated 

CDF Amount (on the Lender’s Policy screen) to the rate schedule’s amount for the simultaneous issue, if 

the Owner’s policy is being paid for by the seller.  It is the same amount needed to bring the CDF 

Amount, for the seller-paid Owner’s Policy, up to the rate schedule’s amount for the Owner’s Policy.  The 

credit will be calculated automatically if the “Simultaneous” flag is checked on the Loan Policy 

Information screen and the Seller is paying for the Owner’s policy and the borrower is paying for the 

Lender’s policy.  Both the Lender’s Policy and Owner’s Policy figures must be entered before the 

calculation will be completed.   

In the sample below, a Lender’s Policy has been entered, to be paid by the Borrower, and the 

Simultaneous flag was checked on that data entry screen.  Then, on this Owner’s Policy screen, the 

Base Premium has been entered and the Seller is identified as the payor (with the amount in the Seller 

Amount field).  Clicking on the  Info icon results in the presentation of the explanation of the 

calculation for the CDF Amount.  

In this example, the $450 Credit to Borrower for 

Seller Pay, when added to the CDF Amount, brings 

the seller cost back up to the true rate manual cost for 

the Owner’s Policy, which the seller will be paying, and 

reduces the borrowers true cost for the Lender’s policy 

to $150.00.  The credits will appear in sections L & N of 

the CDF (discussed later in this documentation). 

If the Borrower is the payor of the Owner’s policy 

premium, the Description will reflect “(Optional)” at the 

end of it.  Some lenders may require that verbiage 

regardless of the payor. In that case, the user can 

modify the Description manually. 
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Title Charges 

The Title Charges tree-view entry is used to add any non-policy, non-endorsement title charges to the 

CDF file.  

 

 

 

 

 

The  Add Line button is used to open the Title Charges data entry screen shown below. 

The Type field, at the top of the screen, will present, through the dropdown arrow, a listing of MISMO 

standard charge types.  The Type selected will default into the Description field, but the Description can 

be edited.  Per the CFPB Final Rule, the Description, for title-related charges, must begin with “Title – “ 

– this does NOT need to be done manually on this screen. The required hyphen after the leading “Title” in 

the Description will be added automatically when the charge is viewed from the CDF section it is sent 

to…it need not be edited here. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Income Code for the charge should be selected (this will auto-fill the Payee Information with the 

Company’s information).  If applicable, the Liability field will be opened for data entry. 

The Borrower Amount and Seller Amount fields are used to detail the amounts being paid by either of 

those parties. 
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When an amount is entered into the Paid by Others field, and the user then tabs out of the field, the 

system will bring up the Paid by Others (Payors) screen, on which details of which party(ies) to the file 

is(are) paying the charge, and whether it is POC’d.   

 

 

 

 

 

Click on the  New Payor button to bring up the Payor screen on which the details of who is paying 

what are entered.   

 

 

 

 

 

The full amount must be detailed before leaving the Paid by Others (Payors) screen.  The ellipse button 

after the Paid by Others field will bring up the Paid by Other (Payors) screen for subsequent editing 

after initial completion. 

 

If there are Credits or Funding considerations, they are addressed in the middle section of the Title 

Charges screen.  If the charge is to be withheld from the loan (not typical), the Withhold from Loan 

checkbox should be checked.  The amount of any seller credit is entered into the Seller to Borrower 

field.  

If the charge is POC’d by the borrower or seller, details are entered in the POC section of this screen.  If 

the Borrower or Seller paid the charge outside of closing, the amount(s) they paid would go in their 

respective fields.  The user may enter a substitute Description in the field of that name, for use on the 

Settlement Statement only. 

The Payee Information section is used to identify the party receiving the funds.  The  NAF icon is 

available to select from the NAF; alternatively, the  Search icon is available to pull up a listing of 

parties to the file to select from; and, the  Clear icon is used to clear the Payee Information fields 

completely, so the user can start over.   

There is a Separate Check checkbox, if the payment is to be isolated from others to the same payee. 

 

 

The Add Another button, at the bottom of the screen, is used to save the current charge entry and bring 

up a new, blank screen for entry of another charge.   

Click on the OK button to save the charge entry, or Cancel to exit without saving. 
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Prelim Distribution List 

The Prelim Distribution List is used to manage the delivery methodology, for Prelims, CC&R’s and 

other Docs, to the various parties to the transaction.  A system setting will add columns for the Legal, 

Vesting and Plotted Easements as well.  While the data on distribution method and counts for the noted 

documents types can be entered on each party’s data entry screen, the data for all parties can be viewed, 

and edited, on this screen.  There is also an additional record for the Escrow Branch. 

 

 

 

 

 

 

The distribution method (Via column) and counts for each doc type can be edited on this screen, so the 

user does not need to go into each party to change this information.  Changes made on this screen are 

immediately reflected on the party. 

The  New Party icon, at the top right of the screen, can be used to add another party to the file. 

The  Information icon, on each party’s record, will present a brief set of information on the party, to 

refresh the user’s memory if needed. 

The  Clear icon, on each party’s record, will erase the distribution method and counts for that entry. 
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Miscellaneous Data Entry 

A system configuration option exists that provides for the ability to add data fields for information that the 

Company wishes to track that is not provided for elsewhere.  A screen will be presented of whatever 

fields the Company has established.  The setup of the fields for this screen is done in the Utilities module, 

by a System Administrator via Utilities > User Tables > Dynamic Data Fields.  This data can be 

reported on, but cannot be used in documents.  Existing fields can be flagged (in Utilities) as inactive and 

will not appear for files created after that flagging. 

A sample of a Miscellaneous Data Entry screen is shown here. 

 

 

 

 

 

For sites that are configured to use the Miscellaneous Data Entry screen the option to print data for the 

selected file is available on the Print menu.  The user should select the Dynamic Data Entry Report 

option on the Print menu. 

 

 

 

 

 

 

 

 

 

 

 

This is the end of the Opening Information menu section description, for Residential files. 

Items that are unique, in Opening Information, for Commercial files, will be discussed in the following 

pages. 
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Opening Information - Commercial 

The Opening Info menu, on Commercial files, is identical to that on Residential files.  

 

 

 

 

 

 

Dates/Transaction Information (Commercial) 

The Dates/Transaction Information screen, on a Commercial file, is very similar to that of a 

Residential file, but has the following differences: 

 Type of Closing is Commercial and cannot be changed 

 

 

 

 

 The Sales Price field will reflect the aggregate of prices entered on each property and will be 

grayed out.  If prices are not entered on each property, the Sales Price field on the 

Dates/Transaction Information screen will be editable…until such time as prices are entered on 

New/Edit Property screens. 

 

 

 

 The Initial Deposit field is not presented. 

 The Funds Held by Broker fields are not presented, as they are not applicable to non-RESPA 

files. 
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Properties (Commercial) 

Commercial files are distinguished by the ability to have an unlimited number of properties added to 

them.  The Property Information menu entry, on the Opening Information sub-menu, will initially open 

with a largely blank window.  The  Add Property icon, at the top near-middle of the window, is used to 

initiate the entry of information on each property to be added to the file.  When the Add Property icon 

is clicked a screen will be presented like the one shown below.  The same three tabs are presented as on 

the Residential property screen: Property, Mobile Homes and Notes. 

 

 

 

 

 

 

 

 

 

 

 

 

The Commercial New/Edit Property screen is very similar to that in Residential files, with the following 

differences: 

 There is a Sales Price field for each property.  Prices entered in this field (on each property) will 

aggregate to the Sales Price field on the Dates/Transaction Information screen. 

 There is an Add Another button at the bottom of the screen that, when clicked, will present 

another property entry screen for the next property to be defined. 

 There is a Copy From button at the bottom of the screen that, when clicked, will present a listing 

of the previously entered properties on the file and the user may identify which property to copy to 

use as a starting point when entering another new property.  Alternatively, when a property is 

highlighted, in the Property tree-view (discussed later), the   Copy Property icon, at the top 

right of the Property tree-view (left side of screen), will copy the highlighted property to a new 

property record, where the copy can be edited. 

The reader is referred back to the Property Information Screen (Residential) section of this manual for 

explanation of the common fields on this screen.  The Mobile Homes and Notes tabs are identical to 

those on the Residential Property screen. 

The Cancel button applies to all changes made to the active property screens, not just a particular 

screen.  Hitting Cancel will eliminate all changes made to all screens (Property, Mobile Homes & Notes). 

Once the OK button is used to save changes made to a property entry, the property will be listed in a 

tree-view on the left side of the screen – as shown on the next page. 
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The Properties screen (shown below), when first presented, will not have any property highlighted, in the 

tree-view on the left side of the screen, and will have limited data about all entered properties on the right 

side of the screen. 

To edit an existing entry in the tree-view, the user can highlight it in the tree-view and click on the  Edit 

icon in the upper right corner of the window, or right-click on the property and select Edit from the options 

presented (  Edit or  Delete). 

 

 

 

 

 

 

 

 

 

 

The  Reposition Property icon, above the tree-view, will present a window in which the user can 

reorder the properties – this will impact the number of the property, which can impact documents that 

have already been prepared based on the previous ordering. 

The  Copy Property icon, above the tree-view, will copy the highlighted property’s information to a 

new property, where the differences can be edited. 

As shown above, a view-only screen of each 

property’s information is shown when the 

property is highlighted in the tree-view.  The 

Notes on any property can be read (but not 

edited) by clicking on the  Notes icon in the 

upper right corner.  The  View Detail and  

View Summary icons, also in the right corner, 

will flip from a summary listing of all properties to 

a detailed preview screen for one property or 

back, depending on the icon and view that is 

open.  The screen to the right reflects the View 

Summary presentation. 

The  Delete icon (in the icon tray on the right of each property summary section) can be used to 

completely remove a property from the file.   
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Parties (Commercial) 

Commercial files can have unlimited numbers of all Party types, including Lenders and Agents (which 

are restricted in number in Residential files).  Entry of Party information on Commercial files is 

fundamentally the same as it is on Residential files, and the user is referred to the Parties explanation 

earlier in this manual for a full discussion of the subject.  The following comments will be limited to 

differences in Buyers, Sellers and Lender party data entry that are specific with Commercial files. 

Buyers & Sellers (Commercial) 

The Buyer and Seller party entry screens, on Commercial files, are identical to those in Residential 

files with one addition:  Ownership Percentage.  The Ownership Percentage entered on each Buyer 

and Seller party entry reflects that party’s ownership interest in the entire transaction.  Up to four decimal 

places may be entered.  As an example of an entry, 10 1/8
th
 percent would be entered as 10.125.  The 

system keeps track of the aggregate percentages entered and will detail the remaining percentage, if any, 

to be assigned to the parties that have been entered on the file, as shown in the screen shot below.  If 

any percentage is entered on any party, 100% must be assigned, across all parties, before the user can 

leave the Parties screens. 

 

 

 

 

 

 

 

 

 

The Ownership Percentage is used to enable the generation of “fractional” settlement statements, by 

Party, that split up the transaction’s figures by the percentages entered. 
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Lenders (Commercial) 

The Lender party entry screen, on Commercial files, is very similar to those in Residential files with four 

changes:  The GFE-related Loan Terms & Tolerance Adjustments tabs do not exist; Interest 

Prorations cannot be administered from the Lender screen for the New Loan and Refinance Types of 

Financing; the Type of Loan field does not exist; and, an Alternate Loan Description field has been 

added to the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Alternate Loan Description field will present as the description of the loan on the Settlement 

Statement. 

Lenders can be Repositioned, on the main Parties screen, on Commercial files. 

Again, all other Party entry is identical to that described earlier in this manual. 
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Title Charges – Commercial (conditional) 

The data entry of settlement items for Commercial files was introduced in version 7.6 of Impact/SQL and 

is completely different from the HUD or Worksheet data entry styles.  This screen will only be available if 

the enhanced Sub Escrow functionality is not enabled, and the option to let Title update title charges is 

enabled. 

The Title Charges Settlement Items category is used to enter title charges and lender & owner policy 

premiums.  The  New Title Charge icon is used to create a new entry.   

The top portion of the screen concerns the charge information.  There are, currently, three charge types 

(Title Charge, Lenders Policy and Owners Policy) and Title Charge defaults in the Type field.  It is 

possible other Types may be added in the future. 

 

 

 

 

 

 

 

 

 

 

 

 

When the Lenders Policy or Owners Policy types are selected, the Description field will default with 

the text selected, but will be left editable so the user can describe the policy being issued.   

If the Lenders Policy type is selected, the Liability From field will be activated and the user will need to 

select the Lender to use to drive the value entered in the Liability From field; the lender’s loan amount 

will populate the Liability From field.  The field will remain editable so the user can change the liability 

amount. 

If the Owners Policy type is selected, the gross sales price aggregate will be entered in the Liability 

From field.  The field will remain editable so the user can change the liability amount. 

Should the charge be a Company fee, the appropriate Income Code should be selected for the charge 

being entered, using the dropdown list.  Once an income code is selected, the Payee Information 

section of the screen will auto-fill with the Company Name (:T payee information) and Branch Address.  

The Payee Information fields will then also be grayed out and will be not be able to be edited. 

The user should enter the charge in the appropriate debit/credit fields.  
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Notes can be added and will appear on the Settlement Statement. 

If the charge is a POC item (complete or partial), that detail is entered in the middle of the screen. 

The Payee Information (if the charge is not a Company charge, indicated by an income code above) is 

entered at the bottom of the screen.  The  Search for Payee icon is used to bring up a listing of all 

parties entered on the file, for selection of one as the payee.  There is the ability to edit the parties, from 

the listing presented, if need be.  The  NAF icon will be enabled when the cursor is placed in the Name 

field, so the user can select from the NAF for the payee.  If the payee is not a party and is not in the NAF, 

the user can simply enter the payee’s information.  The  Remove Payee icon will be enabled once 

payee data is entered via the  Search for Payee icon and clicking on it will clear all of the Payee 

Information fields. 

The Allocate Charges checkbox at the bottom of the screen will bring up the Settlement Allocations 

screen.  Allocation of Commercial Settlement Items is detailed in the Escrow manual, and, as allocating of 

charges covers far more than Title Charges, the user is referred to the Escrow manual for more 

information. 

 

Balance of Opening Information Menu (Commercial) 

The balance of the Opening Information menu entries on Commercial files (Source of Business/Bill 

To, Title Information, Prelim Distribution and Misc Data Entry) are identical to those in Residential 

files and so will not be discussed here.  The reader is referred back to the discussion of those screens 

earlier in this manual. 
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Opening Information – Direct Order 

The Opening Information menu, under Edit in the Title module, for Direct Orders, can contain up to ten 

(10) entries, as shown below.  Each will be described in the following pages. 

 

 

 

 

 

 

 

There is an additional  Title Search icon on the Opening Information screens (as seen below).  This 

icon will send the file to the queue to be printed or emailed as a newly submitted order.  The other icons 

at the top of each screen are the same as those described earlier in this manual, in the Opening 

Information – Residential Files section – and will not be re-explained here. 

 

Dates/Transaction Info 

The Direct Order Dates/Transaction Info screen is an abbreviated version of the Escrow file screen of 

the same name.  A sample is shown here. 

The Title Officer on the file is identified by 

selection from the dropdown list of all TO’s 

in the Title Branch of the file. 

The Marketing Rep field is filled from the 

dropdown listing of all marketing reps. 

The Date Opened field is pre-filled with the 

date the Direct Order file was created but 

can be changed by the user manually or 

with the  Calendar tool. 

The Contract Number can be entered in 

the field of that name. 

The Contract Date field is used to enter the date of the purchase contract, if there is one.  This field is 

available to be pulled into documents. 

The Date Closed and Date Recorded fields will fill with the effective date of the policy when the policy is 

issued.  If the user manually enters these dates, they will not be updated upon issuance of the policy. 

The Project Name field is dissimilar to that in Escrow.  In Title, it is simply an eight character descriptive 

field. 

The Type of Transaction field is selected from the dropdown list.  This field is used to categorize files for 

management reporting.  This field is often mandatory.  The transaction type lookup table is maintained, 

through the Utilities module, by a System Admin. 
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The Underwriter field is filled via the dropdown listing of available underwriters.  If only one is available, it 

will default. 

The Policy Type dropdown for this field presents the product sets that have been defined by the 

business as those available to their customers.  The listing will present the various combinations of 

owner’s and lender’s policies and the user should select the description that best fits the transaction.  The 

listings may differ by underwriter.  Should additional information need to be provided to Title, it can be 

added in the Comments field on the Title Information screen.   

The Sales Price field is used to record the purchase price of the property, if a purchase transaction.  The 

field should be left blank if a refinance transaction.  The loan amount, on a refinance transaction, is not 

entered here, but on the Lender screen. 

 

Property Information 

The Property Information screen, on a Direct Order, is used to enter information on the property 

involved with the transaction.  Most of the fields on this screen are available for use in documents and in 

reports. 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two tabs on the Property Information screen:  Property and Mobile Homes.  Should there be 

data on the Mobile Homes tab, there will be a  red diamond icon next to the tab name. 

Property Tab 

The Property tab is used to detail all the pertinent information about the property, starting with the 

address information.  There are two lines for the street or box address information (Address #1 & 

Address #2) and then City, State and Zip Code fields.  The City field has a dropdown list that can be 

populated by the business with those cities that they routinely do business with; selections from that list 

may populate the County and State fields at the same time.  The user may also enter the city manually.  

The State field dropdown has all of the states abbreviations listed.   

The County field will normally default to the County on the Branch setup screen, but this is optional. The 

County field can be populated manually or via the dropdown listing of counties.  
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The Property Type field is populated via the business-maintained dropdown listing of property types (ie. 

1-4 Family Residence).  The property types are used to categorize the transactions for management 

reporting, but have no other functionality in the system. 

The Municipality Type and Municipality Name fields are provided, but are not used in most states. 

The Subdivision Name field can be filled from stored subdivision information via the use of the button 

with the ellipse (…) on it, next to the field.  The stored subdivision information can fill the Tract, Book and 

Page fields as well.  If the user does not find the subdivision name they need in the listing available, they 

can enter the name manually.  The stored subdivision listing is maintained by the business via the 

Utilities module.  

The T/S Weeks label should be ignored.  It is applicable only to Escrow files. 

The Unit, Low Lot, High Lot, Block and Q1Q2Q3Q4 sections of the screen are used to detail 

information related to the plat map of the property.  The user would only use the Unit or the Q1Q2Q3Q4 

sections, not both, depending on how the property is described in the land records. 

The Brief Legal field will auto-populate from data entered in the Subdivision Name, Tract, Map Book 

and Map Page or Section, Township and Range fields (whichever set are used), the first time the brief 

legal field is tabbed or clicked into.  The user can modify the brief legal that is presented.  The brief legal 

field is limited to 250 characters.  Note: if changes are made to the individual component fields, the brief 

legal will not be automatically reconstituted unless it is deleted and the field is tabbed into again when 

empty. 

Clicking on the  Full Legal icon will launch MS Word® and let the user enter the full legal description.  

The full legal is stored as an MS Word® document by Impact/SQL and, as such, it can be incorporated 

into other documents prepared within Impact/SQL. 

The Tax Parcel ID Numbers / Tax Map Key fields (four) are available for that data and are available to 

the Search function in Impact.  Hyphens must be included when entering the tax parcel numbers, as 

there is not a standard convention. 

The HPR Numbers (horizontal property regime) fields are used with property descriptions of timeshare or 

condominium units.  If needed, these fields could also be used for additional tax parcel ID numbers or tax 

map keys.  Depending on the system configuration, these fields may be labeled Property Levy Codes. 

Mobile Homes tab 

The Mobile Homes tab, on the Properties screen, is used to 

detail any number of mobile homes that may be involved with 

the transaction.  The data entered on this tab is available for 

use in escrow documents.  When first presented, the screen 

looks like the sample below. 

Clicking on the  New Mobile Home icon will create an entry, 

in the column on the left side, of “Mobile Home 1” and will 

open up the data fields for entry of information.   

Once one or more mobile homes’ information has been 

entered, if the user determines one should be deleted, it 

should be highlighted in the column on the left and the  

Delete Selected icon should be clicked on (reached with the 

dropdown arrow to the right of the New MH icon).  The user will be prompted to confirm the intent to 

delete the item selected.  
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Seller Information 

The Seller Information screen, in Opening Information on a Direct Order, provides for the entry of 

information on eight (8) sellers, two on each of four tabs.  The tabs are identical.  Click on a tab label to 

move to that tab.  If there is data entered on a tab, a  red diamond will appear in front of the tab label. 

Note that the Seller Address Information, at the bottom of the screen, is common across all four tabs; 

only one address can be entered. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Company Name checkbox is used to let the system know to not reformat the name entry when using 

the name in documents.  If the checkbox is NOT checked, and the user is entering a personal name, they 

should enter in the format “Last Name {comma} First Name”.  The name will reformat around the comma 

if the Company Name checkbox is not checked.  Some samples on name entry are shown below. 

Individual’s Name Format Company Name Format Will Display on Documents 

Mouse, Mickey  Mickey Mouse 

DaVee Jr., Darel  Darel DaVee Jr. 

Brown Trustee, John  John Brown Trustee 

 USA Digital Solutions, Inc. USA Digital Solutions, Inc. 

 Dewey, Cheatem & How, PPC Dewey, Cheatem & How, PPC 
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The Hold Title Code is the type of vesting.  The dropdown box will present a listing of pre-defined entries, 

and if the user selects one of those from the listing, it will be put in the text box below the field and will be 

uneditable.  If the user wishes to enter a vesting description that is not in the listing, they should either not 

select an entry at all and directly type in the text box below the field, or, if they wish to modify a pre-

defined entry, they should select the entry first, then select the blank entry at the top of the dropdown 

listing.  This will open up the text box for editing. 

The SSN field is used to identify the tax identification number (EIN or SSN) for the named entity.  The 

user must enter the number formatted properly, with the hyphens being entered in the appropriate 

locations, as detailed in the error message below, which will appear if the user does not properly format 

their entry. 

 

 

 

 

 

An Email Address can be entered for each seller, in the field of that name. 

As was stated earlier, the Seller Address Information, at the bottom of the screen, is common across all 

four tabs; only one address can be entered.  The DDE field reference for the address is Sellers Address 

#1. 

 

Buyer Information 

The Buyer Information screens are identical to the Seller Information screens. 
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Lender Information 

There are screens provided to enter up to three (3) lenders on a Direct Order.  The user can get to each 

lender’s information by clicking on the heading tabs, or use the ALT+# (1, 2 or 3) quick key approach.  

Traditionally, the Lender #3 tab is used to enter Mortgage Broker information. 

 

 

 

 

 

 

 

 

 

The Name field can be filled in manually, or the information on the lender could be pulled from the  

NAF, if available therein.  Generally, lenders will be in the NAF, and for consistency sake the NAF should 

be used to populate the bulk of the fields on these screens. 

The data entered on the Lender Information screens is utilized in other areas of Impact/SQL.  There are 

Lender Payee shortcuts (:L1, :L2 & :L3) that will pull this information.  The information is also available in 

document preparation. 

The Reference Number field can be used for an additional lender-provided identifier, beyond the Loan 

Number, for which there is also a field. 

The Loan Amount should be entered in the field of that name. 
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Title Information 

The Direct Entry Title Information screen is used to accomplish a couple of different tasks.  The first is 

to provide additional useful information to the Title Department regarding the order.  The second is to 

record information about the outside Escrow operation that placed the order. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The property Status field is the first on the screen.  The options accessible via the dropdown box are 

Proposed, Under Construction and Exists.  The user should make the appropriate selection for the 

status of the structure on the property, if any.  If Proposed is selected, that should alert the Title 

Department that an ALTA inspection may be needed. 

The Base Order No. field is used to identify a starter file number (if, for example, the transaction is a 

refinance of a loan previously closed with another escrow in the system).  This is a searchable field in the 

Impact/SQL Search function. 

The Reference Number 1 and Reference Number 2 fields can be used to store client file number(s) or 

other reference numbers.  These fields can also be searched via the Search function. 

The Subject To field is used to enter “Schedule B” items if some are known. 

The Need by Date field is used to identify when the Prelim/Commitment is needed. 

Four Requirements can be listed in the fields in the boxed section with that label. 

Any additional Comments to Title can be entered in the text box of that name. 

The Escrow Company Information is entered in the bottom section of the screen.  The information can 

be entered manually, but the  NAF would typically be used to enter routine clients’ data.  The  NAF 

icon will be activated when the cursor is in the Name field. 
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Source of Business 

The Direct Order Source of Business screen is shown below.   

 

 

 

 

 

 

 

 

If the Source of Business is one of the three Lenders previously entered, or the Escrow Company 

entered on the Title Information screen, the user can identify that by clicking on the appropriate radio 

button at the top of the screen.  The data from the selected party will be pulled into the fields on the 

screen, and they will be uneditable. 

If the user leaves Other selected, they would then enter the information manually, or they could use the 

 NAF to enter routine clients’ data.  The  NAF icon will be activated when the cursor is in the 

Company Name field. 

In this sample screen, the Company Name field is reflecting a green background, as it has been set as a 

mandatory field for a Direct Order (a system configurable option). 

 

Billing Information 

The information entered on the Billing Information screen, on a Direct Order, will flow to an invoice 

prepared on the file. 

The Bill To party and their information will 

flow from the party selected (by radio button), 

at the top of the screen.  If Other is selected, 

the information can be entered manually or 

via the  NAF. 

The Sales Price and Loan Amount data will 

populate from the data entered earlier. 

The user should enter the charge data in the 

Billing Items section at the bottom of the 

screen. 
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Prelim Distribution 

The Prelim Distribution screen is used to identify how many copies of assorted documents are to be 

delivered to the assorted parties on the transaction and how they are to be delivered.  The data entered 

here does not trigger automated delivery, it is purely informational. 

The method of distribution is selected from the Via dropdown list. 

The Number of Copies of each type that are to be provided should be entered in the three or six 

(depending on configuration) columns on the right of the screen.  The columns represent Prelims, 

CC&R’s, Documents, Legal Description, Vesting and Plotted Easements. 

The Lenders’, Seller #1, Buyer #1 and Applicant (Source of Business) names will flow from their 

original entry points, as will the Escrow company name, at the bottom of the screen.  Additional parties 

may be added in the three open sections.  The  NAF can be used on this screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Miscellaneous Data Entry 

The system can be configured to accept data into fields defined by a business, for use in reports – but not 

documents.  If so configured, the Miscellaneous Data Entry screen will be the last presented on the 

Opening Info menu. 

A sample is shown to the right.  As every site can 

define different data fields for this screen, if they 

wish to use it, no further explanation will be 

provided here. 
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Legal Description 

The second entry on the Edit menu, in Title, is Legal Description.  This function is used, by Title, to edit 

the Full Legal.  Once a file is submitted to Title, Escrow users cannot edit the Full Legal (unless a 

system override setting is enabled).  The Full Legal can still be used in escrow documents after it is 

locked.  The Legal Description is entered, and stored, as a MS Word ® document in Impact. 

The selection of the Legal Description entry, on the Edit menu, will result in the presentation of the 

Legal Description screen as shown below.  If the file involved is a Residential file, there will only be one 

property listed.  If the file involved is a Commercial file, all of the entered properties will be listed.  

Samples of each are presented here (Residential on the left, Commercial on the right). 

 

 

 

 

 

 

 

 

 

When first opened, no property will be selected (checkbox in front of the Property Address), but to utilize 

the function icons across the top of the screen, the appropriate property(ies) should be checked.  At that 

point, the Legal Description for the selected property(ies) can be  Printed,  Emailed or  

Published (if so configured).  If there is a Date/Time entry in the Last Updated column, a Full Legal 

exists for the property.  If that column is blank, no Full Legal has been started for the property. 

To enter a new legal description, or edit an existing one, the user should double-click on the appropriate 

property or click on the  Edit icon to the right of the property to be worked. 

The default Full Legal master document is very often completely blank.  However, it can be customized if 

there is default verbiage, or data from the file, that the Company wishes to have always presented at 

initial creation, in a standardized format.  When a Full Legal is first opened for a property, the system will 

copy the default master document and save it tied to the file and property, and present it to the user 

inside MS Word ®, ready for editing by the user. 

Impact adds a customized tool bar/ribbon to the MS Word ® tool bar/ribbon set that provides for various 

custom functions that aid in the entry of the legal description.  The Impact/SQL Legal Tool Bar/Ribbon, 

from MS Office 2010 ®, is presented below.  There are different Impact/SQL Tool Bar/Ribbons in the 

different document types in Impact (Escrow, Title, Prelim & Policy), customized for the document type. 
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There are shortcut Quick Keys for many of the Legal tool bar icons, as detailed here. 

Button Tool Name Quick Keys 

 

Next Fill-in 
 CRTL+1 or F11 takes user to the next fill-in field in 

 the document, if there are any. 

 

 Insert Field    CTRL+2  

 

 Insert Legal Clause 
 CTRL+3 to bring up the floating insert legal clause 

 window 

 

 Insert Degree  The apostrophe key under the tilde ~ 

 

 Change Case 

 SHIFT+F3 at end of text string will cycle through 

 three options: ALL CAPS, all lower case, Upper case first 

 letter only. 

 

 
 Date to Text 

 CTRL+0 will mimic icon. 

 CTRL+9 will generate an alternative text version 

 (Month ##, ####) vs. icon’s (## the day of Month, 

 ####) 

 

 
Format Phone Number 

 Enter 7 or 10 digits then hit icon or ALT+2 

 to add parentheses and hyphen to format number. 

 

 Open Tools Menu 
 No Quick Key shortcut. 

 Content of menu varies by Access Level. 

 

 Print Document  CTRL+P to print the document 

 

 Email Document  CTRL-SHIFT+M to email the document 

 

 Info  CTRL-SHIFT+A for info on Impact and the document 

 

 Save Document  CTRL+S to save the document changes 

 

 Save and Return to Impact 
 No Quick Key shortcut.   

 Saves the document changes and closes the doc. 
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The  DDE Icon 

A configuration option is available to permit the use of data fields (DDE) within the legal description.  If 

enabled, clicking on the DDE icon, on the Impact Legal tool bar/ribbon will bring up a listing of fields that 

can be used.  Highlighting a field on the list will have its data contents preview at the bottom of the listing.  

Double-clicking on the field name will insert the contents at the cursor location in the document being 

edited.  Alternatively, once the field is highlighted, the user can click on the Insert button to insert the 

contents at the cursor location. 

 

 

 

 

 

 

 

 

 

 

 

 

The  Clause browser Icon 

Snippets of text often used in legal descriptions can be stored in MS Word ® files called “clauses”.  

Clauses can then be imported into the legal description as the text is needed, with the Clause Browser 

icon. 

When clicked upon, it will open up the Clause Insertion 

window, shown to the right.  The user can enter the clause 

name (or names, separated by commas), if known, in the 

field and then click on Insert to use it/them.  Alternatively, the Browse button can be used to see a listing 

of available Legal Clauses. Highlighting items 

will present their contents, as shown in this 

sample. 

 

 

 

The balance of the Legal tool bar/ribbon icons are explained in the Documents section later in this 

manual.  
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Order Title Search 

The Order Title Search entry, on the Edit menu in the Title module, is available to submit a Direct Order 

that is open on the desktop to the Title Department.  The option will not be available if an Escrow file is 

open on the desktop. 

The same function can be performed using the  Title Search icon on the Opening Information 

screens (as seen earlier).  The function will send the file to the queue to be printed or emailed as a newly 

submitted order. 

When initiated, the user will be prompted with a confirmation 

screen, like that shown here, asking if the order should be 

submitted to Title. 

Giving an affirmative or negative response, the system will 

prompt the user as to whether they wish to print Title 

Instructions for the file submitted. 

If the order has previously been sent to Title, and accepted/printed, a subsequent submission will be 

marked “Amended”, so that Title will recognize it is not an initial submission. 

 

Update Search & Exam Info 

The Update Search & Exam Info entry, on the Edit menu in Title, presents the same screen regardless 

of whether the file open on the desktop is an Escrow file or Direct Order. 

The screen is used to log information on the status of the title work being done on the file.   

It can also be used to change the Title Unit (Branch, Plant) on a file, if 

multiple title branches are available.   

Data entered on this screen is presented on the File > File Progress 

Report screen, in Title, and the File Status screen (for escrow files) in 

Escrow.  Therefore, other users can see the status of the order as it 

progresses through Title, and need not call Title for the same 

information. 

If Title File Numbering is enabled, the user may be able to set the Title 

File Number in the field of that name, depending on system settings; 

the number may be assigned at opening.  As explained earlier, the 

Title File Number is an alternate number that can be assigned to an 

order.  It does not alter the underlying file’s number (Escrow or Direct 

Order). 

Typically, the following fields are completed as the file moves through the process, not all at once. 

The Searcher’s Initials can be entered, along with the Date to Searching (date and time). 

The Examiner’s Initials can be entered, along with the Date to Examining (date and time). 

And, the Date Into Typing (date and time) can be entered.  

A Point Value can be entered (to score difficulty of the file) if desired.  This can be used in reporting. 
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Create Prelim/Commitment 

The Create Prelim/Commitment entry, on the Edit menu, is the path to the routine through which the 

preliminary report or commitment is prepared.   

The preliminary report &/or commitment master documents are customized by underwriter.   

There are also customizations available for integrating with NextAce and Value Check.   

Sites can be configured to generate either document (preliminary report or commitment), with a prompt 

being presented when started, asking which document type will be prepared.  Both cannot be prepared 

on one file, just one or the other, when so configured. 

 

 

 

 

 

 

The Prelim/Commitment screen above is presented when the Create Prelim/Commitment entry is 

selected.  If the file is a Commercial file type, it may have multiple properties listed on the screen.  A 

Residential file or Direct Order will only have a single property listed.  The checkbox in front of each 

property is used to activate the  Print Selected,  Email Selected and  Publish Selected (if so 

configured) icons at the top of the screen, which are used to initiate those functions for the checked items 

– once a prelim/commitment exists for the property. 

If a document has yet to be created for a property (and there will be a different document for each 

property on a Commercial file), only the  Edit icon, to the right of each property entry, will be 

presented, and there will be nothing in the Created, Last Updated and Released columns.  Once a 

prelim/commitment has been created, the date and time of its creation will be put in the Created column; 

the end time of the last edit will be put into the Last Updated column; and, the date & time the document 

is released to Escrow will be entered into the Released column. 

The  Delete icon is used to delete a prelim/commitment document.  The user will be prompted to 

confirm that action before it is taken. 
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Prelim/Commitment Entry 

Clicking on the  Edit icon, to the right of a property on the Prelim/Commitment screen, will bring up 

the Prelim/Commitment Entry screen.  A sample is shown below. 

Basic file information is at the top of the screen. 

The Underwriter assigned to the file is presented.  If a 

prelim/commitment has not yet been created, the 

underwriter can be changed here without issue.  If a 

prelim/commitment has already been created, this is the 

only screen from which the underwriter can be changed 

(and the result of such a change will be discussed below). 

Under the Types of Policies to be Issued heading, the 

user can select up to three policies and their liability 

amounts.  The policy menus for each underwriter installed 

may vary.  The first entry, Policy A, will have the sales 

price of the property defaulted in the Amount field.  

Policy A fields are ONLY used for an Owner’s policy’s 

information.  Policy B will have the loan amount from Lender #1 in the Amount field and Policy C will 

have the loan amount from Lender #2 (if there is one) in the Amount field.   

The Effective Date field is used to enter the “Plant Date”. 

The Date Last Amended field and the Number field are used to keep track of the latest amendment’s 

date and count. 

The Examiner is selected via the dropdown of available personnel.  The initials and name are presented. 

The Typist is selected via the dropdown of available personnel.  The initials and name are presented. 

Once the underwriter and policy information is identified, the user should click on the  Edit Document 

icon to initiate creation (or editing) of the prelim/commitment.  This will initiate the loading of an MS 

Word® session with the prelim/commitment master document for the selected underwriter.  The 

previously entered legal description will be pulled into the document along with the policy information 

entered here.  Editing of the prelim/commitment will be discussed in the following pages. 

If there is an existing document and it should be deleted, the user should click on the  Delete 

Document icon. 

Changing an Underwriter 

Note: should the underwriter on a file need to be changed, once a 

prelim/commitment has been created, it can only be changed from 

the Prelim/Commitment Entry screen.  If the underwriter is 

changed, when a document already exists for the property, and the 

user tabs out of the Underwriter screen, the existing entries under 

the Types of Policies to be Issued heading will be reverted to 

None, and the user should select the appropriate policy(ies) for the 

new underwriter and then click on the  Edit Document icon.  The user will be prompted to confirm the 

change in underwriter at that point.  The existing document, for the old underwriter, will be replaced with 

one for the new underwriter.  
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Editing a Prelim/Commitment in MS Word® 

MS Word ® is used as the editor for the prelim/commitment documents, as it is with the Legal Description, 

Policies and other miscellaneous Title documents.  As mentioned earlier, if a site is so configured, the 

user will be prompted, upon initially requesting a new document from the Prelim/Commitment Entry 

screen, as to whether they desire a preliminary report or a commitment for the property.  Once that 

selection is made, the user will be put into a copy of the appropriate master document for the underwriter 

selected. 

The master documents will be formatted as the underwriter and business desire.  As much data as can 

be pulled from the database will be, via the use of DDE fields and SmartTags.  Data pulled from the 

database in this manner will present as red text in the document on the screen.  If the document contains 

the Full Legal, it will have been merged into the document, preserving the original Full Legal as a 

standalone document that can be pulled into other documents as well.  Generally, it is good policy to 

enter the Full Legal before creating the prelim/commitment.  The Company’s logo and customized 

electronic signatures are also incorporated into the master documents.  The various sections of the 

master document are “bookmarked” in order to allow for sections of the document to be utilized in other 

documents – such as policies.  The user must be aware of this bookmarking and be careful when deleting 

or copying sections of the document, so as to not damage the bookmarking. 

The master documents are prepared in such a manner as to allow for the user to move through the 

document as quickly as possible, being taken to the points at which data entry is required.  The F11 

function key is used to the next “fill-in” field in the document.  Fill-in fields are indicated by a pair of [blue 

square brackets].  There may be some text within the brackets, indicating to the user the nature of the 

text to be inserted.  There are situations where the pair of blue brackets representing a fill-in field [ ] will 

enclose a special control that will, when reached, will prompt the user for a response.  These will be 

discussed below.  

Most of the editing done in a prelim/commitment document involves insertion of clauses (code book 

phrases) into the Requirements, Exceptions, Restrictions or Notes areas of the document.  These 

clauses must be placed in the correct area of the document in order to properly transfer to the policy 

document(s).  These areas will likely contain special Fill-in fields that provide for easy insertion of clauses 

from the electronic code book.  If the user needs to insert more clauses in a later edit, or if the special Fill-

in fields are not present, they can first click on the appropriate toolbar/ribbon icon to be taken within the 

appropriate section of the document – EXC to get to the end of the Exceptions section, REQ to get to the 

end of the Requirements section, RES to get to the end of the Restrictions section and NOTE to get to 

the end of the Notes section.  Once taken to the requested section, the cursor will be within the 

bookmarking for the section, and clauses entered will continue the numbering before them. 
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Prelim/Commitment Toolbar/Ribbon Icons and Quick Key Alternatives 

The table below describes each of the toolbar/ribbon icons that are located on the customized 

Impact/SQL Prelim ribbon (in MS Office 2010 ®), as seen in the screen shot on the preceding page.  

Some are common to those found when editing the Full Legal, Policies or Miscellaneous documents.  

Quick key alternatives are also identified, if the user does not want to click on the icon with their mouse.  

Hovering over the icons will result in “tool tips” being displayed.  Note: depending on screen resolution, 

some of the ribbon buttons will be grouped into sub-menus, as is seen with the Tools and Actions 

buttons on the screen shot on the preceding page. 

Button Tool Name Quick Keys 

 

 Next Fill-in 
 CRTL+1 or F11 takes user to the next fill-in field in 

 the document, if there are any. 

 
 Go to End of Exceptions 

 ALT+F2 takes the user to the end of the 

 Exceptions bookmarked section. 

  Go to End of Requirements 
 ALT+F1 takes the user to the end of the 

 Requirements bookmarked section. 

  Go to End of Restrictions 
 ALT+F3 takes the user to the end of the 

 Restrictions bookmarked section. 

 
 Go to End of Notes  No Quick Key for this icon. 

 

 Insert Field   

 CTRL-SHIFT+I will bring 

 up the DDE field selector (quick key will work in 

 v8.3 or later). 

 

 Clause Browser 
 CTRL+2 to bring up the floating title Clause 

 Insertion window 

 

 

 Open Name and Address File 

 CTRL+N brings up the NAF for selection of a 

 party whose information should be inserted into  

 the document at the cursor’s location 

 

 

 Insert info on Insured A  

 (Owner) 

 CTRL+3 inserts information on the proposed 

 insured A (generally owner), found elsewhere in 

 the document bookmarked as “InsA”. 



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 105 of 181 

Button Tool Name Quick Keys 

 
 Insert info on Insured B  

 (Lender 1) 

 CTRL-SHFT+3 inserts information on the 

 proposed insured B (generally Lender 1), found  

 elsewhere in the document bookmarked as 

 “InsB”. 

 
 Insert info on Insured C 

 (Lender 2) 

 CTRL+4 inserts information on the proposed 

 insured C (generally Lender 2), found elsewhere  

 in the document bookmarked as “InsC”. 

 
 Copy Fee Type 

 CTRL+5 inserts information on the fee type found 

 elsewhere in the document bookmarked as  

 “FeeType”. (generally Fee Simple or Leasehold). 

 
 Copy Vesting 

 CTRL-SHIFT+5 inserts information on the vesting 

 as found elsewhere in the document bookmarked  

 as “Vested”. 

  Insert Checked Box  CTRL+7 inserts a checked box at the cursor’s 

 location. 

  Insert Checkbox  CTRL-SHIFT+7 inserts an empty checkbox at the 

 cursor’s location. 

  Insert Checkmark  CTRL+8 inserts a checkmark at the cursor’s 

 location. 

 

 Insert Degree symbol  Hit the apostrophe key (`)under the tilde ~ 

  Insert AutoText  Enter autotext item name and hit F3, or accept 

 prompt with ENTER key 

  Select Addressee  CTRL-SHIFT+4 will bring up the Insert Addressee 

 tool. 

 
 Change Case 

SHIFT+F3 at end of highlighted text string, or 

 single unhighlighted word, will cycle through three  

 options: ALL CAPS, all lower case, Upper First  

 Letter Only (if more than one word highlighted). 
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Button Tool Name Quick Keys 

 

 

 Date to Text 

 CTRL+0 will mimic icon. 

 CTRL+9 will generate an alternative text  version 

 (Month ##, ####) vs. icon’s (## the day of Month,  

 ####) 

 
 Date w/ Dashes  CTRL-SHIFT+9 after mmddyy entry. 

  Date Spelled  CTRL+9 after mmddyy or mmddyyyy entry.  

  Dollar Amount to Text  CTRL+6 after entering numbers (no commas). 

 
 
 

  Format Phone Number 

 Enter 7 or 10 digits then hit icon or CTRL- 

 SHIFT+1 (quick key will work in v8.3 or later) to 

 add parentheses and hyphen to format 

 number. 

 

 Switch between Header/Footer 

editing and document body editing 
 No Quick Key shortcut. 

 

 Import Prelim 
 Enabled if configured for NextAce and file data is 

 available for import.  No Quick Key shortcut.   

 

 Open Tools Menu 
 No Quick Key shortcut. 

 Content of menu varies by Access Level. 

 

 Print Document  CTRL+P to print the document 

 

 Email Document  CTRL-SHIFT+M to email the document 

 

 Info 
 CTRL-SHIFT+A for info on Impact and the 

 document 

 

 Save Document  CTRL+S to save the document changes 

 

 Save and Return to Impact 
 No Quick Key shortcut.   

 Saves the document changes and closes the doc. 
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Each of the tools on the Prelim toolbar/ribbon will be explained below. 

 

Next Fill-In  

The Next Fill-In tool will quickly move the cursor through the document stopping only on the places 

where the typist must enter additional information that is not stored in the database. This is usually text 

that is unique to the specific file.  

When the user has finished providing all the information for the Fill-In, CLICK the Next Fill-In tool icon 

again, or press F11 (or CTRL+1), to move to the next fill-in field.  When the user has reached the end of 

the document, Impact/SQL will return the cursor to the top of the document and start the process again. 

Mandatory Fill-In Fields 

A document may have Fill-Ins that require the user to provide an answer before they can save or print the 

document. These are called Mandatory Fill-Ins. They will appear in the document as the same blue 

square brackets except they also include an asterisk, as in [*     ]. 

If the user tries to print or exit the document without providing 

information for this field, Impact/SQL will display the warning 

shown to the right.  

CLICK the Yes button to continue on with the requested command 

(print, save, etc.). 

CLICK the No button to cancel the previous request that was made. Impact/SQL will relocate the cursor to 

the Mandatory Fill-In where the missing information can be entered. 

Phraseboxes 

Phraseboxes are a special type of Fill-In field that may be used in documents. When F11 or CTRL+1 

are used to move through the document and land on a [=phrasebox=] Fill-In, a window will pop up with a 

list of options the user can choose from which will be inserted into the document at that location. It is then 

up to the user to CLICK on which item(s) they will be including with the document.  After they have made 

the desired selection(s), they should CLICK the Insert button. The phrasebox will be replaced with the 

items selected.  If the user sees square boxes in front of the options they can pick as many options as 

they would like to have appear in the document.  If the user sees circles in front of the options, they will 

only be able to choose one option. 
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End of Exceptions  

The End of Exceptions icon, or ALT+F2, will take the user to the end of the Exceptions bookmarked 

section of the prelim/commitment.  At that point, additional clauses could be inserted and would be 

properly numbered/itemized. 

 

End of Requirements  

The End of Requirements icon, or ALT+F1, will take the user to the end of the Requirements 

bookmarked section of the prelim/commitment.  At that point, additional clauses could be inserted and 

would be properly numbered/itemized. 

 

End of Restrictions  

The End of Restrictions icon, or ALT+F3, will take the user to the end of the Restrictions bookmarked 

section of the prelim/commitment.  At that point, additional clauses could be inserted and would be 

properly numbered/itemized. 

 

End of Notes  

The End of Notes icon (there is not a Quick Key for this function) will take the user to the end of the 

Notes bookmarked section of the prelim/commitment.  At that point, additional clauses could be inserted 

and would be properly numbered/itemized. 

 

Please note: as the clauses inserted into each of the bookmarked sections mentioned above are tagged 

with SEQ (sequential) field identifier…and each of those is consistent with the bookmarked section.  

Therefore, copying clauses from one section to another can “break” the numbering scheme in a section.  

To resolve such issues, after copying a clause from one section to another, right-click on the clause 

number, in the new location, and select Toggle Field Codes from the pop-up menu, and replace the 

designation (EXC or REQ, for example) with the correct one for the section copied into.  ALT+F9 will 

display the unique SEQ fields on each entry; repeating ALT+F9 will hide them again.  In the sample 

below, an Exception item is reflecting the SEQ EXC coding at the beginning of the item. 
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Insert DDE Field  

The Insert DDE tool opens the Insert Field dialog box (shown below). Each tab (Title and Prelim) shows 

a list of the available database fields that the user can insert into a document at the cursor’s location.  

Position the cursor at the location in the document where a DDE 

field’s information should be inserted. 

CLICK on the DDE toolbar icon to open the dialog box. 

Select the appropriate tab and highlight the field to insert into the 

document at the cursor’s location. 

CLICK the Insert button (or DOUBLE-CLICK on the field name). 

CLICK the Cancel button to close the Insert Field window. 

NOTE:  This dialog box will remain on the screen until the user closes it 

giving them the opportunity to insert several fields if necessary. If the 

user wants to leave the Insert Field window open to insert fields in 

different locations of the document, they must CLICK in the document to 

change focus from the Insert Field window to the document window in 

between inserting the separate fields. 

The user can also use the Insert DDE dialog box to double-

check what information Impact/SQL has in the database for a 

field. In the example Insert Field dialog box above, the Buyer Name and Title field is currently 

highlighted.  At the bottom of the dialog box North Twenty-Fifth Ave. Ventures and Bill B. Ventura is 

listed in red. This is the value that the user will see in the document if they were to insert this particular 

field. If the information is not correct, the user should return back to the Impact/SQL desktop to correct the 

information in the file data – to make sure the file data is current.  Changing a field’s content by typing 

over it in a document will NOT change file data. 
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Clause Browser  

Title clauses are otherwise known as “The Code Book”. These are typically a paragraph in length but can 

range from a sentence to pages. The clauses 

installed on the system are available to all staff. The 

Clause Insertion dialog box is shown here at the 

right. 

1. Position the cursor at the location where you want to insert a Title clause. 

2. CLICK on the Clause Browser tool (or press CTRL-3). 

3. Type the name of the clause in the Browser field.  You can list as many clauses as you wish here 

by separating them with a comma. 

4. CLICK the Insert button to place the clauses into the document. 

The Browse button will expand the Clause Insertion 

dialog box to include a list of the available clauses. If the 

user CLICKS on a clause name, they can see a preview 

on the right side of the window. 

NOTE: the Title Clauses seen on the Clause Insertion 

window of a particular site will be different than what is 

displayed here. 

DOUBLE-CLICK on any clause name to have Impact/SQL 

insert the clause name in the Browser bar. 

Once all the desired clauses for insertion are listed at 

the top of the window, CLICK the Insert button. 

CLICK the Cancel button to close the Clause Insertion 

window without inserting any clauses. 
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NAF  

The Name and Address File (NAF) is available to 

be used within the prelim/commitment. The user 

can insert the address and contact information into 

a document without having to make the individual a 

party to the file. Impact/SQL will open the Name 

and Address File window shown here.  

1. The user should position the cursor at the 

location in the document where they want to 

insert a name and address from the NAF. 

2. Press CTRL-N (or CLICK on the NAF tool). 

3. Select the search criteria on the left side of 

the Name and Address File window.  

4. Highlight the selection that is to be used in 

the results window. Verify on the right it is the correct individual and/or company. 

5. CLICK the Use button at the top of the window (or DOUBLE-CLICK on the Company name in the 

results window). 

Impact/SQL will close the NAF window and insert the address information at the cursor’s location in the 

document. It will appear in similar form to the sample shown below. 

 

 

 

 

NAF Use Special 

The user also has the option to select which name and 

address information, from the NAF, is placed into their 

document. In those cases, replace Step 5 above with 

the Use Special button. 

The NAF Use Special window is shown here on the 

right. CLICK on any of the three radio buttons, on the left 

of the screen, to replace ALL of the NAF fields in the 

document with the NAF entry selected, or use the 

Short or Full addresses, as displayed.  Or, the user 

may check the specific items on the right side of the 

screen for inclusion at the cursor’s location in the document; any number may be selected at the same 

time. 

Optionally, the Document Administrator may have used additional NAF fields to customize documents. 
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Insured A  

The Insured A icon, or CTRL+3, will copy data entered elsewhere in the prelim/commitment, 

bookmarked as “InsA”, to the cursor’s present location.  Generally, this is information on the insured 

owner. 

 

Insured B  

The Insured B icon, or CTRL-SHIFT+3, will copy data entered elsewhere in the prelim/commitment, 

bookmarked as “InsB”, to the cursor’s present location.  Generally, this is information on the insured first 

lender. 

 

Insured C  

The Insured C icon, or CTRL+4, will copy data entered elsewhere in the prelim/commitment, 

bookmarked as “InsC”, to the cursor’s present location.  Generally, this is information on the insured 

second lender. 

 

Fee Type  

The Fee Type icon, or CTRL+5, will copy data entered elsewhere in the prelim/commitment, bookmarked 

as “FeeType”, to the cursor’s present location.  “Fee Simple” and “Leasehold” are examples. 

 

Vesting  

The Vesting icon, or CTRL-SHIFT+5, will copy data entered elsewhere in the prelim/commitment, 

bookmarked as “Vested”, to the cursor’s present location. 

 

Checked Box  

The Checked Box tool inserts the  symbol at the cursor’s current location. There are numerous 

documents that include the [] Fill-In. This tool is very handy to indicate a chosen selection in those lists. 

Alternatively, the user can press CTRL+7 to insert the checked box symbol. 
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Checkbox  

The Checkbox tool inserts a blank square box at the cursor’s current location. The user can use this tool 

to replace a checked box that might have been inserted via the Checked Box tool if it was selected by 

mistake or if the information in the document has changed. Alternatively, the user can press CTRL-

SHIFT+7 to insert the blank checkbox symbol. 

 

Checkmark  

The Checkmark tool will insert the checkmark character, , at the cursor’s current location. Alternatively, 

the user can press CTRL+8 to insert the checkmark symbol. 

 

Degree  

The Degree tool will insert the degree symbol , at the cursor’s current location in the document. 

Impact/SQL has remapped the keyboard so pressing the ` key (back apostrophe ` and tilde ~) will also 

insert the degree symbol. 

 

Insert AutoText  

The AutoText tool will insert an AutoText entry into the document at the cursor’s current location. 

AutoText are snippets of text that are stored in the user’s MS Word ® profile (their Normal.dot file). The 

options that a user may have available to them may not be the same options that their co-workers have 

unless the organization is using the global AutoText feature of Impact/SQL. There is a more detailed 

discussion about using a Company-wide AutoText solution later in this chapter. 

1. Place the cursor at the location in the document where an AutoText entry should be used. 

2. Type the name of the AutoText entry and then press F3 if MS Word 

doesn’t prompt to include the phrase as shown to the right. 

Impact/SQL will replace the AutoText name with the contents of the entry.   
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Addressee  

The Addressee tool, or CTRL-SHIFT+4, pulls up the Insert 

Addressee dialog box. This dialog box displays all the parties 

to the selected file that were entered in the Initial Questions, 

Parties screens. Each tab at the top of the screen represents 

the party types.  Each will list parties of that type that can be 

selected for use in the document. 

IMPORTANT NOTE: Each party that the user checks in the 

Use column will have a copy of the document produced for it. 

In other words, if the user checks three parties, then 

Impact/SQL will copy the document three times creating a 

document for each party. The result is a document three 

times as long in Impact, which is really three separate 

documents, when all is said and done.  FOR THIS REASON, 

IT IS RECOMMENDED THAT MULTIPLE PARTIES NOT BE 

SELECTED, UNGROUPED, FOR USE IN A PRELIM/COMMITMENT. 

Grouping Addressees Together 

The user can group two or more parties together on the same document by assigning them the same 3-

digit number from the drop-down menu in the Group column. The user can mix and match between 

individual parties and groups of parties in the same document. The user cannot, however, group parties 

on separate tabs. In other words, all members of a group must appear on the same tab. 

Change Case  

The Change Case tool, or SHIFT+F3, will rotate through making the selected text all lowercase letters, 

title case letters (first cap), or all uppercase letters. 

1. Select the text to modify by blocking it. 

2. CLICK the Change Letter Case tool (or press SHIFT-F3) to move through each option until the 

form desired is presented. 

The Change Case tool is not a substitute for text that needs to always be presented in UPPERCASE. 

The Change Case tool applies the All Caps attribute to the selected text which is just like applying Bold 

or Italics. If the text is subsequently imported into another document that applies its own formatting, the 

text will return back to the original way it was entered from the keyboard. Use the CAPS LOCK key to 

make sure text that needs to be typed in UPPERCASE remains in UPPERCASE. 

 

Date to Text  

The Date to Text tool, or CTRL+0, converts a numeric date into a long date format. For example, 

07182013 is converted to read 18
th
 day of July, 2013.  Note that the date is entered in “mmddyyyy” or 

“mmddyy” format, without dashes or slashes.  The cursor must be located at the end of the date entry that 

is to be converted before CLICKING on the Date to Text tool (or pressing CTRL-0).  The DocGroup at USA 

Digital Solutions, or another Doc Admin, will recommend when this type of date format should be used by 

creating a Fill-In field that says [Date then press CTRL-0]  
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Date w/ Dashes  

The Date w/ Dashes tool, or CTRL-SHIFT+9, will convert a numeric date entry into a date with dashes 

entry.  For example, 071813 is converted to 07-18-13.  The date should be entered in “mmddyy” or 

“mmddyyyy” format.  The cursor must be located at the end of the date entry to be converted before the 

tool is clicked on, or CTRL-SHIF+9 is used. 

 

Date Spelled   

The Date Spelled Out tool, or CTRL+9, converts the numeric date (entered in the form “mmddyyyy” or 

“mmddyy”) into the standard date format. For example, 07182013 is converted to read July 18, 2013. The 

cursor must be located at the end of the date to be converted before clicking on the Date Spelled tool (or 

press CTRL+9). 

 

Dollar Amount to Text   

The Dollar Amount to Text tool, or CTRL+6, converts the numeric dollar amount into the cardinal 

representation.  The dollar amount should be entered without commas, but with the decimal point before 

the pennies figures. For example, 93379.28 is converted to read Ninety-Three Thousand Three Hundred 

Seventy-Nine Dollars And 28/100. The cursor must be located at the end of the dollar amount to be 

converted before clicking on the $ Dollar amount to text tool (or press CTRL+6). 

 

Phone  

The Phone tool converts a 7-digit or 10-digit phone number into the standard telephone format. For 

example, 6028668199 is converted to read (602) 866-8199. The cursor must be located at the end of the 

phone number to be converted before clicking on the Phone tool. 

 

Toggle Headers and Footers  

The Toggle Headers and Footers tool will open the Header & Footer toolbar and place the cursor into 

the first header of the document. The user can then make any changes they need to the header and 

footer text using MS Word’s tools. They should click the  Close Header and Footer tool, on the 

Header & Footer toolbar, when are ready to return to the main document text. 

NOTE: The user can also switch back and forth between the header and footer text and the main document by DOUBLE-

CLICKING in either area. 

Import Prelim  

If the system is configured with the NextAce integration and data is available to be imported for the 

prelim, this button will be enabled (colored) and can be used to bring in the NextAce-provided information.  
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Tools  

The Tools tool displays a drop-down menu when the user clicks on this option. The 

menu is a collection of options that are useful to the user’s overall Impact/SQL 

document editing experience.  The Tools drop-down menu that regular users see is 

shown here on the right. Each option will be discussed below. (The menu contains 

more entries for Doc Admin users). 

 

User Preferences 

The User Preferences window gives the user the opportunity to set up options on how Impact/SQL will 

behave. The User Preferences dialog box is shown on the left.  

The View radio buttons allow the user to select if they wish to open their 

documents in MS Word’s Normal view or in MS Word’s Page view. The Normal 

view will be straight text with no margins or page breaks shown. The Page view 

shows how each page of the document will be shown on the printed page. 

The Zoom % option allows the user to set the magnification of their document 

once it is opened in Microsoft Word. For most users a 120% to 144% setting will 

show them the entire document from the left to right margin on the screen. 

The Insert DDE Fields as Bold and the Insert DDE is bright red checkboxes 

determine how fields inserted into the document by the user will be displayed. 

These two options affect only the DDE fields that the user inserts into the 

document using the Insert DDE field tool. They do not change how the Document 

Administrator chose to represent the fields entered in the master document. 

The Return to Impact after Printing checkbox will automatically close every 

document after the user CLICKS the Print tool on Impact/SQL’s toolbar. 

The Display the Print Dialog Box when AutoPrinting from Impact will open up MS Word’s print dialog 

box when the user CLICKS the Print tool. 

When the user is finished defining how they would like to work with Impact/SQL and MS Word 

documents, they should CLICK the Save & Return button to close the dialog box and return to their 

current document. 

NOTE:  CLICK the Cancel button to return to the current document without making any changes to User preferences. 
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AutoText Load and Save 

The AutoText Load and Save dialog box can be used to import the 

Company-wide AutoText entries into a user’s personal AutoText or to 

save a copy of what a user currently has for AutoText entries outside 

of Impact/SQL. 

The AutoText Load and Save dialog box is shown to the right. The 

top portion deals with importing AutoText entries into a user’s 

AutoText. The bottom portion deals with making a backup of a user’s 

AutoText entries so they can retrieve them if they are lost in MS 

Word®. 

Users have two options for loading AutoText entries. The first radio 

button, Load from: (personal) MyAutoText.doc, will only be available if the user has previously used 

the Store option on the bottom of the screen. The Load option will restore the user’s AutoText entries 

from whatever is currently saved in their MyAutoText.doc file. The AutoText Load and Save dialog box 

will indicate the date the MyAutoText.doc was created, if one exists. Anything that was saved to the 

user’s AutoText after that date will be lost if there is a need to replace a user’s corrupted Normal.dot 

(which is where a user’s MS Word® AutoText entries are stored). 

The second radio button is the Load from: (all users) option and will only be available if the company 

has a global AutoText document set up. Impact/SQL will display the path to the location of the global 

AutoText document used by your company after the (all users) label (blanked out in the screen shot 

above). 

The Delete all your existing AutoText entries before loading the entries 

from the file checkbox will clear out the user’s existing AutoText entries, from 

their Normal.dot, before reloading with the entries from the option selected. 

The user should click the Load button once they have made their choices. 

Impact/SQL will process either file option and display the entry count for the 

user.  Click the Yes button to proceed with the import.  

Click the No button to cancel the operation and return back to the AutoText Load and Store window.  

From there the user can click the Cancel button to return back to the current document without making 

any changes to AutoText. 

The Store button will create a Non-Impact/SQL MS Word® document in the user’s personal Impact folder 

called MyAutoText.doc. This document contains a table with a row for each entry in the user’s AutoText. 

This is a great backup tool for users if they rely on AutoText. Frequently DSI receives calls from users 

who have lost all their AutoText entries for one reason or another. If users back up their AutoText using 

the Store feature, we can easily assist in getting it back for them by guiding them to use the Load 

feature.  

It is highly recommended that all users use the Store feature if they use AutoText. 

It is a good idea to repeat the Store procedure after modifying AutoText entries. DSI suggests users 

make storing their AutoText entries a habit that goes along with a significant day like every payday or at 

the first of every month. 
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AutoCorrect Load and Save 

The AutoCorrect Load and Save dialog box is shown to the right. It 

behaves exactly like the AutoText Load and Save option discussed 

above, but works with the user’s MS Word® AutoCorrect entries, if 

any. In this screenshot the reader can see how the dialog box appears 

if there isn’t a personal MyAutoCorrect.doc or a company-wide 

AutoCorrect option in place. The two radio buttons are grayed out, 

indicating there is nothing the user can load. If the user clicks on the 

Store button, the Load From: (Personal) MyAutoCorrect.doc option 

will then be available for a future re-load (if lost from the user’s 

Normal.dot file). 

AutoCorrect Options 

The MS Word AutoCorrect function is accessed through this menu 

entry.  Historically (MS Word 2003 and earlier) this option has been 

available to users on the routine Word menus, but with version 2010 of 

MS Word, it was made inaccessible when within an Impact/SQL 

document, so this function has been put on the Tools menu.   

 

 

 

 

 

Unlink All fields 

The Unlink All Fields tool will disconnect the current document on the screen from the database and 

change all the DDE fields to regular text. None of the information that has been brought into the 

document will change from this point forward if the user chooses this option and then changes data in the 

file. The document will be a snapshot of your database 

information at the point in time the user chose this option.  

1. CLICK on the Tools tool on the Impact/SQL ribbon. 

2. CLICK on the Unlink all fields option on the pull-down 

menu. 

3. Impact/SQL displays the dialog box shown here at the right. CLICK on the Yes button to unlink all 

fields from the database. 

4. CLICK on the No button to return to the document without unlinking the fields. 

Once the fields have been unlinked from the database, Impact/SQL will also remove all the red font color 

from the document since it indicates database fields and those are no longer linked. 

Once the document has been saved, there is no backing out of this change. If this was done in error, the 

user will have to delete the document and recreate it in order to get the database fields back as DDE 

fields. 
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Remove Fill-In Fields 

The Remove Fill-In Fields option will immediately remove all the square brackets in the document. 

Impact/SQL does not ask the user to confirm the action so the user must make sure they want to take this 

action before selecting the option.  

This option will remove only the square brackets that create the Fill-In fields.  Any non-breaking spaces or 

prompt text will remain in the document. 

NOTE: The user can use CTRL-Z to undo this action but will have to press CTRL-Z twice—once for the left square 

bracket and once for the right square bracket. 

Print with remaining fill-in fields 

When a user chooses the Print tool from the Impact/SQL ribbon, any remaining Fill-In fields will have the 

square brackets hidden so they do not show up on the printed page. Selecting the Print With Remaining 

Fill-In Fields option from the Tools sub-menu will leave the square brackets visible on the printed page. 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 120 of 181 

Print  

The Print tool, in the prelim/commitment only, will open a window like that shown 

here asking what the user wishes to print.  The options are the Prelim and 

Distribution Letters, the Distribution Letters, the Distribution Labels or 

Cancel.  There is a system setup option that provides for the preparation of 

Distribution letters with the prelim/commitment.  When enabled, this behavior will 

be seen. 

Once the desired print function is selected, the typical MS Windows® Print dialog box will present on the 

screen. The users should select the options they typically would do just as with any other MS Windows® 

application.  Click the OK button to send the document(s) to the specified printer.  The user’s designated 

Document printer will default as the selected printer on the Print dialog box. 

Email Document  

The Email tool on the Impact/SQL ribbon opens the Email Options window shown here. The top of the 

window displays information about the current Escrow File #.  

The table portion of the window will list all the Parties 

listed under Initial Questions. 

CLICK in the To column to have the party be listed in the 

main To: field of the email message prepared with the 

document as an attachment. 

CLICK in the CC column to have the party be listed in the 

CC: field of your email message prepared with the 

document as an attachment. 

Depending upon the company’s Impact/SQL configuration, 

the user may have the option to send the document as a 

PDF or as an MS Word® document. MS Word® 

documents also have the ability to set a password on the document so it can’t be edited unless the 

correct password is given. If the user does not see the Attachment Options area at the bottom of the 

Email Options window, their company has determined which type of attachment will be created by 

everyone. 

NOTE: Do not forget the password that was used to protect the document if it is changed from the Company’s default. No 

one will be able to unlock the document without it. 

The user should CLICK on the OK button once all choices have been made and they are ready to send the 

email, with the document as an attachment. 

MS Outlook® will open the usual email message window. The To: and CC: fields will be populated with 

the choices made, by the user, in Impact/SQL. The document will appear as an attachment. The user can 

type in the body of the email message and CLICK the Send button when they are ready to send the email. 
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Information  

The Information tool displays the dialog box shown to the right.  The user 

can see which version of Impact/SQL they are using if they are not certain. 

The other tabs contain useful information when troubleshooting any 

difficulties users might be having with their documents. USA DSI’s support 

staff may guide users to this area in order to help solve any problems. 

CLICK the  Close icon to close the Information box and return to the 

current document. 

 

Save Document  

This is one of the more important tools on the Impact/SQL toolbar. CLICK this button frequently to have 

Impact/SQL save your document (or press CTRL-S). You will remain in the document so you can 

continue working.  

A good rule of thumb is to save the document as often as you want to retype. That means if you are 

willing to retype four hours of work, save your document every four hours. The DSI DocGroup 

recommends you save your document frequently and definitely before switching to another task such as 

answering the phone or replying to email messages. Computers are fickle and can behave unexpectedly. 

Save and Return to Impact/SQL  

Save and Return to Impact/SQL will close the document and return the user to the Prelim/Commitment 

screen. The user can perform additional functions on that screen, or  Close the screen and return 

to the Impact/SQL Title desktop. 

 

Release Prelim/Commitment to Escrow (or Title if DO) 

The Release Prelim/Commitment to Escrow menu entry, on the Edit Menu, will present a screen very 

much like the Prelim/Commitment screen discussed above, but without the edit and delete options. 

The Select Prelim/Commitment 

to Release screen will list all of 

the properties on the file and 

indicates the dates/time of the 

creation and updating of the 

related prelim/commitments.  The 

 Release icon, to the right of each listing is used to release the item to Escrow (or Title if a Direct 

Order).  The date/time of release will then be recorded in that column, and the icon will be removed.  

There is a system option that, when set, will have the Title user prompted after editing a 

prelim/commitment as to whether it should be released.  The screen shown here is used to manage the 

release manually.  Another configurable option is to have Escrow notified by email upon a release.  An 

additional option can be set to require Title to re-release the prelim/commitment if it has been amended.  
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Create Policy 

The Create Policy menu entry, on the Edit menu, is used to create the policy(ies) on a file.  The 

information entered into the prelim/commitment document(s) is pulled, as needed, into the policy(ies). 

The Create Policy screen, below, reflects the Property involved under the basic file information 

presented at the top of the screen.  Should the file be a Commercial file, with multiple properties, the 

dropdown arrow should be used to select the correct property to work up policies on. 

 

 

 

 

 

 

 

The Policy Description and Amount fields will be filled with the information from the prelim/commitment 

prepared earlier for the property identified.  In the state shown above, no policies have been established 

for the property, so the Status and Policy Number fields are empty, and the checkboxes in front of each 

entry are not able to be checked, and the functions across the top of the screen are disabled. 

The first step in policy creation, using one of the listed entries, is to click on the  Edit icon to the right of 

the entry to be worked.  If the policy to be worked up is NOT one of those listed, the  New Policy icon, 

at the top left of the screen, can be used to bring up a blank Policy Entry screen.  In the sample below, 

the first entry on the listing above was selected with the  Edit icon. 

The policy Type field is pre-filled, but can be 

edited if incorrect.  The dropdown arrow will 

present the full policy menu for the 

underwriter involved. 

The Policy No (number) field, depending on 

configuration, will either be open for the user 

to enter a number from another source, or 

will be disabled (as shown), and will auto-fill 

upon clicking the OK button.  Every policy 

number must be unique. 

The Pro Forma Version checkbox should 

be checked if the user is preparing a Pro 

Forma policy.  When converting an existing 

Pro Forma policy, the checkbox would be 

subsequently unchecked. 

The Date field should be filled with the effective date of the policy (usually the recording date on the 

transaction).  This is a required field. 

The Time field is used for the effective time of the policy.  It may be left empty, be manually filled or be 

pre-filled with a default entry. 

The Loan No (number) field can be used to enter the lender’s loan number, if applicable.  
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The Loan Delivery Date is entered into the field of that name, if applicable. 

The Fee No (number) field can be used for the County Recorder’s document number. 

The Premium field is used to enter the premium on the policy.  This figure does not flow from Escrow’s 

title charges, it must be entered by the user.  The amount is used on the Underwriter Submission report 

and appears on the policy. 

The Amount field is used to reflect the liability amount of the policy.  If the policy data was initiated from 

prelim/commitment data entered earlier the field will be pre-filled.  The amount is used on the Underwriter 

Submission report and appears on the policy. 

The Approved Date field is typically defaulted to the current date by a system setup option.  The date 

indicates that the policy information is full and complete, and that the entry should appear on an 

Underwriter Submission report encompassing that date.  If left blank, the policy will be reflected on the 

Policy Exception report as an incomplete policy. 

The Examiners Initials are typically pre-filled from the data on the Prelim/Commitment Entry screen.  

They can be modified if they are not correct, or have not been entered. 

The Typist Initials are typically pre-filled from the data on the Prelim/Commitment Entry screen.  They 

can be modified if they are not correct, or have not been entered. 

Endorsements on File 

The Endorsements on File section of the screen will typically present and is used to add endorsements 

to the policy and when added here they will appear on the Underwriter Submission Report.  A system 

setup option can be set to hide this screen and its functionality (not recommended). 

The user should click on the  Add Endorsement icon to add an endorsement to the file.  The 

Endorsement Details window will pop up (shown here) and the user should select the endorsement to 

be added from the dropdown listing of endorsements for the underwriter of the policy. 

The premium for the endorsement should be 

entered in the Premium field. 

The Add Another button, on the Endorsement 

Details screen can be used to add another 

endorsement without leaving the window. 

Once the OK button is clicked on the 

Endorsement Details screen the user will be 

returned to the Policy Entry screen and the 

endorsements selected and priced will appear on the listing.  From there, the  Edit icon can be used to 

alter a specific entry, or the  Delete Selected function can be used, in conjunction with the checkbox in 

front of the entry(ies) to remove an entry altogether. 
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At this point, the Policy Entry screen is complete and the user would click on OK to return to the Create 

Policy screen.  The screen shot below reflects this state, with Pending in the Status column, and a 

Policy Number and effective Date identified.  The same modification cycle should be repeated for all 

policies on the list (unless they are to be deleted), before the  Edit Policies icon is clicked at the top of 

the screen.  Once the  Edit Policies icon is clicked, any policies with a blank Status will be deleted. 

 

 

 

 

 

 

 

Once all policies which are to be created have a Pending Status, the user would then click on the  Edit 

Policies icon, at the top of the screen to begin the MS Word® policy editing process.  The system will 

create all of the policies requested and then prompt the user to select which policy should be worked on 

first.  As indicated on the Activate a Policy screen (sample below) it can be brought up with CTRL+W, 

providing the mechanism to move from one policy to the next.  It can also be brought up with the  

Activate Policy icon, in the toolbar/ribbon.  When the listing is presented, the user can highlight the 

policy to be worked on and click on the OK button, or simply hit the order number (1, 2 or 3 in the sample 

below) of the policy, to open the policy. 

 

 

 

 

 

 

Depending on the policy selected, various DDE fields in the document (usually displayed as red text) will 

be filled with data from the file.  The legal description, various logos and scanned signatures may be 

preloaded into the document.  The listing of Exceptions included in the prelim/commitment will be pulled 

into the policy, as will the map if the policy master is set up to receive it.  The top of a policy is shown 

below, along with the Office 2010 Impact toolbar/ribbon. 
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Policy Toolbar/Ribbon Icons and Quick Key Alternatives 

Many of the icons on the Policy Impact/SQL toolbar/ribbon are common to those on the Prelim 

toolbar/ribbon.  Each will be detailed in the table below, but only those that are unique to the Policy 

toolbar will be explained in the following discussion. 

Button Tool Name Quick Keys 

 

 Next Fill-in 
 CTRL+1 or F11 takes user to the next fill-in field in 

 the document, if there are any. 

 
 Activate Policy  CTRL+W will open the Activate a Policy screen. 

 
 Go to End of Exceptions 

 ALT+F2 takes the user to the end of the 

 Exceptions bookmarked section. 

  Go to End of Restrictions 
 ALT+F3 takes the user to the end of the 

 Restrictions bookmarked section. 

 

 Insert Field   

 CTRL-SHIFT+I will bring 

 up the DDE field selector (quick key will work in 

 v8.3 or later). 

 

 Clause Browser 
 CTRL+2 to bring up the floating title Clause 

 Insertion window 

 

 

 Open Name and Address File 

 CTRL+N brings up the NAF for selection of a 

 party whose information should be inserted into  

 the document at the cursor’s location 

 

 

 Insert info on Insured  

  

 CTRL+3 inserts information on the insured 

 Party, found elsewhere in the document, 

 bookmarked as “Insured”. 

 
 Copy Fee Type 

 CTRL+5 inserts information on the fee type found 

 elsewhere in the document bookmarked as  

 “FeeType”. (generally Fee Simple or Leasehold). 

  Insert Exceptions  CTRL+4 will pull up the Exception Insertion tool.  
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Button Tool Name Quick Keys 

    Insert Endorsement  CTRL-SHIFT+2 will open the Endorsement 

 Insertion tool.  Endorsement(s) will be added 

 at the end of the document. 

    Insert Checked Box  CTRL+7 inserts a checked box at the cursor 

 location. 

    Insert Checkbox  CTRL-SHIFT+7 inserts an empty checkbox at the 

 cursor location. 

    Insert Checkmark  CTRL+8 inserts a checkmark at the cursor 

 location. 

 

 Insert Degree symbol  Hit the apostrophe key (`)under the tilde ~ 

    Insert AutoText  Enter autotext item name and hit F3, or accept 

 prompt with ENTER key 

    Select Addressee  CTRL-SHIFT+4 will bring up the Insert Addressee 

 tool. 

 
 Change Case 

 SHIFT+F3 at end of highlighted text string, or 

 single unhighlighted word, will cycle through three  

 options: ALL CAPS, all lower case, Upper First  

 Letter Only (if more than one word highlighted). 

 

 

 Date to Text 

 CTRL+0 will mimic icon. 

 CTRL+9 will generate an alternative text  version 

 (Month ##, ####) vs. icon’s (## the day of Month,  

 ####) 

 
 Date w/ Dashes  CTRL-SHIFT+9 after mmddyy entry. 

 

 

 Date Spelled  CTRL+9 after mmddyy or mmddyyyy entry. 

  Dollar Amount to Text  CTRL+6 after entering numbers (no commas). 
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Button Tool Name Quick Keys 

 

 

 
 Format Phone Number 

 Enter 7 or 10 digits then hit icon or CTRL- 

 SHIFT+1 (quick key will work in v8.3 or later) to 

 add parentheses and hyphen to format 

 number. 

 

 Switch between Header/Footer 

editing and document body editing 
 No Quick Key shortcut. 

  

 Import Policy 
 Enabled if configured for NextAce and file data is 

 available for import.  No Quick Key shortcut.   

 

 Open Tools Menu 
 No Quick Key shortcut. 

 Content of menu varies by Access Level. 

 

 Print Document  CTRL+P to print the document 

 

 Email Document  CTRL-SHIFT+M to email the document 

 

 Info  No Quick Key shortcut. 

 

 Save Document  CTRL+S to save the document changes 

 

 Save and Return to Impact 
 No Quick Key shortcut.   

 Saves the document changes and closes the doc. 

 

Each of the five (5) unique tools on the Policy toolbar/ribbon will be explained in the following pages.  

Those that are common to the Prelim toolbar/ribbon will not be re-explained – the reader is referred back 

to that section for the explanation of the common tools.  The reader is also referred back to the Editing 

the Prelim/Commitment in MS Word® section for general comments on editing documents in MS 

Word® in Impact. 
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Activate Policy  

The Activate a Policy screen is brought up with the  Activate Policy icon or CTRL+W.  All policies 

for a file are opened up when the user clicks on Edit Policies on the Create Policies screen.  This 

screen is used to move from one to another (when there is more than one loaded). 

 

 

 

 

 

 

The screen is used to move from one policy to the other, for editing purposes.  The user can highlight an 

entry and click on OK to go to that policy, or may enter a number representing the policy in the listing, or 

may simply double-click on the policy to edit. 

 

Copy Insured  

The  Copy Insured icon, or CTRL+3, will copy data entered elsewhere in the policy, bookmarked as 

“Insured”, to the cursor’s present location.   

 

Insert Exceptions  

The  Insert Exceptions icon, or CTRL+4, will bring up the Insert Exception(s) tool, shown 

here.  The tool identifies the number of exceptions in the prelim/commitment, 

and the user should identify the item number(s) of the exception(s) that they 

wish to pull into the policy at the cursor’s location.   

If the user needs to look at the prelim/commitment, they can click on the Open 

Prelim/Commitment as XXX.doc button, at the bottom of the tool’s screen, 

and a copy of it will open, in MS Word, with XXX.doc as the temporary file’s 

name. 

Once the user has entered the item number(s) of the exception(s) to be 

inserted, they would click on Insert to continue.  Cancel should be clicked if none are to be inserted. 
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Insert Endorsement  

Important Note:  Typically, the endorsements for a policy are identified on the Policy Entry screen, 

before the user clicks on the Edit Policies button on the Create Policy screen.  Added in that manner, 

the endorsements will automatically be added to the end of the policy document when opened.  In 

addition, endorsements entered in that manner will appear on the Submission Report.  Endorsements 

added through the Insert Endorsement tool will not appear on the Policy Entry screen, after being added, 

and will not appear on the Submission Report.  

The  Insert Endorsement icon, or CTRL-SHIFT+2, will bring up the Insert Endorsement 

tool.  It will identify the name of the underwriter on the policy at the top of its window. 

The user can scroll through the listing of endorsements to locate 

those that are to be inserted, double-clicking on each to select 

them (the file names of the selections will be placed in the field 

at the top of the window); or, they can enter the first number or 

letter of the entry they wish, if they know it, repeatedly if need 

be, to move through the listing quickly, and double-clicking on 

items to be added. 

Once the endorsement(s) desired are identified, the user will 

click on Insert to have the selected endorsement(s) added to 

the end of the policy document.  Cancel should be clicked to 

exit the tool without adding an endorsement. 

 

 

 

 

Import Policy  

If the system is configured with the NextAce integration and data is available to be imported for the policy, 

the Import Policy button will be enabled (colored) and can be used to bring in the NextAce-provided 

information. 
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Copy Base Files & Subdivisions 

The Copy Base Files & Subdivisions menu entry, on the Edit menu, is utilized to copy title-related work 

from one file to another.  It is also used to copy title-related work from a pre-established Subdivision 

workup or from an Other Base file…collectively known as “Bases”.  When selected, the Copy Bases 

screen is presented to the user (sample shown below).  The user is referred to the Bases section, later in 

this manual, for a discussion on creating and editing Subdivision bases and editing Other Base files.  The 

function being described here is also accessible from the Bases menu. 

On the left side of the screen, the source and target file 

numbers are entered, after the selection of the file type the 

number relates to. 

The options in the From section (the source of the data) are 

Escrow, Direct Order, Subdivision and Other.  The user 

should make the correct selection and enter the File Number 

in the field of that name. Note: the Archived option is grayed 

out in most instances as there is not an archiving option in the 

current Impact/SQL product. 

The To section is used to identify the target file’s type and 

number.  The options are Escrow and Direct Order. 

Depending on the From and To file types selected, the copy 

options, on the right side of the screen, will vary in their 

availability.  If an option is available, it will not be grayed out.  In the sample above, as no File Number 

has been entered in either the From section, no options are available. 

General Options 

Copy Legal 

The Copy Legal option is used to copy the Full Legal description from one file to another.  This can be 

helpful in situations where several files share a largely-common legal description.  The Full Legal can be 

copied and then the minor edits required can be made, through the Edit > Legal Description function. 

The Append Legal option will append the legal being copied to any existing legal in the target file, rather 

than overwriting. 

Copy Endorsements 

The Copy Endorsements function will copy endorsements created under the Endorsement menu to the 

target file.  It does NOT copy endorsements tied to the source file on the Policy Entry screen. 

Copy Documents 

The Copy Documents option will copy all of the miscellaneous Title documents (only) that had been 

prepared on the source file to the target file.  Note: data that had been copied into the original documents, 

in place of the normal DDE fields, is not copied into the new documents in the target file.  The system is 

basically creating new documents, based on the same master docs, in the target file to mirror those in the 

source file.  To copy Escrow documents from one escrow file to another, the Escrow module’s File > 

Copy File function would be used. 
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Copy File 

The Copy File option is only available when copying from one Direct Order to another Direct Order.  The 

option will copy the entire source file into the target file. 

Prelim Options 

The options available in the Prelim Options section are to Copy Entire Prelim or to Copy Exceptions 

Only.  The options are mutually exclusive (the user can pick one or the other).   

The Copy Entire Prelim option will copy all existing exceptions, requirements, restrictions, notes and 

map from the source file to the target file.  The notes must be properly styled and bookmarked and the 

prelim master document must be set up to include maps. 

The Append sub-options will append the section(s) being copied to any existing prelim content in the 

target file, rather than overwriting. 

Policy Options 

The only Policy Option is Copy Exceptions.  If this option is selected, the Prelim Options are grayed out 

and are unavailable. 

The Append sub-option will append the exceptions being copied to any existing policy exceptions in the 

target file, rather than overwriting. 

When the Copy Exceptions policy option is selected, a screen will present of the policies on the source 

file.  The screen is called Select Policy to Use for Base and the user should do that by highlighting the 

desired source policy and clicking on OK to continue.  Cancel will stop the operation. 

 

When a copy operation is completed, a screen will present reporting the actions taken, like that shown 

below. 
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Recording Information 

The Recording Information menu option, on the Edit menu, presents the Recording Information 

screen through which users can log information on New Liens, Existing Liens and Other (miscellaneous 

liens) on Escrow files.  This functionality applies to all escrow file types; however, it is being implemented 

to facilitate a data export function for CDF files (only) that will be forthcoming in a future Impact/SQL 

release.  This data is not available in DDE fields. 

When opened, the screen will present a tree-view of liens previously entered (if any) on the left of the 

screen.  The  Add Lien button will bring up the Add/Edit Recording Information sub-screen (shown 

below) through which the user can enter information on a lien.  below) through which the user can enter 

information on a lien.   

The Type dropdown is used to identify if the item being logged is a New Lien, Existing Lien or Other.   

The Link to: field is used to tie the item to a specific lender/loan – this is a mandatory field on New and 

Existing Liens.  An entry under New Liens will  present the new lender(s)/loan(s) entered on the file for 

linking.  An entry under Existing Liens will present any payoffs that have been entered on the file. 

The balance of the fields are self-explanatory.   

The Add Another button can be used to save the current entry and bring up a cleared screen for another 

entry.   

OK will save and exit 
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Title Charges Menu (Sub Escrow - optional) 

The Title Charges menu will appear between the Edit and Documents menus if the system is configured 

to use the enhanced sub escrow routines that were introduced in Impact version 7.7.  This function allows 

Title users to enter charges in a sub-routine rather than having to enter them into the HUD or Settlement 

entry screens.  The charges can then be made accessible to Escrow (for placement in the appropriate 

locations), or they can be pulled into invoices prepared in Title.  Depending on system settings, the 

charges entered by Title users may or may not be editable by Sub Escrow users. 

The first thing Title users will notice, when the “Charges not shared with Escrow” Setup Option is enabled, 

which enables the new sub escrow routines, is that a new menu entry presents on the Title module’s 

menu bar: Title Charges. 

 

 

 

Clicking on the Title Charges menu entry, will bring up the standard prompt for 

an Escrow file number.  The user should enter the number of the file they wish to 

work with and click on OK to continue.  The Search function does exist on this 

screen, but the user should know the file number they are to be entering charges 

for. 

Entering title charges does NOT lock the file for Escrow users, as long as the Title user does not open the 

file on their desktop. 

The screen that is then presented is displayed below. This is the screen through which title charges will 

be entered.  It also lets the user see the total of any payoff information that has been entered into the file.  

The Payoff information cannot be edited by a user in the Title module; it is entered by sub-escrow users.  

The screen, when first opened, defaults to the Charges Summary view (selected on the tree-view on the 

left side of the screen.  On the right side of the screen, when Charges Summary is selected, are totals 

for Title Charges, Recording Charges, Additional Charges and Payoffs.  The right side of the screen 

will present different information, depending on the item highlighted on the tree-view on the left, as will be 

seen in later screen shots. 

The Charges screen has two icons at the top left, 

used to   Print the Settlement Statement, or 

Statement of Billing Instructions and/or Sub 

Escrow Instructions or  Add Charges.  These 

will be discussed below.  At the bottom of the 

screen, the Title Charges Status is shown, as 

well as when the status was last modified.  The 

Status will also be discussed below.  The Source 

of Business and Bill To Customer are also 

identified at the bottom of the screen.  The  

Info icon next to each label will bring up contact 

information on the parties.  The  button, in 

the upper right corner is used to close the screen. 
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Title Charges 

The Title Charges category is used to enter title charges and lender &/or owner policy premiums.  

Clicking on the Title Charges entry, in the tree-view on the left of the screen, will change the information 

presented on the right side of the screen – it now will present title charges that have already been entered 

to the file, if any, and will provide icons for adding a   New Title Charge or to   Rearrange Items 

(only active if there are any items entered). 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking on the  New Title Charge icon, will present the user with a screen like that shown here.  The 

user should select the Type of charge being entered (Title Charge, Lenders Policy or Owners Policy). 

 

 

 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 135 of 181 

Regardless of the type of charge selected, the Description field will default with the text selected, but will 

be left editable so the user can describe the charge or policy being entered.  

If Title Charge is selected, the Liability From and Liability fields are disabled.  

If the Lenders Policy type is selected, the Liability From field will be activated and the user will need to 

select the Lender to use, via the dropdown arrow, to drive the value entered in the Liability field; the 

selected lender’s loan amount will populate the Liability field.  The field will remain editable so the user 

can change the liability amount. 

If the Owners Policy type is selected, the sales price (on Residential files) or gross sales price aggregate 

(on Commercial files) will be entered in the Liability field.  The field will remain editable so the user can 

change the liability amount.  The Liability From field will be disabled. 

Should the charge be a company fee, the appropriate Income Code should be selected for the charge 

being entered, using the dropdown list.  Once an income code is selected, the Payee Information 

section of the screen will auto-fill with the Company Name (:T payee information) and Branch Address.  

The Payee Information fields will then also be grayed out and will be not be able to be edited.  If the 

charge is payable to an outside party, no income code should be selected and the payee information 

should be entered on the bottom half of the screen.  The  Find icon can be used to pull up a listing of 

parties to the file that can be selected from for the payee information.  The NAF is also available, if the 

“:T” payee is not selected via the selection of an income code. 

The user should enter the charge in the Amount field. 

Notes can be added, via the Notes tab, and they will appear on the Settlement Statement.  The presence 

of a red diamond on the tab indicates a note has been entered. 

The screen shot below presents a completed Owners Policy entry, for a policy being issued by the 

company (:T payee, with Income Code), that also has a note on it. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Clicking on the Add Another button will save the entry and present a new, blank Title Charge entry 

screen.  Clicking on the OK button will save the entry and return the user to the Charges screen.  

Clicking on the Cancel button will abandon any changes made. 



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 136 of 181 

Rearrange Items 

The  Rearrange Items icon, above the detailed listings of Title Charges, Recording Charges or 

Additional Charges, on the right side of the Charges screen and enabled when more than one charge is 

listed, will present a window in which the user can reorder the charges as presented on the screen and on 

the Billing Statement.  The  Move Up and   Move Down icons are used to push the selected charge 

in the desired direction.  Click on OK to save the altered order, or Cancel to exit without saving changes. 

 

 

 

 

 

 

 

 

 

Modify and Delete 

There are two icons that will appear to the right of each charge listed on the Charges screen. 

The  Modify icon, when clicked on, will open the specific charge for editing. 

The  Delete icon, when clicked on, will delete the charge, after a confirmation prompt. 
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Recording Charges 

The Recording Charges category is used to enter recording fees.  The   New Recording Charge icon 

is used to create a new entry.   

There are six Types of fees that can be selected, as shown in the screen shot below.   

 

All of the Types, except for Other, when selected will have their text auto-fill the Description field but the 

field will remain editable by the user.  The Other type will leave the Description field blank and open for 

editing by the user.   

When the Recording Fee type is selected, the Deed $, Mortgage $ and Release $ fields will be opened 

up for data entry.  As dollar amounts are entered in those fields, they will sum in the Amount field.  

When the City/County Tax/Stamp type is selected, the screen will alter somewhat.  The Release $ field 

is disabled, as it is not required.  The  Calculator icon will appear next to the Amount field if rates 

have been entered for the property city &/or county.  A message that the rates have not been set up will 

be presented if that is the case.  Amounts entered in the Deed $ and Mortgage $ fields will sum in the 

Amount field. 

The State Tax/Stamp type behaves the same as the City/County Tax/Stamp type. 

The City Transfer Tax and County Transfer Tax types disable all three of the document type fields.  

The  Calculator button will be presented if rates have been entered for the city &/or county.  A 

message that the rates have not been set up will be presented if that is the case. 

The Property field is used to tie fees to a particular property.  Rates cannot be calculated if a property is 

not identified, however they can still be entered manually.   On Commercial files, if a property is deleted, 

and there are recording fees tied to it, the charges will be unlinked from the property but will remain on 

the file. 
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If the rate tables have not been established for the County of the property, a warning like that shown 

below will present.  If there is no such warning, the recording fee calculation screen can be utilized, called 

for with the Recording Fee Calculator icon. (Yes, Alameda is not a county in AZ…this was just to 

demonstrate the error.)  The recording charges calculators used on this screen (for Recording Fees, 

City/County Tax Stamps and State Tax Stamps) have been modified to produce a single amount, rather 

than the traditional buyer and seller amounts. 

 

 

 

 

 

 

 

 

Should the charge be a Company fee, the appropriate Income Code should be selected for the charge 

being entered, using the dropdown list.  Once an income code is selected, the Payee Information 

section of the screen will auto-fill with the Company Name (:T payee information) and Branch Address.  

The Payee Information fields will then also be grayed out and will be not be able to be edited.  If the 

charge is payable to an outside party, no income code should be selected and the payee information 

should be entered on the bottom half of the screen.  The  Find icon can be used to pull up a listing of 

parties to the file that can be selected from for the payee information.  The NAF is also available if the ”:T” 

payee is not selected via the selection of an income code. 

Clicking on the Add Another button will save the entry and present a new, blank Recording Charge 

entry screen. 

Clicking on the OK button will save the entry and return the user to the Recording Charges screen.   

Clicking on the Cancel button will abandon any changes made. 
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Additional Charges 

The Additional Charges item entry screen is used to enter charges that do not fall into the other 

categories.   The   New Additional Charge icon is used to create a new entry.   

 

 

 

 

 

 

 

 

 

 

 

 

The user can enter whatever Description is desired, and can enter the Amount for the charge.   

Should the charge be a Company fee, the appropriate Income Code should be selected for the charge 

being entered, using the dropdown list.  Once an income code is selected, the Payee Information 

section of the screen will auto-fill with the Company Name (:T payee information) and Branch Address.  

The Payee Information fields will then also be grayed out and will be not be able to be edited.  If the 

charge is payable to an outside party, no income code should be selected and the payee information 

should be entered on the bottom half of the screen.  The  Find icon can be used to pull up a listing of 

parties to the file that can be selected from for the payee information.  The NAF is also available if the “:T” 

payee is not selected via the selection of an income code. 

Clicking on the Add Another button will save the entry and present a new, blank Additional Charge 

entry screen. 

Clicking on the OK button will save the entry and return the user to the Additional Charges screen.   

Clicking on the Cancel button will abandon any changes made. 
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Title Charges Status 

The Title Charges Status field is used to identify if the charges have been finalized on a file.  The status 

choices are:  Not Set, Open and Final. 

The Title Charges Status field is controlled with the Update button at the bottom of the screen. 

 

 

 

When the Update button is hit, the Change Title Charge Status screen, shown below, opens up.  The 

Notification Options are set, at opening, to the defaults for the database (see Introduction section of this 

documentation). 

The user can change the Status by selecting an option from the dropdown menu.  Again, the options are: 

Not Set, Open and Final.  NOTE:  It is not necessary to change the status in order to have an email 

notice generated, which can be sent to whomever the user wishes, with or without added reports.   

 

 

 

 

 

 

 

 

 

 

The Notification Options are: 

Send Email – when checked, this option will trigger the creation of an email about the Title Charge 

Status currently being set, when the OK button is clicked. 

Add Escrow Officer and Processor as Recipients – when checked, if there are email addresses in the 

Users table for the internal EO and processor (if any) on the file, those addresses will be added to the 

email.  Additional addresses will be able to be added by the user before the email is sent. 

Attach Billing Statement – when checked, the Billing Statement will be added to the email as an 

attachment.  The Billing Statement (or Billing Instruction) is a customizable Crystal Report that lists all of 

the title charges entered via the Sub Escrow function. 

Attach Sub Escrow Instruction – when checked, the Sub Escrow Instructions form will be added to the 

email as an attachment.  The Sub Escrow Instructions form is a customizable Crystal Report that can be 

used to notify the Payoff unit that the file is ready to be worked.  Traditionally, this form is printed and 

manually marked up then handed to Payoff, so emailing it in an incomplete state is not recommended.  

This report will likely be customization for each site. 
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Once the desired Status is set, and the desired Notification Options are checked, clicking on OK will 

save the status change (if any) and generate the email (if requested) and present the email on the user’s 

screen, ready for additional addressees to be added to it, as well as any additional comments that the 

user might want to make to the recipient(s).  Once all addressees have been entered, click on Send to 

send the email. 
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Documents Menu 

The Documents Menu contains functions for the preparation of Miscellaneous Title documents and the 

printing of Prelims/Commitments, printing of Policies, printing of Title Instructions and printing of the Legal 

Description.  In addition, the maintenance of master documents is managed from this menu, with the 

appropriate permissions.  The Documents Menu, in the Title module, may contain up to six options, 

depending on the user’s access level.  The six options are: 

 Select & Edit Documents 

 Print Prelim/Commitment 

 Print Policies 

 Print Title Instructions 

 Print Legal 

 Document Maintenance (conditional) 

 

Select & Edit Documents 

The Select & Edit Documents menu option is used to prepare and distribute the various miscellaneous 

title documents created for any file.  The documents are edited within MS Word®, in a controlled Word 

window, from copies of “Master Document” templates.  Users can give specific file copies of documents 

unique names, for versioning purposes or to distinguish unique versions of a common document, for 

multiple recipients, for example.  Existing documents on a file can be printed without going into the 

document, and they can be published to a document management system (if so configured), or emailed 

directly from within Impact.  The Miscellaneous Title document masters are customized per company, and 

the document menu can be arranged as the business wishes.                                          

Selecting Select & Edit Documents from the Documents menu, or clicking on the  Select Edit 

Documents toolbar shortcut when no file is open on the desktop, opens the File Number Entry dialogue 

box.  If the user has a file open on the desktop the File Type and file number will be preselected on the 

dialog box, but they can be changed if the user wishes to work on a different file’s documents.  If the file 

number field is blank, or the user wants to work on documents for another file than that pre-filled, the 

correct file type and file number should be entered and OK clicked to continue to the Title Document 

Menu.  The  Search icon is available on the off chance the file number desired is unknown. The 

Cancel button should be clicked if the request to edit documents was in error.   

 

 

 

 

 

 

If the user has a file open on the desktop and clicks on the  Documents toolbar shortcut, the File 

Number Entry screen will be bypassed and the user will be taken directly to the Title Document Menu.  
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Title Document Menu 

A sample of the Title Document Menu that is presented to users is shown in the screen shot below.  

Again, the document menu is unique to each Impact database.  The Title Document Menu is, traditionally, 

much smaller than the Escrow Document Menu as the bulk of documents produced by Title are not 

“miscellaneous documents” but are, rather, prelims/commitments, policies and endorsements.  When 

initially opened, the menu is presented in “collapsed” mode, meaning only the document section headers 

are presented, not the full listing of documents.  Clicking on the boxed plus sign, in front of a section 

header, will expand the document menu for that section; displaying all of the master documents available 

within it. 

At the top of the screen are icons that the user can use to either   Change File - to work on documents 

for  a different file than the one currently selected - or to show the  File Document List – which is a 

listing of documents already worked up for the selected file (discussed more later). 

In the boxed area near the top of the screen, the Escrow (or Direct) File #, Escrow (or Title) Officer, 

Branch and Underwriter of the file are presented. 

The Filter: field is used to quickly limit the listing presented to documents whose master document name 

contains the content entered in the Filter: field, along with the section header of the section the 

documents are in, or, if the entered text is in a section header, the section header and all items within the 

section.  Some experimenting, by the user, will help familiarize them with the filtering mechanism.  The  

Clear icon is used to quickly clear out the Filter: field of any entered content. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A bold section heading indicates that there is at least one document already prepared for the file 

selected, from a master in the section whose heading is bolded (as demonstrated above with the Arizona 

[2] heading).  The number in brackets after the bolded section heading indicates the number of 

documents from that section that have been prepared for the selected file. 

The  icon, in the upper right corner is used to Close the Title Document Menu. 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 144 of 181 

To create a new document, the user will expand the document section the master document is in, or will 

use the Filter: field to expose the document masters whose names contain the filter’s content, and then 

the user will double-click on the document master name from the list being presented.  If the listing being 

presented is very long, the scroll bar on the right can be used to move through it…or the Filter: field 

contents can be altered to narrow the presented listing. 

In the example below, the Arizona section of the menu has been expanded and the “Affidavit of 

Disclosure” document master has been highlighted (with a single click on the name). 

When the user double-clicks on the name, to signal that a new 

document, of that type, for the selected file, is to be created, the 

system will present the Document Title screen.  The user can 

then either give their copy of the document, prepared just for the 

selected file, a new title (in the sample “- 10-30-13” was added to 

the title), or may simply click on OK to continue.  See the Edit 

Documents section below for details on how to edit the 

document in MS Word®.  If the wrong document was selected, 

clicking on Cancel will stop the document from being prepared, 

and return the user to the Title Document Menu. 

 

 

 

The Document Title entered in the title field (above) will be displayed when the  File Document List 

icon is clicked to open the File Document List screen, which lists all the documents created for the file.  

This name will help you identify the unique document when editing it in the future, so you may want to edit 

the name presented for ease of future referencing.  If there are no documents prepared for a file, the   

File Document List icon will not be enabled.  

It is possible to make any Excel® “document” Impact-ready and make it available on the Title Document 

Menu.  Contact USA Digital Solutions Support for more information on this subject. 

There is a background service that can be utilized to automatically delete miscellaneous title documents 

after a pre-set number of days after last editing, as wished by the Company. 
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File Document List 

The File Document List, when requested, will present a screen like the one shown here, presenting all of 

the documents that have already been created for the selected file. 

 

 

 

 

 

 

 

 

 

The user can click on the column headers to sort the listing of documents by that category (Description, 

Date Created or Date Changed) in ascending order; an additional click on the same header will flip the 

sort to descending order.   

Across the top of the File Document List, there are four icons that may be available, depending on 

system configuration. 

  Print Selected, to print the checked documents 

  Email Selected, to email the checked documents (discussed below) 

  Delete Selected, to delete the checked documents 

  Publish Selected, to publish (to a document management system, if available) 

To utilize these functions, the user will check the checkbox in front of the document(s) on the list that they 

wish to print, email, delete or publish and then click on the appropriate icon.  Multiple documents can be 

checked. 

On the right of each listed document, there are two icons: 

  Modify, to open for editing the specific document 

  Rename, to open the Document Title screen for the specific document 

The user should click on the icon next to the document they wish to edit or rename to execute those 

actions. 
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Email Selected 

If the user clicks on the  Email Selected icon, after checking one or more documents on the list, the 

Email Options screen will be presented to them, as shown below.  All parties to the file will be listed on 

the screen and the user can check which to include as addressees on the email, and whether they should 

be a primary addressee or a “cc” addressee.  Depending on system configuration, the user may also 

have the choice of sending the attachment(s) in MS Word® form or in PDF form; and, the user may be 

able to alter the password protection on the attachment(s), if sent in MS Word® form. 

 

 

 

 

 

 

 

 

 

 

Once the recipient(s) has been selected, and Attachment Options set (if any), the user should click on OK 

to start the email routine. 

Click on Cancel if the emailing should not be done, to return to the File Document List screen. 

 

Publish Selected 

If the system is configured for use of a document management system like SmartVIEW, ePaperless or 

Impact Online the user will see the  Publish Selected option.  To use the function, the user would 

check the document(s) to be published and then click on the  Publish Selected icon. 

Each document management system will present different screens to the user at this point, but 

generically, the user would usually identify the name on the document to be published, the location it 

should be published to, and, possibly, the parties who have permissions to view the document in the 

document management system. 

If multiple document management systems are available, the user will be presented with a screen asking 

which of the systems are to be published to; more than one can be selected at the same time. 
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Creating a New Document from a Menu Item 

Once the user has located the document they wish to create, on the Title Document Menu, they should 

double-click on the menu entry for the document. Impact/SQL will open the Document Title dialog box 

on the screen (if there is not already a document of the selected type on the file).  If there is a document 

of the selected type on the file, the File Document List will present from which the user can select the 

existing document to edit, or can click on the  New icon to create a new file of the type selected. 

 

 

 

 

The user should type a description for the document they are about to create in the Enter a title for this 

document field. They can keep the default description or type anything they wish to make it fit their 

purposes (up to 100 characters). They should click OK to create the document when are ready. 

Click on the Cancel button to return back to the Title Document Menu without creating a document. 

Impact/SQL will create a copy of the document for the user to work with and then open the document in 

MS Word®.  A typical document is shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Impact/SQL documents are color-coded to make working within them easier. Any field that pulls 

information entered into the Opening Info area in the database is colored red. If the information 

displayed in red is not accurate, the user should return to the Impact/SQL desktop and correct the data in 

the Opening Info area. The information will be corrected when you re-open the document. This insures 

ALL documents that are created will have the correct information. 
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The Fill-In fields in the document are represented by blue square brackets separated with non-breaking 

spaces such as [°°°°°]. (The user will not see the small o’s between the brackets unless the MS Word® 

option to show paragraph markers is turned on.)  These Fill-In fields allow the user to type information 

that is not stored in the database and is unique to the document. The user should press F11 or CTRL-1 to 

move from Fill-In to Fill-In until all the information has been typed. Once Impact/SQL reaches the bottom 

of the document, it will return the cursor to the top and start the search for a Fill-In field once more. 

SmartTags vs. DDE Fields 

The majority of the documents in the Title module are set up to pull the database information into the 

document by using DDE fields.  As the newer versions of Impact/SQL have been released, the document 

masters have begun the switch to using SmartTags to pull information from the database into MS Word® 

documents.  As Impact/SQL document masters advance over time, users will start to see more of the 

documents they create open up to the Data Selector dialog box shown below.   

With the use of SmartTags in the documents, a Document Administrator has a lot more flexibility when 

designing documents. In the case of the example shown here, one letter was created that could be used 

for the Buyer or for the Seller on the Escrow Order Number. There isn’t a need to have two separate 

documents. 

When the user creates a document that has 

SmartTags used in the master document, the Data 

Selector window will have a one or multiple drop-

down choices. The prompt next to each choice is 

worded to help the user determine which party 

should receive the document.  There may be more 

than one choice. 

Unused Field Options 

The Unused Field Options area of the Data Selector is used to tell Impact/SQL how to treat the 

SmartTags when the user is not sure which option to select from one of the drop-down fields. 

The Change to fill ins radio button will remove the SmartTag field from the document and replace it with 

a Fill-In ([°°°°°]). If the Leave radio button is selected (the default), the SmartTag will remain in the 

document so the information can be provided later. 

NOTE:  The  is disabled on this dialog box. CLICK the OK button to close the window. 

Unanswered Questions 

If the user does not answer all the Prompt Text before clicking on the OK button, and they have the 

Unused Field Options set to Leave, they can have the Data Selector shown on the screen again at a 

later time by pressing CTRL-SHIFT-R. Only the Prompt Text that has not been answered will be shown in 

the Data Selector.  Alternatively, the user can simple Save & Exit the document and then reopen it.  

Impact/SQL will show the Data Selector dialog box again for only the unanswered questions. 

NOTE: if the Change to Fill-Ins option is selected, Impact/SQL will no longer show the Data Selector dialog box. This 

option should only be selected if the information can’t be obtained from any source. 
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The Title Document Toolbar/Ribbon 

 

 

 

Impact/SQL adds functionality to MS Word® through the Impact/SQL toolbar (ribbon) at the top of the 

documents. The user can click on any function they need on the toolbar using the mouse or can use the 

keyboard shortcut Quick Key. The table below details each item shown on the Toolbar. 

Button Tool Name Quick Keys 

 

Next Fill-In CTRL+1 or F11 takes user to the next fill-in 
field in the document, if there are any  

 

Insert DDE Field CTRL-SHIFT+I will bring up the DDE field 
selector (quick key will work in v8.3 or later). 

 

Clause Browser CTRL+2 to bring up the floating Title Clause 

 Insertion window 

 

Name and Address File CTRL+N brings up the NAF for selection of a 

 party whose information should be inserted 

 into  the document at the cursor’s location 

 Insert Checked Box CTRL+7 inserts a checked box at the cursor 

 location. 

 Insert Checkbox CTRL-SHIFT+7 inserts an empty checkbox at 
the cursor location. 

 Insert Checkmark CTRL+8 inserts a checkmark at the cursor 

 location. 

 Insert Degree Hit the apostrophe key (`)under the tilde ~ 

 Insert AutoText Enter autotext item name and hit F3, or accept 

prompt with ENTER key 

 Select Addressee CTRL-SHIFT+4 will bring up the Insert 
Addressee tool. 

 

Change Letter Case SHIFT+F3 at end of highlighted text string, or 
single unhighlighted word, will cycle through 
three options: ALL CAPS, all lower case, 
Upper First Letter Only (if more than one word 
highlighted). 
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Button Tool Name Quick Keys 

 Insert Date as Text CTRL+0 will mimic icon. 

CTRL+9 will generate an alternative text  
version (Month ##, ####) vs. icon’s (## the 
day of Month,  ####) 

 Insert Dashes into Date CTRL-SHIFT+9 after mmddyy entry. 

 Insert Date Spelled Out CTRL+9 after mmddyy or mmddyyyy entry. 

 Dollar Amount to Text CTRL+6 after entering numbers (no commas). 

 Format Phone Enter 7 or 10 digits then hit icon or CTRL- 
SHIFT+1 (quick key will work in v8.3 or later) 
to add parentheses and hyphen to format 
number. 

 

 

Show/Hide headers and 
Footers 

 

No Quick Key shortcut. 

 

Tools No Quick Key shortcut. 

Content of menu varies by Access Level. 

 

Print CTRL+P to print the document 

 

Email Document CTRL-SHIFT+M to email the document 

 

Information CTRL-SHIFT-A 

 

Save Document CTRL+S to save the document changes 

 

Save and Return to 
Impact/SQL 

No Quick Key shortcut.   

 Saves the document changes and closes the 
doc. 

 

All of the tools on the Title Documents toolbar/ribbon have been explained earlier in either the 

Prelim/Commitment or Policy editing sections, so will not be repeated here.  The user is referred back 

to those sections for details on each.  
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Print Prelim/Commitment 

The Print Prelim/Commitment menu entry, on the Documents menu, is used to print, email or publish 

(if so configured) prelim/commitment documents.  When first selected, when 

no file is open on the desktop, the screen shown to the right is presented.  

The user should select the File Type and enter the file number and click on 

OK to proceed.  If there was a file opened on the desktop, the File Type and 

file number would be prefilled on the screen. 

 

Once a file is identified, the Print 

Prelim/Commitment screen will 

be presented, listing all of the 

prelim/commitment documents on 

the file. 

The user should click on the checkbox in front of each of the documents that is to be worked with and 

then select the appropriate icon at the top of the screen to print, email or publish, as desired. 

  Print Selected, to print the checked documents 

  Email Selected, to email the checked documents 

  Publish Selected, to publish (to a document management system, if available) 

These functions have been described earlier in this documentation so will not be re-explained here. 

 

Print Policies 

The Print Policies menu entry, on the Documents menu, is used to print, email or publish (if so 

configured).   The behavior is exactly like the Print Prelim/Commitment function discussed just above.  

Once the file is selected, the Print Policy – Selector screen is presented, on which the user will identify 

the document(s) to be printed, emailed or published. 

 

 

 

 

 

Print Title Instructions 

Selecting the Print Title Instructions option, from the Documents menu, will allow the user to preview, 

email, publish (if so configured) or print a copy of the Title Instructions.  A file is identified and OK clicked 

to proceed to the Printer control dialog. 

The Title Instructions can be customized for each Impact site.  The information that presents on the Title 

Instructions is entered, and can be modified, on the Opening Info screens. 
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Print Legal Description 

The Print Legal Description option, on the Document menu, is used to print, email or publish (if so 

configured) the Full Legal Description document.  As with the other Print menu selections, the user is 

prompted to identify the file type and file number, then is presented with a Print Legal Description 

screen, like that shown below.  On Commercial files there may be more than one prelim/commitment. 

 

 

 

 

 

 

Document Maintenance (conditional) 

The menu option is only available to a user with Document Maintenance authorization.  It is used to 

develop or modify master document templates.  Please refer to the Document Maintenance manual for 

further information the Document Maintenance functionality.  It is not detailed here. 

Training on the Document Administrator role is available from USA Digital Solutions, Inc. 

 

Endorsements Menu 

The Endorsements menu, on the Title desktop, is used to create endorsements separate and distinct 

from the Create Policy > Policy Entry routine.  Endorsements created from the Endorsements menu will 

not be included in the underwriter’s Submission Report.  The reasons to create an endorsement from this 

menu, rather than through the Create Policy function, include: the desire to create a pro forma 

endorsement; to create an endorsement for a policy that was generated on another system; and, to 

specifically keep an endorsement off of the underwriter’s Submission Report. 

The Endorsements menu lets endorsement documents be created, and edited within MS Word®, 

standalone from a policy document.   

The endorsement listings are customized by underwriter. 

The standard File Number Entry screen is presented when the Endorsements menu entry is clicked on.  

There is an additional File Type presented, however, of Misc.  If an Escrow, Direct Order or Title File 

Type is identified, and file number provided, the user will next be presented with the Endorsement Menu 

and can proceed.  If a Misc file type is selected, an existing or new miscellaneous file number can be 

entered and when the user clicks on OK to proceed, the Select Underwriter screen will ask them to 

select the Underwriter for the miscellaneous file’s endorsement(s), before proceeding to the 

Endorsement Menu. 
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The Endorsement Menu is then presented, for the underwriter identified with the file selected or the 

underwriter selected for a Misc file.  Again, the menu is customized by underwriter. 

The menu is similar in fashion to the Miscellaneous 

Title Documents menu, in that the endorsements are 

grouped by category, and the presence of existing 

endorsements, created through this menu, are 

indicated by bolding of the category heading (when 

shown in collapsed mode, as shown to the right). 

The same Filter tool exists, as in the previously 

discussed document maintenance functions, and can 

be used to limit the displayed items to those with the 

filter field’s contents in their name. 

The  File Document List icon, at the top of the 

screen, will be enabled if there are existing endorsements, created through this menu, for the selected 

file.  From this list, the user can print, email, delete or publish (if so configured) endorsements prepared 

through this menu – in the same manner described previously in the other document maintenance 

discussions (so will not be repeated here). 

 

 

 

 

 

 

To create a new endorsement document, from the Endorsement Menu, the user would use the Filter 

field to find the document master to use, or would expand the appropriate menu section and find the 

desired document title.  Either way, once located, double-clicking on the document name will open up the 

Document Title screen, on which the user may alter the title for the file’s copy of the document; once the 

title is acceptable, click on OK to continue into MS Word to complete the document. 
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Impact/SQL documents are color-coded to make working within them easier. Any field that pulls 

information entered into the Opening Info area in the database is colored red. If the information 

displayed in red is not accurate, the user should return to the Impact/SQL desktop and correct the data in 

the Opening Info area. The information will be corrected when you re-open the document. This insures 

ALL documents that are created will have the correct information.  The legal description, various company 

logos and scanned signatures may be preloaded into the document masters.  The reader is referred back 

to earlier document maintenance sections for comments on DDE fields, clause insertion and other tools. 

The Endorsements Toolbar/Ribbon 

The Impact/SQL Endorsements toolbar/ribbon is very similar to Title Documents toolbar/ribbon.  The MS 

Word 2010® version is shown below.  The reader is referred back to the earlier document maintenance 

sections for descriptions of each. 
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Misc Menu 

The Miscellaneous menu, on the Title desktop, has up to eight entries, as listed below.  Each will be 

described in the following pages. 

 Print Title Instructions (conditional) 

 Invoicing (optional) 

 File Search 

 Policy Number Search 

 Rate Calculator 

 Printer Setup 

 Escrow Ledger 

 Reprint Title Instructions 

 Change Password (conditional) 

 

 

Print Title Instructions (conditional) 

The Print Title Instructions option, on the Misc menu, is not the same function as the commonly-named 

function on the Documents menu.  The entry on the Documents menu prints instructions for a specific 

file.  This function is used to print instructions from the queue of all orders submitted to the Title 

branch(es).  If the Impact Windows Service is configured to print or email title instructions on a routine 

basis (generally every 5-10 minutes), and the option to Auto Print Title Instructions is checked, on the 

Tools menu, then this option will not be presented on the menu.  If, however, the IWS is not configured to 

print submitted orders, this function can be used to clear the queue, by Title Branch.  When selected, the 

Print Title Instructions screen, like that shown below, will be presented. 

 

 

 

 

The Title user would click on the  Print icon to the right of the Title Branch for which they wish to print 

the queued orders.  The standard Print dialog box will present and the user can OK (to print) or Preview 

or Email the orders.  Publishing, if so configured, is not an option as there would generally be orders for 

several different files queued up.  Once orders have been printed, the Title Branch will drop off the listing 

until additional orders queue up. 
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Invoicing (optional) 

There are two sub-entries on the Invoicing item on the Misc menu:  Add and Modify and Search.   

Add and Modify 

Depending on system configuration, Title may have the ability to generate invoices.  Typically, this 

functionality is enabled for Title users.  If enabled, Title has the ability to generate an unlimited number of 

invoices for an escrow, title, direct order, or miscellaneous file number.  It is also possible to configure the 

system to allow for the creation of pre-bills, which can be converted to invoices.  The default type to be 

created can also be set (pre-bill or invoice) for the database.  Depending on system configuration, the 

Title user may not be able to delete an invoice once it has been entered into Impact/SQL.  There is not 

an Accounts Receivable function within Impact/SQL for tracking invoices.  Invoices can be edited at any 

time after creation – they cannot be locked, except by some proprietary systems. 

File Number Entry 

Selecting Add and Modify, from the Invoicing sub-menu on the Misc menu, will open the File Number 

Entry dialogue box. 

If no file is open on the desktop, the File Number Entry screen will 

present with the Misc File Type selected and no file number will be 

identified.  If the invoice being created is to be tied to an existing Escrow, 

Direct Order or Title File number, the user should select the appropriate 

File Type, by clicking on the radio button in front of the file type, and then 

should enter an existing file number.   

To generate an invoice that is not linked to an existing file, the user should select Misc as the File Type 

and enter a number in the file number field – the number entered will not link back to an existing Escrow 

or Direct Order or Title File of the same number. 

If there is a file open on the desktop, the File Number field will be pre-filled with the current open file 

number, and the appropriate File Type will be selected.  If it is the file the user wishes to create or edit an 

invoice for, they should click on the OK button to continue.  If not the correct file, then the correct number 

should be entered.  If the screen was entered in error, the Cancel button will take the user back to the 

Title desktop. 

Add and Modify 

Once a file has been selected for invoicing, the Add and Modify screen is presented to the user, as 

shown below.  This sample has three previously entered items 

 

 

 

 

 

 

If the user recognizes that the wrong file was selected, they can use the  Change File icon, in the 

upper left corner of the screen, to select a different file.  
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There are icons at the top of the screen that can be used to  Print Selected (checked) invoice(s),   

Email Selected invoice(s) and, if so configured, to  Publish Selected invoice(s). 

There is also a  New Invoice icon, at the top of the screen, which is used to initiate the creation of a 

new invoice (or pre-bill, if enabled). 

On the right side of each existing invoice, or pre-bill, entry, as shown above, are  Modify and  

Delete icons.   

The  Modify icon will open the Invoice Entry screen with the existing detail presented.  All fields other 

than the invoice number can be edited as needed. 

The  Delete icon may not be presented, if the system is configured to not permit invoice deletion.  An 

invoice’s lines would need to be zero’d out if deletion is not available and the invoice is to be eliminated. 

Note, in the screen shot above, the “P” after the third entry’s Invoice #...that indicates the item is a pre-

bill, rather than an invoice. 

 

Invoice Entry 

The   New Invoice icon will take the user to the Invoice Entry screen, shown below.  Note that, in this 

sample, the Type of Invoice is defaulted to Pre-Bill.  The user should ensure that the Type of Invoice 

selected is the type they wish to create.  There is a system setting that will allow an existing pre-bill to be 

converted to an invoice, eliminating the need to re-enter the data.  When a pre-bill is switched to a regular 

invoice, the original pre-bill number is retained in the system, allowing for searching based on the original 

pre-bill number, even after switching. 

 

 

 

 

 

 

 

 

 

 

 

 

While the Invoice Entry screen has a standard layout, the printed invoice can be customized, by 

database.  The invoices and pre-bills are generated with a Crystal Reports template. 

The invoice/pre-bill numbering is automatic, based on sequence numbering established via the Utilities 

module.  A number will not be assigned to an item until the invoice has been saved.  The invoice number 

will present at the top right of the screen, once it is assigned.  The number is assigned when the invoice is 

saved.
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The Invoice Date will default to the current date.  The  Calendar tool can be used to select a different 

date, or the user may type in the date in “mmddyy” format. 

When a new invoice/pre-bill is created, the fields on the top half of the screen, related to the customer 

who will be billed, will be pre-populated if the Bill To data has been entered in the Initial Questions or 

Opening Info screens (Escrow or Direct Order data entry).  If the data was not provided earlier, or if it is 

incorrect, the user will need to enter the information on who is being invoiced.  The Bill To information 

can be filled out manually, but it is recommended that the client be selected from the NAF.  The  NAF 

icon will be enabled when the cursor is in the Bill To field.   

The Reference Number field is used to enter a reference number provided by the party being invoiced, 

such as a lender’s loan number. 

Up to 30 lines can be entered on an invoice/pre-bill.  Each line has fields for a Product Code, 

Description, Liability amount and charge Amount.  These fields can be filled by selecting a Product 

Code from the dropdown listing under that column heading.  The Product Code listing is also known as 

the Invoice Description listing and is maintained by the Company in the Utilities module.  The listing can 

provide a default charge description, can identify whether the liability amount should be pulled from the 

sales price or one of the three loan amounts or be left blank, can assign an income code (behind the 

screen) and can set a default amount for the charge.  All of the defaults can be edited by the user except 

for the liability amount, if it is pulled from the database via the Product Code.  Values not defaulted via the 

Product Code should be entered by the user as needed.  The system will total up the Amount column. 

The  Clear icon, to the right of each invoice line will clear the line’s content, after prompting the user for 

a confirmation that that action is desired. 

The OK button should be clicked on when the invoice/pre-bill has been completed and should be saved. 

The Cancel button should be clicked on to exit without saving any changes. 

 

Import Title Charges 

If the database is configured for the updated Sub Escrow processing routines, introduced with version 7.7 

of Impact/SQL, the user will see an Import Title Charges button at the bottom left of the Invoice Entry 

screen (as seen on the sample earlier). 

When clicked, all of the title charges for the file entered via the Title Charges function will be loaded into 

the invoice.  Note that the income codes entered during title charge entry are tied back to Product 

Code/Invoice Descriptions so if not all income codes are represented in the Invoice Description listing, a 

Product Code will need to be selected manually.  Also note that there can be several Product 

Code/Invoice Descriptions tied to a single income code…and the system will match up to the first match, 

most likely, which may be incorrect.  The user should review the results of the import carefully to make 

sure the desired result was achieved. 

Import from Escrow 

The Import From Escrow button, in the lower left of the screen, will pull charges entered in the Title 

Charges section of the HUD, Worksheet or CDF styles of entry on Residential files, or from Title 

Charges entered through Settlement Items on Commercial files, eliminating the need to re-type them. 
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Search 

The Search entry, on the Invoicing menu, is used to search the system for invoices.  The search can be 

done by Invoice Number, Pre-Bill Number and File Number.  

The user should select the search Filter desired, then enter the value to be looked up in the Search For 

field. 
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File Search 

The File Search function, seen in many places in Impact, when a file number is being requested, permits 

you to search the entire database, for files that meet search criteria, with differing filters to limit the 

search.  When first opened, the screen presented is set with broad filter of All but file numbers against 

which the Search For: field content will be applied, as shown below.  The function can be accessed 

directly on the Misc menu. 

The File Search screen gives you the ability to search the database broadly or in a more targeted 

manner.  By entering the beginning of a last name in the Search For: field, for example, and then clicking 

on the Search button without changing the search default of All but file numbers, you will get a listing 

returned of all files that have names of either the Buyer or the Seller which begin as you requested.  The 

more sure you are of the item being requested, enter a more complete description.  However, if at first 

you do not find what you believe you should have, limit the information you enter in the Search For: field.  

You may also use the percent sign (%) as a wildcard in your searches.  It can be placed at the beginning, 

middle or end of your entry to tell the system to find anything that ends with what you entered, contains 

anything between your entry items, or begins with what you entered, respectively.  The more targeted 

search options are listed below and can be selected from the Filter: dropdown.  The default is All but file 

numbers. 

 Sellers and Buyers 

 Buyers 

 Sellers 

 Property Address 

 Tax Parcel Number 

 Subdivision (Name) 

 Reference Number 

 Base File Number 

 Loan Number (Lender’s) 

 File Number 

 Title File Number 

Once you click on the Search button, a listing of candidate items will present.  The records will indicate 

which search criteria they matched up on.  Up to the first 1,000 records that meet the criteria will be 

presented – you will be prompted to narrow your search if over 1,000 hits are made.    
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The quickest path to the Search functionality is via the  Search icon on the Impact toolbar. 

The user should proceed as far as they can before invoking a search, to minimize the effort.  For 

example, if the plan is to open a file from the search results use the  Open Existing File toolbar icon 

and then click on the  Search icon and conduct the search.  Double-clicking on a search result, will 

then open that file. 

In the sample below, “smith” was the search criteria, with the All but file numbers filter.  The Found By 

column indicates how the search criterion relates to the search result.  The File Number column contains 

that information.  The Initials column presents the Escrow Officer’s initials, and the Branch of the file is 

presented; along with the Title File Number.  There is a  View File Status icon next to each record 

returned; click on the icon to get more information on the file that the record relates to. 

The Show Detail checkbox, in the top right of the screen, will open a section at the bottom of the screen 

presenting some additional information on the highlighted file.  This helps the user determine if the 

selection is the file they are really looking for. 

The search results can be re-ordered by clicking on a column header. 

The user can re-size the screen by clicking and dragging on the lower right corner of the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

If the File Search screen was called up from a screen requesting a file number, double-clicking on a 

record in the results screen will select that file number for use. 
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Policy Number Search 

The Policy Number Search function, on the Misc menu, is used to locate a file by the policy number.  

This can be helpful when an underwriter requests a duplicate policy, but only has the policy number. 

Selecting the Policy Number Search function, on the Misc menu, will present a screen like that shown 

below…but the screen will be blank when first opened. 

 

 

 

 

 

 

 

The user should enter information on the policy number in the Search For field and click on the Search 

button to conduct the search.  The percent sign (%) can be used as a wild card, in front of the entry to 

search for any data containing the text or numbers anywhere in the policy number.  The more that is 

entered, the narrower the search result will be. 

 

Rate Calculator 

Please note that the Rate Calculator in Impact/SQL does not currently handle some common pricing 

practices and is under review for revision (as of January 2015).  Therefore, a full description of the Rate 

Calculator will not be included in this section of the Title manual. 
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Printer Setup 

Each user’s session is unique in the printers it has at its disposal and how they are configured.  Once 

printers are established within the computer environment (either in Citrix sessions, or in a terminal server 

environment, or locally), Impact must be told which printers to use for each user.  They must be defined in 

the user’s environment before they can be selected in Impact.  The first time a user goes into Impact, if 

their printers have not been defined through this function, they will be prompted about the matter and will 

be asked if they wish to define their printers.  Once defined, they will no longer get the warning prompt.  

Should they need to change their defined printers, they would use this function, from the Misc menu. 

Depending on the user, Impact will need a document printer defined (at a minimum) and, possibly, a 

check printer will need to be defined.  Note that the check printer is distinguished by the fact that it uses 

MICR toner, so banks’ proof machines can recognize the encoded information on checks and deposit 

slips. 

This function is available in the Impact Escrow, Title, Accounting and Utilities modules.  The configuration 

only needs to be done once for each user (not in each module they use). 

 

 

 

 

 

 

 

Two tabs are presented, one for the Document/Report Printer and the other for the Check Printer.  

Simply select the printer to assign to each task, by highlighting the desired printer from the list presented, 

on each tab. 

When print jobs are queued up, Impact will know whether it needs to send each to the check printer or the 

document printer, and will send the jobs to the correct printers. 
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Escrow Ledger  

The Ledger is where all of the accounting transactions on an Escrow file (receipts and disbursements) 

are presented (whether posted or in process).  When the request is made to display a ledger, with the 

Escrow Ledger option, on the Misc. menu, the user will be prompted for the Escrow Number.  No trust 

accounting can be done on Direct Order files, so no ledgers are available for them. 

Generally, the user will have the Escrow Number and will simply 

enter it and click on the OK button.  However, if they do not have 

the number, but have a name (for example there is a funding check 

in hand, without an escrow number on it, but with a borrower’s 

name), the user can use the  Search icon to initiate a full system 

search of Impact.   

Once an escrow number is entered on the Escrow Number Entry 

screen presented above, or if a file is selected from the search results screen (with a double-click), the 

Ledger will be presented, as shown below.  Both Escrow and Savings account information is available 

through the same screen.  The Ledger is described in detail in the following paragraphs. 

At the very top of the screen are three icons:   Change File and  Print (on the left) and  Collapse 

Summary (on the right).  The Change File icon will let the user select a different file. The Print icon will 

help the user print the ledger.  The Collapse Summary icon will hide the file and balance information, at 

the top of the screen, giving the user more room to view ledger records.  It will revert to an Expand 

Summary icon, which is used to re-present the file and balance information. 

At the initial opening of a ledger, general information about the file (Escrow Number, Escrow Officer, 

Branch, Bank currently assigned, and Buyer and Seller names) is presented on the top left of the 

screen, and summary accounting figures, relating to escrow trust balances, are presented on the top 

right.  The (Posted) Balance is modified with the work in process and on hold to result in the Available 

Balance – which is what is left in the file to be disbursed. 

 

 

 

 

 

 

 

 

 

 

Note that there are three tabs on this screen: Posted Items, Receipts in Process and 
Disbursements in Process.  Click on the tab heading to move from one to the other. 
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The ledger presents, for each transaction, from left to right: 

The Date of the transaction; they are presented in date order 

The Src column presents the type (R=receipt, T=transfer, W=wire and D=disbursement) and source 

(Bank Number); if the file has switched banks, you will see different source numbers on some of the 

items, and you will see multiple banks listed in the account tree on the left 

Who entered the item (user’s initials), in the By column 

The Payor of a receipt or the Payee on a disbursement 

The receipt type (only on receipts), in the Type column 

The reference number of the item (receipt number or check number), in the Number column; an “M” 

beside the check number denotes it was a manually prepared check; a “C” beside a check number 

indicates the check has been cleared, through a reconciliation; an “H” will appear on a receipt that is on 

hold (remember: only Accounting can release non-current-date holds); and, a “V” will reflect a Void. 

The amount of the item (either in the Receipts column or in the Disbursements column, as appropriate 

The running Balance through each transaction 

The  Info icon next to some records can be used to present additional detail on the particular item. 
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Savings Ledger – from View Ledger 

The Ledger also gives the user access to the Savings account information, if any, associated with a 

particular file.  On the left side of the screen, under the file information, a “tree” of account numbers is 

presented.  If there are one or more Savings accounts associated with the file, they will be listed under 

the Savings heading.  Note: if there is escrow trust account activity for more than one escrow trust 

account, those will be listed above the Savings heading, under the Escrow Trust heading. 

Click on a specific Savings account number listing and two things will happen.  In the file summary 

section above the ledger detail, on the left side, the Bank field will be filled with the savings account’s 

information, and the Balance information, on the right side will reflect summary information about that 

particular savings account.  The ledger detail that is presented will be that for the selected savings 

account. 

 

 

 

 

 

 

 

The tabs available for ledger detail records are Posted Items, Receipts in Process and Adjustments in 

Process (no Disbursements), as all savings activity is done via receipts. 

 

Close the Ledger with the  Close icon in the upper right hand corner. 
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Reprint Title Instructions 

The Reprint Title Instructions menu option, on the Misc menu, is used to reprint ALL of the Title 

Instructions (Title Orders) that were submitted on a given date.  If a site is configured for multiple title 

branches, the orders can be printed for a particular branch for the selected date. 

The reader is reminded, to reprint a single file’s Title Instructions, use the Documents menu’s Print Title 

Instructions option. 

Selecting the Reprint Title Instructions option will present the user with the screen below (this is the 

screen a site configured for multiple title branches will see). 

 

 

 

 

 

 

 

 

 

The user should enter the date for which orders are to be reprinted, in “mmddyy” form, in the Date field, 

or the  Calendar tool can be used to select the date.  The Search button should then be clicked and 

the system will pull up a listing of the number of orders placed, by Title Branch, from which the user can 

select the branch to reprint orders for, by clicking on the  Print icon to the right of the branch detail 

record. 

 

Change Password (conditional) 

If NT Authentication is not being used (not recommended), and the Impact system asks the user for their 

Impact initials and a password when they access an Impact module, the users will be able to change their 

own password with the Change Password function.  Historically (pre Impact/SQL version 8), a System 

Administrator had to change a user’s password for them.  Selecting the Change Password option, on the 

Misc. menu, will present a screen on which the user will enter their old password and their new 

password.  The new password will have to be entered twice, to verify it was entered consistently. 

The entries will be displayed as asterisks (***), so no one looking over the user’s shoulder can read their 

password off the screen.   

The system will NOT check to see that the password truly was changed – the same password can be 

entered as the Old Password and in the New and Verify Password fields. 

User passwords in Impact/SQL are restricted to six (6) characters or less. 
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Bases Menu 

The Bases menu contains four functions that are used for working with base files (title documents created 

inside or outside of Impact) that can be used, for example, with subdivision or condominium transactions, 

where much of the documentation is common file-to-file. 

 Copy Base Files & Subdivisions 

 Create & Edit Subdivision Masters 

 Print Subdivision Masters 

 Edit Other Bases 

 

Copy Base Files & Subdivisions 

The Copy Base Files & Subdivisions menu entry, on the Bases menu, is utilized to copy title-related 

work from one file to another.  It is also used to copy title-related work from a pre-established Subdivision 

workup or from an Other Base file…collectively known as “Bases”.   

The reader is referred to the explanation of this functionality in the Copy Base Files & Subdivisions 

portion of the Edit menu section of this manual. 

 

Create & Edit Subdivision Masters 

Selecting the Create & Edit Subdivision Masters option, on the Bases menu, will open up the 

Subdivision Maintenance screen, as shown below. 

The screen presents an alphabetical 

listing of all the subdivision master files 

(extension .sdv) that have been created 

in the database, and the date/time each 

of them was last modified. 

There is a  New Subdivision icon, at 

the top of the screen, which is used to 

create a new subdivision master file 

(discussed below). 

The Filter field can be used to limit the 

list presented.  The user should enter a 

minimum of three characters and the 

system will find file names starting with 

those characters.  The percent sign (%) 

can be used as a wildcard in front of the 

entry to find the entry within a file name, 

rather than at the start of the file name.  The  Remove icon can be used to clear the Filter field’s 

contents. 
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There are two icons to the right of each file listed.   

The  Modify icon is used to maintain a subdivision master file.   

The  Delete icon is used to permanently remove a subdivision master file.  The user will be prompted 

to confirm they wish to delete the file after the icon is clicked. 

 

New Subdivision 

When the  New Subdivision icon is clicked, the user will be presented with a New Subdivision pop-

up window asking for the New File Name.  The user should enter a name for the new file.  The name can 

be up to 20 characters in length, and must conform to Microsoft® file name conventions. 

A suggestion for naming subdivision files is to use the Book and Page of the plat map…for example “357-

24”…but it is up to each business to establish their own naming convention that makes locating the 

subdivision master files easy for them. 

Once the name desired is entered, the user should click on OK 

to continue.  If the name has not been previously used, the 

system will open up a new subdivision file in MS Word®.  If the 

name entered already exists, the user will be notified of that 

fact and will be asked to enter another name. 

Once MS Word® has loaded the template for a new subdivision master file, the user can edit it in the 

same manner discussed in earlier sections of this manual. 

The subdivision master document template is made up of three bookmarked and styled sections:  

Requirements, Exceptions and the Legal Description, as shown below.  The file for a new subdivision 

master should NOT have these sections removed or rearranged.  The clause browser is used to load 

exceptions and requirements.  When the Legal section is being worked, the user should enter square 

brackets [ ] where users should enter data down the road, when the master is copied to be used for an 

active file. 

The user is referred to the Edit > Editing a Prelim/Commitment in MS Word® section, earlier in this 

manual, for a full discussion of editing documents in Impact.  The ImpactSQL toolbar icons are described 

in the earlier document editing discussions, and will not be repeated here.  
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Print Subdivision Masters 

The Print Subdivision Masters menu option, on the Bases menu, is used to generate one or more of 

three reports that provide information on the subdivision masters that exist in the database.  The option 

will present the user with the screen below. 

 

 

 

 

 

 

The options are to include, on the report, Nothing from the document body, or the First Line Only or the 

entire Description. Also, the Subject (it is the file name of the SDV file) and Last Revised date can be 

included on the report. 

 

Edit Other Bases 

The Edit Other Bases menu option, on the Bases menu, behaves in the same manner as the Create & 

Edit Subdivision Masters option discussed earlier, except there is not a New Other Base option.  Other 

Bases are files that have been prepared in another system that have been copied into a specific folder for 

use as “Other Bases”.  The editing of these files is similar to the other document editing discussed above.  

For this reason, the files must be MS Word® documents and must contain the same styles and 

bookmarks.  These files are generally prepared by USA Digital Solutions, Inc. when a client is transferring 

from another system (if it is possible to work with the other system’s prelim files).  Prelims from other 

Impact databases can also be put into the appropriate Other Bases folder and can be edited through this 

function. 

 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 171 of 181 

Reports Menu 

The Reports menu contains functionality for reporting on policies (submissions and exceptions) and on 

invoices (as Title generally does most of the invoicing).  The items on the Reports menu are: 

 Underwriter Reports 

o Underwriter Submissions 

o Policy Exception Report 

o Policy Submission Export 

 Invoice Reports 

 

Underwriter Reports 

There are three options on the Underwriter Reports sub-menu, as shown above.  Each will be described 

below. 

Underwriter Submissions 

Selecting the Underwriter Submissions sub-menu entry will bring up the screen below, which is used to 

prepare an underwriter submission (remittance) report.  Such reports detail the policies (and, generally, 

the related endorsements – only linked endorsements are included in the reports) with an Approved 

Date in the date range specified.  There is a system option to automatically set the Approved Date as 

the date the policy is typed; but that date can be cleared or altered by the policy typist.   

The reports are customized to meet each underwriter’s specifications.  Some are designed to be printed, 

while others are designed to be previewed and then exported – for importation into Excel templates, for 

example. 

 

 

 

 

 

 

 

The user should select the Underwriter they wish to generate the Submission (Remittance) Report for, 

from the dropdown, and then enter the Starting Date and Ending Date for the report.  Again, this date 

range is based on the Approved Date (entered when typing policies).  The Include Property County 

checkbox should be checked if the report for the selected underwriter requires it.   

After clicking on OK to generate the report, the routine Print control panel is presented, letting the user 

print or preview the report.  If the report is designed for export, the user would preview and then export.  

DSI personnel will provide any guidance that is needed for a particular underwriter’s report. 

  



 

USA Digital Solutions, Inc. Title v10.5.431 Manual 
03/04/16 Page 172 of 181 

Policy Exception Report 

The Policy Exception Report presents data on policies that were started but which have no Approved 

Date on them.  Policies without an Approved Date will never make it onto a Submission Report, so this 

report is helpful to confirm that there are not policies that are incomplete in that regard. 

 

 

 

 

 

 

 

The user will be presented with the screen shown above, on which they will select the Underwriter to 

report on and identify whether Escrow Files or Direct Order Files or both should be reported. 

 

Policy Submissions Export 

The Policy Submissions Export routine could be used to prepare an export file of policy submission 

data.  This routine has been supplanted, in practice, by exports from the Policy Submission Report 

routine.  The Types of exports that are in existence in the routine at this writing are old and are likely not 

in use by any clients; again, because similar functionality is achieved via the Policy Submission Report 

routine, and exporting from it. 

The use of the routine is similar in that an Underwriter is selected, the date range (of Approved Dates) 

is entered, the target location for the export is identified and the Select Type field is used to identify the 

format desired. 
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Invoice Reports 

The Invoice Reports menu selection, on the Reports menu, presents the Invoice Report screen shown 

below. 

 

 

 

 

 

 

 

Invoice reports can be run either By Date Range (invoice dates) or By Number (invoice numbers). 

They can Report On Escrow Files &/or Direct Order Files &/or Misc. Files. 

And, there are two Types of Report – Invoice Report and G/L Report.   

The Invoice Report By Date Range format presents invoice data, ordered by invoice number, of all 

invoices dated within the date range selected.  The file Number, Branch, Type of file, Invoice Number, 

invoice Date, Billing Information, Transaction Type on the file and Total Invoice amount are 

presented. 

The Invoice Report By Number presents the same data, in the same layout, as the By Date Range 

report. 

The G/L Report format (either By Date or By Number) takes the data of the requested invoices and 

sorts it by the underlying Income Codes tied to the Invoice Description Codes.  The Description of the 

Income Code shows in the group heading.  The detail records present the file Number, Type, Invoice 

Number, Date, Description off of the invoice line and the Amount of the charge. This report could be 

used to quantify revenue by income code description.  Recall, however, that invoices can be edited after 

creation, so rigid controls must be in place to rely on invoice data. 
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Naf Menu 

The Name and Address File (Naf) or customer list is a very important tool in Impact.  It is used to aid in 

consistently filling name and address information into the appropriate fields in Impact.  Consistency in 

data entry helps ensure that documents properly present information.  Management reporting is also 

aided by consistent data entry.   The Name and Address File (Naf) is displayed in a tiered manner: 

Company – Branch – Individual (Top – Middle – Bottom).  This provides a good way to show the 

relationship between an individual and where he/she works, within the larger organization.  The Naf can 

be centralized or branch-specific, depending on system configuration.  If the user is doing maintenance in 

a branch-specific environment they must be aware of the branch their Impact login initials are assigned 

to.   

Add and Modify 

Maintenance of the Naf is done through this menu entry, if the user has authorization to change the Naf.   

Search criteria are entered at the top of the screen.  The first is the Option field.  The nine options 

presented are the eight categories which can be used to categorize entries by type of firm, as they are 

entered/edited, and the All option is used to assist in searching the entire database, regardless of 

categorization of the entries. 

In addition to the  Option field, there are five other fields that are used to refine the Search to include 

either Name, ID, City, State and/or County.  When more than one character is entered into any of these 

fields (three in Name), the Search button will be activated, and the user should click it when all desired 

criteria have been entered.  You may use the percent sign (%) as a wildcard character. Those records 

that have a specific match, and their related records, are displayed in the tree on the lower left of the 

screen.  In the search results display, the company entries are bolded, branch entries are not bolded and 

individuals’ entries are italicized for enhanced readability.  Details of the highlighted entry will appear on 

the right side of the screen, if the Show Details checkbox is checked (at the bottom of the screen). 

Double-click on an entry to Use it, if you are in a field where a NAF entry could be used, when the NAF 

was invoked.  Alternatively, highlight the entry and then click on the  Use icon at the top of the screen, 

or right-click on an entry and pick Use from the menu presented. 

When a NAF entry is pulled into the file under Parties, Contacts, Source of Business, Bill To 

Customer, Title Information, Documents or Payoffs, if the NAF entry is a branch or individual, and the 

address information is empty, the parent’s address information is used.  The same is true if the Work 

Number, Work Extension and Fax Number are blank; the parent’s values will be used. 
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When first accessed, the screen is blank, with the Search Option field filled with the All option, and the 

cursor is in the Search Name field, in anticipation of the user entering the beginning of a name to be 

searched for.  There are two icons at the top of the screen,  New and  Print, which will be discussed 

below. 

A user with maintenance authority can add a new Naf entry by clicking on the  New icon, at the top of 

the screen, or by right-clicking, while a specific entry is highlighted.  Depending on whether there is a 

highlighted entry or not, and at what level the highlighted entry is (Company (top), Branch (middle), 

Individual (bottom)), Impact may display a prompt asking what the user would like to do, presenting 

currently available options, which could include: Add a New Company, Add a Branch Under the 

Company, Add an Individual under the Branch or Add an Individual Under 

the Company.  Clicking  New, when no entry is highlighted, will bring up the 

entry screen, assuming a new Company entry is being made.  

The sample shown to the right was generated while a company level record 

was highlighted, and the  New icon was clicked.  Had the user right-clicked 

with the mouse, with the same record highlighted, the options would have 

been presented in a slightly different format (menu listing) with less 

information provided as guidance. 

Based on the user’s selection, they 

will be presented with an empty 

form into which they will enter data 

on the new entry. Depending on 

what level of entry was requested, some fields may already be 

completed and will not be able to be edited.  Complete the form 

with as much information as is available.  The form shown to 

the left was presented when a New Company entry was 

requested.   

The Entity Type is used to categorize the company to help in 

searches. If the Entity Type selected is Lender, the Proposed 

Insured Clause field will open for data entry.  This verbiage is 

available as a DDE field for documents (when completed in the 

NAF and the lender is drawn from the NAF); the verbiage is 

stored on a tab in the Lender Party screen, when the lender is 

drawn from the NAF. 

Depending on system configuration, an automatic Id # can be 

assigned to each customer.  The automatic ID #‘s are useful to 

coordinate customer numbering with an outside accounting or 

CRM system.  The Comments area of the screen can be used 

for information not provided for in the fields presented. 

At the bottom of the screen the Naf has fields available for a Bank Name, Account Number and 

Routing Number.  This is useful information to have filled out before wiring money to the entity.  The 

bank Routing Number must be a valid receiving bank ABA number or Impact will not accept the routing 

number.  While bank routing numbers are downloaded from the Federal Reserve website and updated by 

the system administrator periodically, in order to validate ABA #’s on wire entries, the entries in the Naf 

are NOT updated by the ABA downloads. 

The License/Other tab is used to enter licensing information that is used on the CDF Contacts table. 

Click on OK to accept the entry, or on Cancel to quit without saving.    
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Info 

The  Info icon, next to each entry presented, is used to bring up the full data set for the entry, including 

the License tab (which is not visible when the Show Details checkbox, at the bottom of the screen, is 

checked).  The Full Details button, at the bottom right of the screen, under the selected entry’s 

information, brings up the same full data set window. 

Modify 

To make changes to a Naf item, the user should double-click on the record they wish to change, or right-

click on the record and select  Edit from the options presented, or click on the  Edit icon to the right 

of the entry.  If the user has rights to edit the Naf, the entry will be presented for editing. .  The initials of 

the person who created, and who last edited, each Naf entry are stored and presented. 

The Naf allows the Naf Administrator to flag a Naf record as Inactive.  Setting a Company level record as 

Inactive sets all related parties as Inactive.  Setting a single related party as Inactive will dim the specific 

entry and still allow the user to use the Company level record and any other records not set as Inactive. 

Click on Cancel to abort any changes and return to the NAF Entity screen, or OK to save any changes or 

new entries to the screen.    

Delete 

To delete a Naf entry, right-click on it and select  Delete from the options presented, or click on the  

Delete icon to the right of the entry.  If there are related entries below the one selected for deletion, the 

user will be prompted to delete them before attempting to delete the current record.  The function will 

delete the entire Naf entry (a dialogue box will ask for confirmation). 

 

Print 

A name and address listing can be generated for any or all of the Naf categories.  This can be done either 

from the main Naf screen, using the  Print icon, at the top of the screen, or by using the Print menu 

option, from the main Naf menu. By default, in the Print Options area of the screen that is then 

presented, all the fields are checked, meaning they are selected. Click on a check box to uncheck any 

categories that should not be printed. 

Click on OK to print the report, or Cancel to abort and return to the 

Impact desktop. 

Optionally, click on OK, then on Preview. From this preview screen, the 

print results can be exported to a file (click on the  Export icon on the 

top left corner of the screen, for example to an XLS or DOC file) and used 

in other systems, for seasonal greeting cards, mass mailing, etc.  
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Options Menu 

The Options menu, on the Title desktop, has two settings on it that the user can select to provide helpful 

tools to their Title desktop: Show Toolbar and Show Recent File List.  There is information on both of 

these tools at the beginning of this manual, so only a brief comment on each will be made below. 

 

Show Toolbar 

Selecting the Show Toolbar option, on the Options menu, displays a row of icons under the menu at the 

top of the Title desktop.  The icons can be used to initiate actions without using the menus.  Holding the 

cursor over the icons will present tooltips identifying each icon’s purpose.  The purpose of each icon is 

described at the beginning of this manual. 

 

 

 

Show Recent File List 

Selecting the Show Recent File List option, on the Options menu, will provide a listing of the last ten 

(10) files accessed, at the bottom of the File menu.  This is the Recent File List.  The user can simply 

click on a file number, on the list, to open it up.  To access the list the user can use ALT+F to display the 

File menu.   
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Tools Menu 

There are two options on the Tools menu in Title, currently:  

 Event Log 

 Auto Print Title Instructions 

 

Event Log 

The Event Log, in Impact/SQL, keeps a record of most unexpected errors that a user might experience in 

Impact/SQL.  It gives the USA Digital Solutions Support Team a good place to review the history of error 

events when an issue is being researched.  Details captured on the errors can be emailed to 

Support@Digisolaz.com, after clicking on the  Info icon next to a particular error entry, and then 

clicking on the Email button at the bottom of the Event Details screen. 

 

Auto Print Title Instructions 

The Auto Print Title Instructions option, on the Tools menu, should only be unchecked if there is a 

problem with the auto-routing of title instructions (by the Impact Windows Service).  Unchecking this 

option will add the Print Title Instructions option to the top of the Misc menu – which users would use to 

manually trigger the printing of any orders queued up.  Typically, the Auto Print Title Instructions option 

is checked and remains on – which tells the Impact Windows Service to run its title instruction routine as 

configured. 

 

About Menu 

The About menu, on the Title desktop, will bring up a screen of the current Impact/SQL installation, 

including the version and build numbers.  This information is often helpful for the USA Digitals Solutions 

Support Team when researching an issue.  There is no functionality on this screen, other than a link to 

the USA Digital Solutions, Inc. web site. 
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Appendix A - Washington State –Taxes 

The Impact/SQL system can be configured to add the sales tax and excise tax calculations, for 

Washington State, to the applicable HUD screens (1100 – Title Charges & 1200 – Government 

Recording and Transfer Charges).  This setting should only be applied to databases in the state of 

Washington.  The discussion below will detail the system alterations for “with GFE” Residential files.  The 

non-GFE Residential and Commercial data entry are also altered to accommodate sales taxes, but the 

concepts are similar so only the with-GFE Residential will be detailed below.  The businesses are 

responsible for maintaining the sales tax tables (via the Utilities module) as rates change – not USA 

Digital Solutions, Inc.  Title users with access to these Escrow screens, in Washington, will see these 

differences. 

Sales Taxes on Escrow and Title Charges 

The “with GFE” Residential file 1100 Title Charges screen, on a site configured for Washington sales tax 

calculations, looks the same as on other sites, until the user enters the GFE charge breakdown screens 

for the 1102, 1103 & 1104 figures (shown below).  Note the Sales Tax additions to the screens. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Override Sales Tax checkbox, at the top left of each screen, will open up the sales tax fields for 

manual entry.  If not checked, the system will calculate the sales tax on each line. 

The calculations are based on the Estimated Close of Escrow Date. 

Taxes on Escrow Charges are based on the file’s closing center (Escrow Branch) Municipality Type, 

City, County and State. 

Taxes on Title Charges are based on the file’s title service center (Title Branch) Municipality Type, City, 

County and State.  So, if a file’s title branch is in another location from the escrow branch, the rates may 

be different for the two types of charges.  
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Excise Taxes 

The Washington sales and excise tax option replaces the blank 1206 & 1207 lines with a 1206 line set of 

fields dedicated to Excise Tax.  

 

 

 

 

 

 

 

 

 

 

 

 

 

The  Calculator icon, to the right of the fields, is used to open the 

Excise Tax screen – shown to the right.   

The State and Local Excise Tax Rates will present at the top of the 

screen (not shown in this sample). 

The Gross Selling Price and Personal Property data, if entered, is 

shown. 

The taxes will be calculated and presented. 

The user should enter figures in the Delinquent Interest State, 

Delinquent Interest Local and Delinquent Penalty, as needed. 

The Amount to Charge Buyer and Amount to Charge Seller fields 

should be used to split the Total Due, as applicable. 

Click on OK to save and return to the 1200 screen.  The excise tax data 

from the calculator will be presented and locked. 

Once data is entered on the calculator screen, re-entering that screen and clicking on Remove will clear 

the data on the screen and when OK is then hit, the user is returned to the 1200 screen with the 

previously computed data still there, but editable (unlocked).  The data can either be manually removed 

or adjusted as desired. 

Click on Cancel to not save any changes and return to the 1200 screen. 
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Prelim/Commitment Entry 

When the Washington State setup option is enabled, Title users will see a slightly different 

Prelim/Commitment Entry screen.  The screen adds Sales Tax fields to the policy detail lines, so that 

the sales tax amounts can be entered by Title.  There is also an option to push that data back to Escrow. 

 

 

 

 

 

 

 

 

 

 

Note: the screen shot above is from version 8.4 of Impact/SQL, and reflects some fields at the bottom of 

the screen added after version 8.0. 

 

 

 

 

Appendix B - Troubleshooting 

USA Digital Solutions, Inc. (DSI) Support personnel may ask that you make a screen shot so that you can 

e-mail Support a “picture” of the screen as it appears when the error occurs. 

To create this screen shot, save it and send it to the Support personnel, do the following: 

Press the PRINT SCREEN key on the keyboard, which is usually located on the top row of the keyboard, 

and is usually the third key from the right. 

Open your e-mail client, start a new e-mail, to Support@Digisolaz.com, and Paste the screen shot into 

the body of the e-mail.  This will work if the e-mail format is HTML.  If the screen shot does NOT paste 

properly, open an MS Word® document and paste the screen shot into it; save the MS Word® doc; and, 

attach it to an email addressed to Support@Digisolaz.com. 

DSI Support personnel can be reached at (602) 866-8199 extension 2. 

 

mailto:Support@Digisolaz.com


 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

support@digisolaz.com 

 

(602) 866-8199 x 2 

 


